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序文

本書では、Sun StorEdge FC アレイを構成、監視、管理するために Sun StorEdge 
Configuration Service プログラムをインストールして使用する方法について説明しま
す。 

特別な指定がない限り、ここでは Sun StorEdge FC アレイのことをアレイと呼びま
す。また、本書では Sun StorEdge 3000 Family Diagnostic Reporter にもふれていま
す。これは、ホストおよびアレイからシステム メッセージを送受信するために使用
する Sun StorEdge 3000 Family Configuration Service プログラムの併用ユーティリ
ティです。Diagnostic Reporter のインストール方法と使用方法は、『Sun StorEdge 
3000 Family Diagnostic Reporter ユーザ ガイド』を参照してください。

本書は、Sun のハードウェアおよびソフトウェア製品の使用に習熟した上級のシステ
ム管理者を対象として書かれています。

本書の構成
本書には次のトピックが含まれています：

第 1 章: Sun StorEdge 3000 Family Configuration Service の機能について紹介します。

第 2 章: Configuration Service のインストールと使用の前に、アレイが正しく構成さ
れていることを確認する手順を提供します。

第 3 章: Solaris・動作環境でのシステムにおける、Configuration Service コンソール
およびエージェントのシステム要件とインストール手順を提供します。

第 4 章: Microsoft Windows NT/2000 システムにおける、Configuration Service コン
ソールおよびエージェントのシステム要件とインストール手順を提供します。

第 5 章: Linux 動作環境でのシステムにおける、Configuration Service コンソールお
よびエージェントのシステム要件とインストール手順を提供します。
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第 6 章: Configuration Service のセットアップ手順を提供します。

第 7 章: アレイの構成手順を提供します。

第 8 章: 同じストレージを共有する大規模なファイバ チャネル ネットワークを維持す
るための LUN フィルタの作成方法を説明します。

第 9 章: アレイの監視方法を説明します。

第 10 章 : アレイの保全性を維持する方法を説明します。

第 11 章: 現在のアレイ構成を変更または追加する方法を説明します。

付録 A: RAID に関する基本的な情報を提供します。

付録 B: スタンドアロン JBOD を監視し、これにファームウェアをダウンロードする
方法を説明します(SCSI のみ)。

付録 C: クラスタ構成のセットアップに関する情報を提供します。

付録 D: Solaris 動作環境および Microsoft Windows NT を実行するシステム上でホス
トのワールド ワイド ネーム(WWN)を決定する方法を説明します。

付録 E: イベント完全監視機能と電子メール通知機能のセットアップ方法を説明します。

付録 F: トラブルシューティングに関し、症状の一覧と対応策を提供します。

付録 G: Configuration Service のエラーコードとメッセージの一覧です。

用語集: 本書で使用する Configuration Service 関連の略語と用語の一覧です。
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UNIX コマンドの使用
基本的な UNIX® コマンドに関する情報や、システムのシャットダウンと起動、デバ
イスの構成などの手順は、本書では説明されていない場合があります。

必要に応じて、以下の文書を参照してください。

■ Solaris Handbook for Sun Peripherals
■ Solaris 動作環境用 AnswerBook2™ オンライン文書
■ 各システムに付属のその他のソフトウェア文書

表記規約

書体*

*. これらの書体は、使用しているブラウザの設定により異なる場合があります。

意味 例

AaBbCc123 コマンド、ファイル、ディレク
トリの名前。画面に表示される
コンピュータ出力。-

.login ファイルを編集します。

 ls -a を使って、全ファイルを一覧表
示します。

% You have mail.

AaBbCc123 画面上のコンピュータ出力と区
別し、ユーザーが入力する内
容。

% su

Password:

AaBbCc123 書名、新しい用語、語句の強
調。コマンド ライン変数に対し
て入力する実際の名前または
値。

ユーザ ガイドの第 6 章を参照してくだ
さい。

これらはクラス オプションと呼ばれま
す。

この操作を行うには、スーパーユー
ザーでなければなりません。

ファイルを削除するには、rm ファイル
名と入力します。
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シェル プロンプト

関連マニュアル

シェル プロンプト

C シェル machine-name%

C シェルのスーパーユーザー machine-name#

Bourne シェルと Korn シェル $

Bourne シェルと Korn シェルのスーパーユーザー #

タイトル Part No

『Sun StorEdge 3000 Family Release Notes』 816-7301

『Sun StorEdge 3000 Family 導入・運用・サービス マニュアル』 817-2758

『Sun StorEdge 3000 Family 適使用法の手引き』 817-2761

『Sun StorEdge 3000 Family Release Notes』 816-7301

『Sun StorEdge 3000 Family RAID ファームウェア ユーザ ガイド』 817-2764

『Sun StorEdge 3000 Family Diagnostic Reporter ユーザ ガイド』 817-2774

『Sun StorEdge 3000 Family ラック インストール ガイド』 817-2768

『Sun StorEdge 3000 Family FRU インストール ガイド』 817-2765

『Sun StorEdge 3000 Family 安全、規格、遵守マニュアル』 816-7930
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テクニカル サポート
新の技術情報やトラブルシューティングに関するヒントは、ご使用のアレイのリ

リース ノートを、次の適切なディレクトリから入手してください。 

www.sun.com/products-n-solutions/
hardware/docs/Network_Storage_Solutions/Workgroup/3510

無休 24 時間体制の Web ベースのサポート ソリューションには、次のオンライン サ
ポート センターからアクセスできます。 

www.sun.com/service/online

国際サポートおよびサポート リクエストに関するお問い合わせは、1-800-USA-4SUN 
までお電話いただくか、次の URL にアクセスしてください。

www.sun.com/service/contacting

Sun オンライン文書へのアクセス 
Sun StorEdge 3510 FC アレイに関する文書はすべて、PDF および HTML 形式で、次
の 2 つの URL からオンラインで入手できます。

http://www.sun.com/products-n-solutions/ 
hardware/docs/Network_Storage_Solutions/Workgroup/3510

注 – 上記の場所からは、すべての HTML 文書を一括でダウンロードできます。

http://www.sun.com/documentation

Sun StorEdge 3510 SCSI アレイ マニュアルの書籍は、次のサイトからご注文になれ
ます。

http://corppub.iuniverse.com/marketplace/sun
序文 xxi



508 アクセシビリティ機能
Sun StorEdge 文書は、視覚障害を持つ方の支援テクノロジ プログラムと共に使用で
きる、508 条に準拠した HTML ファイルで入手できます。これらのファイルは、ご
使用の製品の文書 CD と、xxi  ページの「Sun オンライン文書へのアクセス」に記載
されている Web サイト上にあります。また、ソフトウェア アプリケーションと
ファームウェア アプリケーションにはキーボード ナビゲーションとショートカット
があり、詳細はユーザ ガイドに記載されています。

本書に対するご意見
Sun では、よりよいマニュアル作成のため、皆様からのご意見やご提案を歓迎いたし
ます。コメントがありましたら電子メールで下記へお送りください。

docfeedback@sun.com

電子メールの件名に、ご使用のマニュアルの Part No. （817-2771-10）をお書き添え
ください。
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第 1 章

はじめに

このセクションでは、Sun StorEdge 3000 Family Configuration Service の機能の概要
を簡単に説明します。

注 – 本書では今後、Sun StorEdge 3000 Family Configuration Service を 
Configuration Service  またはプログラムと呼びます。

Configuration Service は、Java™ プログラミング言語に基づく高性能プログラムであ
り、アレイを集中管理するため、ストレージの構成、保守、および監視ツールを 1 つ
のアプリケーションにまとめています。

ネットワーク上の 1 つのコンソールから、システム管理者はネットワーク ストレー
ジの初期化、構成の変更、ステータスの監視、定期保守のスケジュールなどを、直感
的なグラフィカル ユーザ インターフェイス（GUI）を使って実行できます。

管理者は、ネットワーク全般のストレージ需要の変動に伴い絶えず変化するストレー
ジ要件に合わせて、容量を動的に割り振り、再割り振り、または拡張することができ
ます。  

ステータスに変化があると、Configuration Service はコンソール画面、電子メール、
または英数字ページャを使って、アラートを送信します。Configuration Service で
は、HP OpenView などの任意の簡易ネットワーク管理プロトコル(SNMP)エンター
プライズ マネージャにアラートを送信することもできます。  
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Configuration Service は 2 つのコンポーネントで構成されます。

■ Configuration Service エージェント - Solaris 8 および Solaris 9 動作環境、
Microsoft Windows NT および Windows 2000、Sun™ Linux 5.0 および Red Hat 
Linux 7.2 および 7.3。

エージェントは、接続されているディスク記憶装置を監視し、これらの装置の状
態をコンソールに報告します。エージェント ソフトウェアは、ネットワーク内の 
Configuration Service の一部である各サーバにインストールする必要がありま
す。インストールは、ネットワーク上のリモートの単一ワークステーションから
実行できます。 

■ Configuration Service コンソール - Solaris 8 および Solaris 9 動作環境、Microsoft 
Windows NT および Windows 2000、Sun Linux 5.0 および Red Hat Linux 7.2 お
よび 7.3。

コンソールには、Configuration Service の GUI 部分が含まれており、エージェン
トによって報告される情報を表示します。また、コンソールを使って、1 つのワー
クステーションからリモートでデバイスを構成、管理することができます。
Configuration Service コンソールは、ネットワーク上のサーバを管理するコン
ピュータにインストールする必要があります。
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第 2 章

インストール前に

この章では、インストールして Configuration Service プログラムおよび本ユーザ ガ
イドを使い始める前に確認しなければならない重要な事項について説明します。この
章には以下の項目が含まれます。

■ 3 ページの「アレイに適切な Configuration Service バージョン」
■ 4 ページの「画面の例について」
■ 4 ページの「Solaris 動作環境」
■ 4 ページの「Microsoft Windows NT/2000 オペレーティング システム」
■ 5 ページの「スーパーユーザー／管理者の特権」

アレイに適切な Configuration Service 
バージョン
以下の表は、Sun StorEdge アレイに適切な Configuration Service バージョンを示し
ています。

表 2-1 適切な Configuration Service のバージョン

Configuration 
Service の
バージョン

適切な Sun StorEdge ア
レイ コメント

1.0 Sun StorEdge 3310 SCSI 
Array

Configuration Service の 初の SCSI のみのリ
リース

1.2 Sun StorEdge 3510 FC ア
レイ

Configuration Service プログラムおよびユーザ 
ガイドには、LUN フィルタリングを含むファ
イバ チャネル機能が追加されて更新されていま
す。
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画面の例について
本書では Configuration Service プログラムの例を示すために、全体を通じて多数の
画面が例として使用されています。これらの画面は、Sun StorEdge 3310 アレイまた
は Sun StorEdge 3510 アレイのいずれかから出力したものです。 特定の機能とその
画面の例が Sun StorEdge 3510 FC アレイのみに該当すると特記されない限り、機能
は両方のアレイに該当します。

Solaris 動作環境
Solaris 動作環境でのシステムに Configuration Service をインストールする前に、以
下の事項を確認してください。

■ Configuration Service エージェントをインストールするホスト サーバが、プライ
マリ ID が割り当てられたチャネルに接続されていること。コントローラのデフォ
ルト値と初期構成情報については、『Sun StorEdge 3000 Family 導入・運用・
サービス マニュアル』を参照してください。

■ Sun StorEdge 3310 SCSI アレイにおいて、同一 ID の LUN が動作環境で認識され
ることを確認してください。追加のホスト LUN を割り当てるには、
/kernel/drv/sd.conf を修正する必要がある場合があります。このファイル
の修正方法の詳細は、ご使用の SCSI アレイ用の『Sun StorEdge 3000 Family 導
入・運用・サービス マニュアル』を参照してください。sd.conf ファイルを変更
した場合、変更を有効にするためにワークステーションをリブートする必要があ
ります。

Microsoft Windows NT/2000 オペレー
ティング システム
Microsoft Windows 動作環境でのシステムに Configuration Service をインストール
する前に、以下の事項を確認してください。

■ Configuration Service エージェントをインストールするホスト サーバが、プライ
マリ ID が割り当てられたチャネルに接続されていること。コントローラのデフォ
ルト値と初期構成情報については、『Sun StorEdge 3000 Family 導入・運用・
サービス マニュアル』を参照してください。
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■ サーバがオペレーティング システムに接続されていて、サーバがストレージを認
識すること。

スーパーユーザー／管理者の特権
Configuration Service をインストールし、Configuration Service コンソールを実行
するには、スーパーユーザー／管理者の特権が必要です。
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第 3 章

Solaris 動作環境システムでの 
Configuration Service のインストー
ル

この章では、Solaris 動作環境でのシステムに Configuration Service コンソールおよ
びエージェントをインストールする手順を説明します。この章でふれるトピックは以
下のとおりです：

■ 7 ページの「システム要件」
■ 8 ページの「Configuration Service のインストールの前に」
■ 9 ページの「ソフトウェアのインストール」
■ 16 ページの「ユーザーとパスワード」
■ 18 ページの「Configuration Service のアンインストール」
■ 19 ページの「構成の復元」

システム要件
■ Netscape™ 4.0 以降 - オンライン ヘルプの表示用。

■ コンソール用の TCP/IP 準拠のネットワーク インターフェイス - 各 Configuration 
Service コンソールには TCP/IP 準拠のネットワーク インターフェイス(イーサ
ネット、トークン リング ネットワーク カード、またはモデム付きのシリアル ラ
インなど)が必要です。 

■ Configuration Service コンソールは、解像度 800 x 600 ピクセルで 256 色のモニ
ターを使用すると 適に表示されます。コンソールのその他の要件は、下表を参
照してください。
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■ エージェント用の TCP/IP 準拠のネットワーク インターフェイス - 各 
Configuration Service エージェントには、TCP/IP準拠のネットワーク カード イ
ンターフェイスと(オペレーティング システムに含まれる)ドライバ セットが必要
です。エージェントのその他の要件は、下表を参照してください。

Configuration Service のインストールの
前に
Configuration Service とその関連ソフトウェア コンポーネントをインストールする
前に、以下の必要な手順と追加オプションを確認してください。

■ ご使用のアレイ用の『Sun StorEdge 3000 Family Release Notes』を必ずお読みく
ださい。

■ 動作環境のアップデートをインストールしてください。Configuration Service を 
Solaris 動作環境で使用するには、Solaris 8 および Solaris 9 動作環境用の 新の 
Sun 推奨動作環境パッチと Java パッチをインストールする必要があります。Sun 
推奨パッチのリストは、ご使用のアレイ用の『Sun StorEdge 3000 Family Release 
Notes』を参照してください。 

表 3-1 コンソールのシステム要件 

Solaris 動作環境バージョン メモリ ディスク空き容量

Sun 推奨パッチ付き Solaris 
8 および Solaris 9
（Sun 推奨パッチのリスト
は、ご使用のアレイ用の
『Sun StorEdge 3000 
Family Release Notes』を参
照。）

64 MB 推奨 小 16 MB のディスク空き容量

表 3-2 エージェントのシステム要件 

Solaris 動作環境バージョン メモリ ディスク空き容量

Solaris 8 および Solaris 9 小 128 MB 1 MB のディスク空き容量
小
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■ 動作環境にエンタープライズ管理コンソールが含まれている場合、オプションと
して、SNMP サービスを使用してトラップ イベントをコンソールに送信するよう
に、Configuration Service エージェントを構成することができます。SNMP サー
ビスは動作環境に含まれており、TCP/IP プロトコル スタックのインストール後
にインストールされます。

■ ネットワーク上の Configuration Service サーバからエンタープライズ管理コン
ソールに SNMP トラップを送信する方法の詳細は、「235 ページの「電子メール
と SNMP」」を参照してください。

■ オプション。Configuration Service の併用ユーティリティであり、ストレージ シ
ステムのイベントを指定の電子メール アドレスに通知する Sun StorEdge 
Diagnostic Reporter のインストールと使用方法は、『Sun StorEdge 3000 Family 
Diagnostic Reporter ユーザ ガイド』を参照してください。

注 – Configuration Service をインストールし、Configuration Service コンソールを
実行するには、スーパーユーザーの特権が必要です。

ソフトウェアのインストール
Configuration Service ソフトウェアは、以下のコンポーネントから構成されます。

■ Configuration Service エージェント

■ Configuration Service コンソール

■ Diagnostic Reporter (オプションのユーティリティ - インストールと動作の詳細
は、『Sun StorEdge 3000 Family Diagnostic Reporter ユーザ ガイド』を参照）

Configuration Service インストール パッケージ

Configuration Service インストール パッケージは、Sun StorEdge 300 Family 
Professional Storage Manager CD にあり、以下のファイルが含まれています。

■ SUNWscsd – Configuration Service エージェント
■ SUNWscsu – Configuration Service コンソール
■ SUNWscsa – Diagnostic Reporter エージェント
■ SUNWscui – Diagnostic Reporter Config Tool (UI)
■ SUNWsccli – コマンド ライン インターフェイス（CLI）
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▼ Configuration Service エージェントおよびコン
ソールをインストールする

Configuration Service の一部である各サーバにエージェントをインストールしてくだ
さい。コンソールは、ストレージ システムの維持管理に使用するコンピュータと
ワークステーションにインストールしてください。

Configuration Service 管理コンソール パッケージ SUNWscsu は、サーバまたは任意
のクライアントにインストールできます。Configuration Service エージェント パッ
ケージ SUNWscsd は、ストレージが接続されるサーバにインストールする必要があ
ります。

エージェント、コンソール、またはその両方をインストールするには、以下の手順を
完了してください。Configuration Service を実行するには、少なくとも 1 つのエー
ジェントと 1 つのコンソールをインストールする必要があります。

注 – Configuration Service のインストール先のコンピュータまたはワークステー
ション上に Java Runtime Environment 1.2 以上がインストールされていることを確
認してください。 

注 – コンソールまたはエージェントをアップグレードする場合は、Configuration 
Service をアンインストールする必要があります。Configuration Service のアンイン
ストールの詳細は、「18 ページの「Configuration Service のアンインストール」」
を参照してください。

1. Sun StorEdge 3000 Family Professional Storage Manager CD を挿入し、次のように
入力します。

2. パッケージを次のいずれかの方法でインストールします。

a. エージェントだけをインストールする場合は、次のように入力します。

b. コンピュータだけをインストールする場合は、次のように入力します。

# cd /cdrom/cdrom0/product/solaris

# pkgadd -d SUNWscsd

# pkgadd -d SUNWscsu
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c. 全部のパッケージをインストールする場合は、次のように入力します。

d. インストールするパッケージをメニューから選択する場合は、次のように入力し
ます。

e. 両エージェント(Configuration Service と Diagnostic Reporter)のみをインストー
ルする場合は、次のように入力します。

3. 標準インストール プロンプトのそれぞれに対して、適切な応答を入力します。

インストール プロンプトは、インストールするパッケージの選択と、（スーパー
ユーザー特権での）スクリプトの処理方法に関する標準の pkgadd -d プロンプト
です。

a. Select packages プロンプトで、インストール方法に応じた適切な応答を入力
します。 

たとえば、上記で 2a または 2b を選択した場合は、1 を入力して Return キーを押
します。

b. 以前にエージェントをインストールしていた場合、その構成を復元するかどうか
尋ねられます。

構成を復元するには、y と入力します。n と入力する場合、管理サーバを再度有効
にする必要があります。

# pkgadd -d . all

# pkgadd -d .

# pkgadd -d .SUNWscsd SUNWscsa

Select package(s) you wish to process (or ’all’ to process all 
packages). (default:all) [?,??,q]: 1
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注 – Configuration Service をアンインストールすると、ユーザ パスワードは削除さ
れます。以前の構成が存在する場合、16 ページの「ユーザーとパスワード」での説
明のとおり、ssmon、ssadmin および ssconfig パスワードを再入力する必要があ
ります。

c. 以前にコンソールをインストールしていた場合、その構成を復元するかどうか尋
ねられます。

構成を復元するには、y を押します。n と入力する場合、サーバ情報を再度追加す
る必要があります。

d. インストールを続行するには、y を入力して Return キーを押します。

エージェントのインストールが完了したら、エージェントのインストールが成功
し、起動したことを示す次のメッセージが表示されます。 

インストール プログラムによって、Java runtime 1.2 以上がインストールされている
ことが確認されます。見つからない場合、パスを指定するよう求められます。Java 
runtime environment 1.2.2、1.3、または 1.4 がインストールされていることが分かっ
ていてもインストール プログラムがそれを見つけられない場合、/usr ディレクトリ

The previous configuration was saved.User passwords must be 
reentered.Do you want to restore the configuration [y,n,?,q]:y

The previous configuration was saved.Do you want to restore the 
configuration [y,n,?,q]:y

Do you want to continue with the installation [y,n,?] y

Configuring and starting Sun StorEdge(tm) Configuration Service 
agent daemons:
       The configuration is complete.
       Sun StorEdge(tm) Configuration Service agent server daemon 
has started.
       Sun StorEdge(tm) Configuration Service agent monitor daemon 
has started.
Sun StorEdge(tm) Configuration Service agent startup is complete.

Installation of <SUNWscsd> was successful.
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をチェックし、Java から Java 1.1 以外の 新バージョンの Java へのリンクがあるこ
とを確認します。リンクの作成方法は、251 ページの「トラブルシューティング」を
参照してください。

Configuration Service エージェントおよびコンソールは、次のディレクトリにインス
トールされます。/opt/SUNWsscs/sscsconsole.
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4. Configuration Service オンライン ヘルプにアクセスするには、Web ブラウザ
(Netscape 4.0 以降)へのパスを指定する必要があります。

a. /opt/SUNWsscs/sscsconsole に移動し、次のように入力します。 

b. Web ブラウザへの絶対パスを入力します。

注 – ブラウザのパス名はいつでも構成できますが、いずれかの時点で指定しないと
オンライン ヘルプにアクセスできません。

5. Sun StorEdge 3310 SCSI アレイについては、次の場合に /kernel/drv/sd.conf 
を編集します。

■ 複数のドライブと複数の LUN でサードパーティ HBA （ホスト バス アダプタ）
を使用する。

■ ファイバ デバイスを使用する。
■ すべての LUN が同じ ID を持つ。

構成に応じて論理ユニット番号（LUN）の行を追加します。LUN には 0-31 の番号を
付けることができます。LUN を定義すると、ストレージが接続されていない場合で
も各 SCSI バスがスキャンされてしまいます。その時間を削減するためにも計画して
いる以上に LUN を定義しないことが通常は推奨されます。sd.conf ファイルの修正
方法の詳細は、ご使用のアレイ用の『Sun StorEdge 3000 Family 導入・運用・サービ
ス マニュアル』を参照してください。

6. sd.conf ファイルを編集した場合のみ、再構成を反映するためにリブートを行いま
す。

./config_sscon
14 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



▼ Configuration Service エージェントを起動または
停止する

Configuration Service エージェントは、/etc/init.d/ssagent にある実行コマン
ド スクリプトを使って、手動で停止および起動できます。

1. エージェントを起動するには、次のように入力します。

注 – エージェントを起動するには、スーパーユーザの特権を持ち、Bourne シェルか
ら実行する必要があります。

初に stop を使用せずに start を使った場合、スクリプトは、停止されていた任
意のエージェントを再起動します。すべてのエージェントが(たとえば stop オプ
ションで)停止されていた場合、スクリプトはランタイム環境を再設定してからエー
ジェントを再起動します。

2. エージェントを停止するには、次のように入力します。

3. エージェントが実行されているか確認するには、次のように入力します。

ssmon と ssserver の両方が出力に表示されます。SNMP トラップ生成を有効にし
てあった場合は、その名前 sstrapd も表示されます。

4. 最初のリブート後にストレージ システムが表示されなかった場合は、エージェント
を停止し、コマンド プロンプトで次のコマンドを実行します。

5. 必要なディスクにラベルを付けたあと、Configuration Service エージェントを再起動
します。

# /etc/init.d/ssagent start

# /etc/init.d/ssagent stop

# ps -e | grep ss

# format
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ユーザーとパスワード

管理（ユーザー）セキュリティ レベルとガイドライン

Solaris 動作環境のシステムで Configuration Service アプリケーションを実行する場
合、管理セキュリティ レベルはインストール プロセスで自動的に作成されます。必
要な操作は、許可レベルに応じてパスワードを設定し、ユーザーを割り当てることだ
けです。 

Configuration Service の管理機能では、管理者が、ほかのクライアントやホストに属
するストレージ リソースを許可なく再割り振りしたり削除したりすることのないよ
うに、アクセス ログインとパスワードが要求されます。 

Configuration Service プログラムの 3 つのセキュリティ レベルに個別のパスワード
を割り当ててください。これを行うには、Configuration Service で管理されるスト
レージ デバイスを持つエージェントに 3 つのユーザーをセットアップします。この 3 
つのユーザーは、Configuration Service エージェントのインストール時に自動的に追
加されます。

Configuration Service のセキュリティ レベルの名前は、次のとおりでなければなり
ません。 
■ ssmon

ソフトウェアの監視レベルを表します。

■ ssadmin

ソフトウェアの管理レベルを表します。リビルド、パリティ チェック、およびパ
リティ チェックのスケジュールの機能へのアクセスと、監視機能を提供します。 

■ ssconfig

ソフトウェアの構成レベルを表します。インストール者に、構成機能およびプロ
グラムのその他の関連機能への直接アクセスを提供します。 

3 つのセキュリティ レベルにはこれらのログイン名が必要です。インストールの後、
各セキュリティ名にパスワードを割り当てる必要があります。

ssmon、ssadmin、および ssconfig は、Configuration Service のセキュリティ レ
ベルのみに関連付けられるログインです。UNIX 動作環境(Solaris/Linux OE)では、
ユーザ ID が対話的なログインに使用されることを防ぐために、アカウントのデフォ
ルト シェルが /bin/false に割り当てられます。

Configuration Service は、ユーザーがssmon パスワードを入力せずに監視機能を実
行できるようにセットアップできます。これを行うには、Configuration Service コン
ソールでサーバを Managed Servers リストに追加するときに、Auto Discovery オプ
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ションを選択します。この 3 つのログインとパスワードは各サーバ上でローカルに
セットアップできます。（必要であれば、これらのアカウントにサーバごとに異なる
パスワードを設定することもできます。） 

管理するエージェントにこの 3 つのログインをセットアップした後、システム管理者
は通常、タスクの完了に必要なセキュリティ レベルに基づいてユーザーに適切なパ
スワードを割り当てることにより、Configuration Service へのユーザー アクセスを
提供します。たとえば、特定のサーバに対する管理特権を持つものは全員、ユーザ 
ssadmin 用に確立された同じパスワードが割り当てられます。

注 – Managed Servers リストにサーバを追加する方法は、46 ページの「サーバを追
加する」を参照してください。
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▼パスワードと許可を作成する

各新規ユーザーにパスワードを作成するには、次のように入力します。

管理者はグループ許可を変更することもできます。グループ許可は、インストール時
の /opt/SUNWsscs/sscsconsole ディレクトリにある svrlist.dat  ファイルで
定義されています。 

Configuration Service コンソールは Java ベースのユーティリティであるため、
Configuration Service が作成するファイルの許可や所有権を制御する機能は提供しま
せん。svrlist.dat ファイルは、各種の ASCII テキスト プロセッサで容易に読み
取ることができます。このファイルには、ユーザー ssmon の暗号化されたパスワー
ドが含まれており、解読可能です。 

注 – 監視するエージェントをすべて追加したあとで、svrlist.dat の許可とグルー
プ所有権を変更しないでください。

Configuration Service のアンインストール 
コンソールまたはエージェントをアップグレードする場合は、Configuration Service 
をアンインストールする必要があります。一部のファイルは削除されませんが、その
理由はこれらがインストールの後に作成され、アップグレード環境でも有効だからで
す。

# パスワード ユーザ名
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▼ Configuration Service をアンインストールする

pkgrm コマンドの後に、アンインストールする Configuration Service パッケージ 
SUNWscsu （コンソール）または SUNWscsd （エージェント）を指定します。 

構成の復元
エージェントまたはコンソールを再インストールする場合、インストールの実行中に
構成を復元するかどうか尋ねられます。構成を復元するように選択した場合、以下の
ファイルから情報が復元されます。

■ /var/opt/SUNWsscs/sscsagt.cfg.tar - Configuration Service エージェント

■ /var/opt/SUNWsscs/sscscon.cfg.tar - Configuration Service コンソール

注 – Configuration Service を永久に削除するときにこれらのファイルを手動で削除
したくなることがありますが、Configuration Service を再インストールするときに、
エージェントの構成およびコンソールの構成を復元できなくなります。

# pkgrm SUNWscsu

# pkgrm SUNWscsd
第 3 章 Solaris 動作環境システムでの Configuration Service のインストール 19



20 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



第 4 章

Microsoft Windows NT/2000 オペレー
ティング システムでの Configuration 
Service のインストール

この章では、Microsoft Windows NT/2000 オペレーティング システムでのシステム
における、Configuration Service コンソールおよびエージェントのシステム要件とイ
ンストール手順を説明します。この章でふれるトピックは以下のとおりです：

■ 21 ページの「システム要件」
■ 22 ページの「Configuration Service のインストールの前に」
■ 23 ページの「ソフトウェアのインストール」
■ 25 ページの「ユーザーとパスワード」
■ 27 ページの「Configuration Service のアンインストール」

システム要件
■ Netscape 4.0 以降または Microsoft Internet Explorer 4.0 以降 - オンライン ヘルプ

の表示用。

■ コンソール用の TCP/IP 準拠のネットワーク インターフェイス - 各 Configuration 
Service コンソールには、TCP/IP 準拠のネットワーク インターフェイス(イーサ
ネット、トークン リング ネットワーク カード、またはモデム付きのシリアル ラ
インなど)が必要です。コンソールのその他の要件は、下表を参照してください。
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■ エージェント用の TCP/IP 準拠のネットワーク インターフェイス - 各 
Configuration Service エージェントには、TCP/IP 準拠のネットワーク カード イ
ンターフェイスと（オペレーティング システムに含まれる）ドライバ セットが必
要です。エージェントのその他の要件は、下表を参照してください。

Configuration Service のインストールの
前に
Configuration Service とその関連ソフトウェア コンポーネントをインストールする
前に、以下の必要な手順と追加オプションを確認してください。

■ ご使用のアレイ用の『Sun StorEdge 3000 Family Release Notes』を必ずお読みく
ださい。

■ 動作環境にエンタープライズ管理コンソールが含まれている場合、オプションと
して、SNMP サービスを使用してトラップ イベントをコンソールに送信するよう
に、Configuration Service エージェントを構成することができます。SNMP サー
ビスは動作環境に含まれており、TCP/IP プロトコル スタックのインストール後
にインストールされます。

■ ネットワーク上の Configuration Service サーバからエンタープライズ管理コン
ソールに SNMP トラップを送信する方法の詳細は、「235 ページの「電子メール
と SNMP」」を参照してください。 

表 4-1 コンソールのシステム要件

OS バージョン メモリ ディスク空き容量

Microsoft Windows NT 4.0
（SP 3 以降）

Microsoft Windows 2000

小 32 MB
64 MB 推奨

小 20 MB のディスク空き容量

40 MB 推奨

表 4-2 エージェントのシステム要件

OS バージョン メモリ
ディスク空き容
量

Microsoft Windows NT 4.0 
（Service Pack 3、4、5、  
または 6）
Microsoft Windows 2000

小 32 MB、または 64 MB 以上を推奨。
要件は、データベースなど、ほかの大型ア
プリケーション プログラムにより決定さ
れる。

2 MB のディス
ク空き容量
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■ オプション。Configuration Service の併用ユーティリティであり、ストレージ シ
ステムのイベントを指定の電子メール アドレスに通知する Sun StorEdge 
Diagnostic Reporter のインストールと使用方法は、『Sun StorEdge 3000 Family 
Diagnostic Reporter ユーザ ガイド』を参照してください。

注 – Configuration Service をインストールし、Configuration Service コンソールを
実行するには、管理者の特権が必要です。

ソフトウェアのインストール
Configuration Service ソフトウェアは、以下のコンポーネントから構成されます。

■ Configuration Service エージェント

■ Configuration Service コンソール

■ Diagnostic Reporter(オプションのユーティリティ – インストールと動作の詳細
は、『Sun StorEdge 3000 Family Diagnostic Reporter ユーザ ガイド』を参照）

Configuration Service によってストレージが管理される各サーバにエージェントをイ
ンストールしてください。コンソールは、ストレージ システムの維持管理に使用す
るコンピュータとワークステーションにインストールしてください。

Configuration Service インストール パッケージ

Configuration Service インストール パッケージは、Sun StorEdge Professional 
Storage Manager CD にあり、以下のファイルが含まれています。

■ Sun StorEdge Configuration Service エージェント

■ Sun StorEdge Configuration Service コンソール

■ Sun StorEdge Diagnostic Reporter

■ Sun StorEdge コマンド ライン インターフェイス

▼ Configuration Service エージェントおよびコン
ソールをインストールする 
Configuration Service で管理されるストレージを持つ各 Microsoft Windows 
NT/2000 サーバに Configuration Service エージェントをインストールする必要があ
ります。 
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注 – Configuration Service コンソールのインストール先のコンピュータまたはワー
クステーション上に Java Runtime Environment 1.2 以上がインストールされている
ことを確認してください。 

1. ソフトウェア インストール ユーティリティ機能が最適に動作するように、動作中の
すべての Windows アプリケーションを終了します。

2.  Sun StorEdge 3000 Family Professional Storage Manager CD を挿入し、
\product\windows ディレクトリに移動します。

3. setup.exe をダブルクリックして、ソフトウェア コンポーネント、SUNWsscs 
Agent  または SUNWsscs Console をインストールするか選択します。

4. Choose Destination Location ウィンドウで、デフォルト フォルダをインストール
し、Next をクリックします。エージェントは、C:\Program Files\Sun\ssagent 
にインストールされ、コンソールは C:\Program Files\Sun\sscs にインストー
ルされます。

別のフォルダにインストールするには、Browse　をクリックしてそのフォルダを選
択し、Next をクリックします。 

インストールが完了したら、エージェントは自動的に起動します。

▼ Configuration Service エージェントの起動と停止

Microsoft Windows NT サーバ

サーバで Configuration Service エージェントを起動するには、サーバをリブートす
るか、Settings → Control Panel → Services から、SUNWscsd Startup、SUNWscsd 
Server、および SUNWscsd Monitor の 3 つのサービスを起動します。 

Configuration Service エージェントを停止するには、Settings → Control Panel → 
Services にアクセスし、停止するエージェントを選択して Stop をクリックします。

Microsoft Windows 2000 サーバ

1. Start → Administrative Services → Computer Management を選択します。 

2. Services & Applications をクリックします。

3. 停止するサービス（SUNWscsd Monitor、SUNWscsd Server、または SUNWscsd 
Startup）を右クリックします。 
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別の方法として、Start  Settings → Control Panel → Admin Tools → Computer 
Management を使用することもできます。 

ユーザーとパスワード 

管理者（ユーザー）セキュリティ レベルとガイド
ライン

Configuration Service の管理機能では、管理者が、ほかのクライアントやホストに属
するストレージ リソースを許可なく再割り振りしたり削除したりすることのないよ
うに、アクセス ログインとパスワードが要求されます。Configuration Service の 3 
つのセキュリティ レベルに個別のパスワードを割り当ててください。これを行うに
は、Configuration Service で管理されるストレージ デバイスを持つエージェントに 3 
つのユーザーをセットアップします。 

Configuration Service のセキュリティ レベルの名前は、次のとおりでなければなり
ません。 
■ ssmon

ソフトウェアの監視レベルを表します。

■ ssadmin

ソフトウェアの管理レベルを表します。リビルド、パリティ チェック、およびパ
リティ チェックのスケジュールの機能へのアクセスと、監視機能を提供します。 

■ ssconfig

ソフトウェアの構成レベルを表します。インストール者に、構成機能およびプロ
グラムのその他の関連機能への直接アクセスを提供します。 

3 つのセキュリティ レベルにはこれらの名前が必要です。インストールの後、各セ
キュリティ名にパスワードを割り当てる必要があります。

ssmon、ssadmin、および ssconfig は、Configuration Service のセキュリティ レ
ベルのみに関連付けられるログインです。

Configuration Service は、ユーザが ssmon  パスワードを入力せずに監視機能を実
行できるようにセットアップできます。このためには、Configuration Service コン
ソールでサーバを Managed Servers リストに追加するときに、Auto Discovery オプ
ションを選択します。この 3 つのログインとパスワードは各サーバ上でローカルに
セットアップできます。（これらのアカウントにサーバごとに異なるパスワードを設
定することもできます。） 
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管理するエージェントにこの 3 つのログインをセットアップした後、システム管理者
は通常、タスクの完了に必要なセキュリティ レベルに基づいてユーザに適切なパス
ワードを割り当てることにより、Configuration Service へのユーザ アクセスを提供
します。たとえば、特定のサーバに対する管理特権を持つものは全員、ユーザー 
ssadmin 用に確立された同じパスワードが割り当てられます。

注 – Managed Servers リストにサーバを追加する方法は、「 46 ページの「サーバを
追加する」」を参照してください。

複数サーバに対するグローバル パスワード

大規模ネットワークを使用しているため個々のログインをセットアップしたくない場
合で、複数のサーバが同じパスワードを持つことが許可されているときは、この 3 つ
のログインを Microsoft Windows でのドメイン サーバ上に確立することができま
す。これにより、この Microsoft Windows ドメイン内のほかのすべてのサーバが、
それぞれのパスワードを使って 3 つのログインにアクセスできるようになります。

▼ Microsoft Windows NT ユーザーを作成する

1. NT User Manager プログラムを使ってユーザーを追加します。 

2. Policies を選択して、User Rights を選択します。 

3. Show Advanced User Rights を選択します。

4.  NT ユーザー管理者に、Act as a part of the operating system の権限を与えます。

5. User Properties で、User Must Change Password at Next Login を選択解除します。

6. User Properties で、User Cannot Change Password （ユーザーはパスワードを変更
できない）と Password Never Expires （パスワードは失効しない）を選択します。

7. 複数のサーバ設定を必要としないようにドメイン サーバ上にユーザー名をセット
アップする場合は、被管理のサーバが、Configuration Service ユーザー アカウント
が確立されたドメインに属していることを確認してください。

詳細は、Microsoft Windows NT の説明書を参照してください。
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▼ Microsoft Windows 2000 ユーザを作成する

1. Settings → Control Panel → Administrative Tools → Computer Management → 
System Tools → Local Users and Groups にアクセスし、Users を選択します。

2. Users フォルダを右クリックし、New User を選択して 3 人のユーザ(ssmon、
ssconfig、 および ssadmin）を追加します。

3. User name で、ユーザの 1 人を追加します。必要であれば、Description にその説明
を入力します。

4. パスワードを入力し、必要であれば、User Cannot Change Password(ユーザはパス
ワードを変更できない)と Password Never Expires(パスワードは失効しない)を選択
します。

Configuration Service のアンインストール
Configuration Service を Microsoft Windows コンソールから削除するには、
Windows の Add/Remove Programs ユーティリティを使用してください。 

▼ Configuration Service をアンインストールする

1. Start → Settings → Control Panel → Add/Remove Programs にアクセスします。

2. Configuration Service エージェントを選択し、Add/Remove を選択します。プロンプ
トに対して適切に答えます。

3. Configuration Service コンソールを選択し、Add/Remove を選択します。プロンプト
に対して適切に答えます。
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第 5 章

Linux 動作環境システムでの 
Configuration Service のインストール

この章では、Sun Linux または Red Hat Linux 動作環境でのシステムに 
Configuration Service コンソールおよびエージェントをインストールする手順を説明
します。この章でふれるトピックは以下のとおりです：

■ 29 ページの「システム要件」
■ 30 ページの「Configuration Service のインストールの前に」
■ 31 ページの「ソフトウェアのインストール」
■ 34 ページの「ユーザとパスワード」
■ 36 ページの「Configuration Service のアンインストール」

システム要件
■ Netscape™ 4.0 以降 - オンライン ヘルプの表示用。

■ コンソール用の TCP/IP 準拠のネットワーク インターフェイス - 各 Configuration 
Service コンソールには、TCP/IP 準拠のネットワーク インターフェイス(イーサ
ネット、トークン リング ネットワーク カード、またはモデム付きのシリアル ラ
インなど)が必要です。 

■ Configuration Service コンソールは、解像度 800 x 600 ピクセルで 256 色のモニ
ターを使用すると 適に表示されます。コンソールのその他の要件は、下表を参
照してください。
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■ エージェント用の TCP/IP 準拠のネットワーク インターフェイス - 各 
Configuration Service エージェントには、TCP/IP 準拠のネットワーク カード イ
ンターフェイスと（オペレーティング システムに含まれる）ドライバ セットが必
要です。エージェントのその他の要件は、下表を参照してください。

Configuration Service のインストールの
前に
Configuration Service とその関連ソフトウェア コンポーネントをインストールする
前に、以下の必要な手順と追加オプションを確認してください。

■ ご使用のアレイ用の『Sun StorEdge 3000 Family Release Notes』を必ずお読みく
ださい。

■ 動作環境にエンタープライズ管理コンソールが含まれている場合、オプションと
して、SNMP サービスを使用してトラップ イベントをコンソールに送信するよう
に、Configuration Service エージェントを構成することができます。 

■ ネットワーク上の Configuration Service サーバからエンタープライズ管理コン
ソールに SNMP トラップを送信する方法の詳細は、「235 ページの「電子メール
と SNMP」」を参照してください。 

■ オプション。Configuration Service の併用ユーティリティであり、ストレージ シ
ステムのイベントを指定の電子メール アドレスに通知する Sun StorEdge 
Diagnostic Reporter のインストールと使用方法は、『Sun StorEdge 3000 Family 
Diagnostic Reporter ユーザ ガイド』を参照してください。

表 5-1 コンソールのシステム要件 

 Linux のバージョン メモリ ディスク空き容量

Sun Linux 5.0
Red HatÆ Linux 7.2 および 
7.3

小 256 MB 10 MB

表 5-2 エージェントのシステム要件 

Linux のバージョン メモリ ディスク空き容量

Solaris 8 および Solaris 9 小 128 MB 1 MB
30 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



注 – Configuration Service をインストールし、Configuration Service コンソールを
実行するには、スーパーユーザーの特権が必要です。

ソフトウェアのインストール
Configuration Service ソフトウェアは、以下のコンポーネントから構成されます。

■ Configuration Service エージェント

■ Configuration Service コンソール

■ Diagnostic Reporter(オプションのユーティリティ - インストールおよび動作の詳
細は、『Sun StorEdge 3000 Family Diagnostic Reporter ユーザ ガイド』を参照）

Configuration Service インストール パッケージ

Configuration Service インストール パッケージは、Sun StorEdge 300 Family 
Professional Storage Manager CD にあり、以下のファイルが含まれています。

■  SUNWscsu.rpm  - Configuration Service コンソール
■  SUNWscsd.rpm  - Configuration Service エージェント
■  SUNWscsa.rpm  - Diagnostic Reporter エージェント
■  SUNWscui.rpm  - Diagnostic Reporter Config Tool (UI)
■  SUNWsccli.rpm  - コマンド ライン インターフェイス（CLI）

▼ Configuration Service エージェントおよびコン
ソールをインストールする

Configuration Service の一部である各サーバにエージェントをインストールしてくだ
さい。コンソールは、ストレージ システムの維持管理に使用するコンピュータと
ワークステーションにインストールしてください。

Configuration Service 管理コンソール パッケージ SUNWscsu.rpm は、サーバまたは
任意のクライアントにインストールできます。Configuration Service エージェント 
パッケージ SUNWscsd.rpm は、ストレージが接続されるサーバにインストールする
必要があります。

エージェント、コンソール、またはその両方をインストールするには、以下の手順を
完了してください。Configuration Service を実行するには、少なくとも 1 つのエー
ジェントと 1 つのコンソールをインストールする必要があります。
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注 – Configuration Service のインストール先のコンピュータまたはワークステー
ション上に Java Runtime Environment 1.2 以上がインストールされていることを確
認してください。 

1. Configuration Service のインストール先のコンピュータまたはワークステーション上
に Java Runtime Environment 1.2 以上がインストールされていない場合は、ただち
にインストールします。

2. ファイル システムに CD ROM がマウントされていない場合は、マウントします。

3. Sun StorEdge 3000 Family Professional Storage Manager CD を挿入し、次のように
入力します。

4. パッケージを次のいずれかの方法でインストールします。

a. エージェントだけをインストールする場合は、次のように入力します。

b. コンピュータだけをインストールする場合は、次のように入力します。

5. Configuration Service オンライン ヘルプにアクセスするには、コンソールをインス
トールするシステムに Web ブラウザがインストールされている必要があります。
Web ブラウザが検出されない場合、Web ブラウザ(Netscape 4.0 以降)へのパスを指
定するよう求められます。

a. /opt/SUNWsscs/sscsconsole に移動し、次のように入力します。 

b. Web ブラウザへの絶対パスを入力します。

# cd mount /dev/cdrom /mnt/cdrom

# cd /mnt/cdrom/product/linux

# rpm -ivh SUNWscsd.rpm

# rpm -ivh SUNWscsu.rpm

./config_sscon
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注 – ブラウザのパス名はいつでも構成できますが、いずれかの時点で指定しないと
オンライン ヘルプにアクセスできません。

エージェントのインストールが完了したら、コンポーネントのインストールが成功
し、起動したことを示す次のメッセージが表示されます。 

コンソールのインストールが完了したら、コンポーネントのインストールが成功し、
起動したことをします次のメッセージが表示されます。.

Configuration Service エージェントおよびコンソールは、次のディレクトリにインス
トールされます。/opt/SUNWsscs/sscsconsole

▼ Configuration Service エージェントを起動または
停止する

Configuration Service エージェントは、/etc/init.d/ssagent にある実行コマン
ド スクリプトを使って、手動で停止および起動できます。

1. エージェントを起動するには、次のように入力します。

または

# rpm -ivh SUNWscsd.rpm Preparing...
########################################### [100%] 1:SUNWscsd
########################################### [100%] add user ssmon 
add user ssadmin add user ssconfig Configuring and starting Sun 
StorEdge(tm) Configuration Service daemons[ OK ] 
Starting Sun StorEdge(tm) Configuration Service agent daemon[ OK ] 
Starting Sun StorEdge(tm) Configuration Service agent monitor 
daemon[ OK ]

# rpm -ivh SUNWscsu.rpm Preparing...
########################################### [100%] 1:SUNWscsu
########################################### [100%] 
Installation completed successfully!

# /etc/init.d/ssagent start

# service ssagent start
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注 – エージェントを起動するには、スーパーユーザの特権を持っている必要があり
ます。

初に stop を使用せずに、start を使った場合、スクリプトは、停止されていた
任意のエージェントを再起動します。すべてのエージェントが(たとえば stop オプ
ションで)停止されていた場合、スクリプトはランタイム環境を再設定してからエー
ジェントを再起動します。

2. エージェントを停止するには、次のように入力します。

3. エージェントが実行されているか確認するには、次のように入力します。

または

ssmon と ssserver の両方が出力に表示されます。SNMP トラップ生成を有効にし
てあった場合は、その名前 sstrapd も表示されます。

ユーザとパスワード

管理（ユーザー）セキュリティ レベルとガイドライン

Solaris 動作環境のシステムで Configuration Service アプリケーションを実行する場
合、管理セキュリティ レベルはインストール プロセスで自動的に作成されます。必
要な操作は、許可レベルに応じてパスワードを設定し、ユーザーを割り当てることだ
けです。 

Configuration Service の管理機能では、管理者が、ほかのクライアントやホストに属
するストレージ リソースを許可なく再割り振りしたり削除したりすることのないよ
うに、アクセス ログインとパスワードが要求されます。 

# /etc/init.d/ssagent stop

# ps -e | grep ss

# service ssagent status
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Configuration Service プログラムの 3 つのセキュリティ レベルに個別のパスワード
を割り当ててください。これを行うには、Configuration Service で管理されるスト
レージ デバイスを持つエージェントに 3 つのユーザーをセットアップします。この 3 
つのユーザーは、Configuration Service エージェントのインストール時に自動的に追
加されます。

Configuration Service のセキュリティ レベルの名前は、次のとおりでなければなり
ません。 
■ ssmon

ソフトウェアの監視レベルを表します。

■ ssadmin

ソフトウェアの管理レベルを表します。リビルド、パリティ チェック、およびパ
リティ チェックのスケジュールの機能へのアクセスと、監視機能を提供します。 

■ ssconfig

ソフトウェアの構成レベルを表します。インストール者に、構成機能およびプロ
グラムのその他の関連機能への直接アクセスを提供します。 

3 つのセキュリティ レベルにはこれらの名前が必要です。インストールの後、各セ
キュリティ名にパスワードを割り当てる必要があります。

ssmon、ssadmin、および ssconfig は、Configuration Service のセキュリティ レ
ベルのみに関連付けられるログインです。UNIX 動作環境(Solaris/Linux OE)では、
ユーザ ID が対話的なログインに使用されることを防ぐために、アカウントのデフォ
ルト シェルが /bin/false に割り当てられます。

Configuration Service は、ユーザーがssmon パスワードを入力せずに監視機能を実
行できるようにセットアップできます。これを行うには、Configuration Service コン
ソールでサーバを Managed Servers リストに追加するときに、Auto Discovery オプ
ションを選択します。この 3 つのログインとパスワードは各サーバ上でローカルに
セットアップできます。（必要であれば、これらのアカウントにサーバごとに異なる
パスワードを設定することもできます。） 

管理するエージェントにこの 3 つのログインをセットアップした後、システム管理者
は通常、タスクの完了に必要なセキュリティ レベルに基づいてユーザーに適切なパ
スワードを割り当てることにより、Configuration Service へのユーザー アクセスを
提供します。たとえば、特定のサーバに対する管理特権を持つものは全員、ユーザ 
ssadmin 用に確立された同じパスワードが割り当てられます。

注 – Managed Servers リストにサーバを追加する方法は、46 ページの「サーバを追
加する」を参照してください。
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▼パスワードと許可を作成する

各新規ユーザーにパスワードを作成するには、次のように入力します。

管理者はグループ許可を変更することもできます。グループ許可は、インストール時
の /opt/SUNWsscs/sscsconsole ディレクトリにある svrlist.dat  ファイルで
定義されています。 

Configuration Service コンソールは Java ベースのユーティリティであるため、
Configuration Service が作成するファイルの許可や所有権を制御する機能は提供しま
せん。svrlist.dat ファイルは、各種の ASCII テキスト プロセッサで容易に読み
取ることができます。このファイルには、ユーザー ssmon の暗号化されたパスワー
ドが含まれており、解読可能です。 

注 – 監視するエージェントをすべて追加したあとで、svrlist.dat の許可とグルー
プ所有権を変更しないでください。

Configuration Service のアンインストール 
コンソールまたはエージェントをアップグレードする場合は、Configuration Service 
をアンインストールする必要があります。一部のファイルは削除されませんが、その
理由はこれらがインストールの後に作成され、アップグレード環境でも有効だからで
す。

# パスワード ユーザ名
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▼ Configuration Service をアンインストールする

rpm -e コマンドの後に、アンインストールする Configuration Service パッケージ 
SUNWscsu.rpm (コンソール)または SUNWscsd.rpm (エージェント)を指定します。 

# rpm -e SUNWscsu.rpm

# rpm -e SUNWscsd.rpm
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第 6 章

Configuration Service のセットアップ

この章では、Configuration Service の一般的なセットアップ手順を説明します。この
章には以下の項目が含まれます。

■ 40 ページの「Configuration Service を起動する」
■ 46 ページの「サーバを追加する」 
■ 52 ページの「ログインとログアウト」
■ 53 ページの「コントローラを管理するサーバを選択する」 
■ 57 ページの「エージェントのパラメータを構成する(オプション)」 
■ 60 ページの「ストレージの構成を確認する」 
■ 62 ページの「論理ドライブの構成を保存する」 
■ 63 ページの「サーバにパーティションを作成する」 

Configuration Service を起動する

注 – Configuration Service コンソールを実行するには、スーパーユーザー／管理者
の特権が必要です。
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注 – Configuration Service コンソールは実行していない限りイベント アラートを受
信しません。このため、アレイの構成後、Configuration Service コンソール ワーク
ステーション上で、Configuration Service をその最小モードで常に実行状態にしてお
いてください。Configuration Service コンソール プログラムをフォアグラウンドで
常時実行する代わりに、Configuration Service の併用ユーティリティである 
Diagnostic Reporter を使用することができます。このユーティリティはバックグラ
ウンド サービスとして実行され、指定された電子メール アドレスにホストおよびア
レイからのメッセージを送信します。詳細は、『Sun StorEdge 3000 Family 
Diagnostic Reporter ユーザ ガイド』を参照してください。イベント アラートを受信
する別の方法については、『250 ページの「Configuration Service を使用せずに 
SNMP トラップを送信する」』を参照してください。

注 – Configuration Service でアレイを表示、管理するには、各 HBA カードがプライ
マリ コントローラに接続されている必要があります。

▼ Configuration Service を起動する

Solaris/Linux 動作環境

コマンド プロンプトで、次のように入力します。

Microsoft Windows NT/2000 オペレーティング システム

Start → Programs →Sun StorEdge 3000 Family → Configuration Service を選択しま
す。 

# ssconsole
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最初の使用の前と後のメイン ウィンドウ
Configuration Service を 初に初期化するとき、Configuration Service メイン ウィ
ンドウは空白です。表示される Add Server ウィンドウから、使用している 
Configuration Service コンソールの Managed Servers リストにサーバを追加できま
す。サーバの追加の詳細は、46 ページの「サーバを追加する」を参照してくださ
い。

Configuration Service を初めて起動したあとで、Managed Servers を選択したあと
は、Configuration Service を起動するたびに、Configuration Service メイン ウィン
ドウに Managed Servers リストからのサーバのアイコンが表示されます。OK または 
Cancel をクリックして、続行します。

新しいアレイを構成してワークステーションをブートした後、論理ドライブがラベル
付けされるまでプログラムがそのアレイを認識しない場合があります。これは、
Configuration Service がネイティブの Sun ドライバを使用するためです。

コンソールが使用中にロックした場合

Solaris または Linux 動作環境のシステムでは、Configuration Service コンソールが
使用中にロックした場合、Configuration Service エージェントに影響を与えずに 
Configuration Service を停止し、ウィンドウを閉じて再度開くことができます。

▼ Configuration Service を停止するには

1. コマンド プロンプトで、次のように入力します。

2. プログラムを再実行します。 

Configuration Service エージェントに影響を与えずに、このウィンドウが再び表示さ
れます。

# ssconsole stop
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メニュー、ツールバー、およびタブ

Configuration Service メイン ウィンドウにあるメニューバー、タブ、ツールバーを
確認してください。これらは、主な機能にアクセスするために使用します。
42 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



メニューバー

下図は、メイン メニューにあるオプションを示しています。

ツールバー

メニュー バーの下にあるツールバーには、よく使用する機能にすばやくアクセスで
きるアイコンが並んでいます。アイコンを選択すると、その機能がアクティブになり
ます。ツールバーのアイコンは、Configuration Service メイン ウィンドウで使用可
能なリソースに応じて、アクティブまたは無効(灰色)として表示されます。

Login

Logout

Server List Setup

Save Report

Exit

View Report

View Group

View Server

View Controller

View Logical Drive

View Physical Drive

View Enclosure 

View FRU

Event Log

Configure Host/WWN (Fibre Channel only) 

LUN Filter Properties (Fibre Channel only)

Save Configuration

Load Configuration

Standard Configure

Custom Configure

Controller Assignment

Controller Maintenance

Download FW for Devices

View Peripheral Device

Rebuild

Parity Check

Schedule Parity Check

Contents

About sscsConsole

Help

Array Admin Progress

Agent Options Management

Display HDD under LD
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アイコン 説明

Server List SetupConfiguration Service コンソールが管理する
サーバの追加、サーバ情報の編集、または使用可能なサーバが
管理されていることの指定を行います。

Event Logストレージ デバイスのステータス変化、ハードウェ
アのステータス変化、動作に関する通知などのイベントを表示
します。

Save Event LogEvent Log　ウィンドウを使用せずに Event Log 
を保存できる Save Event Log File　ダイアログ ボックスを表示
します。

Delete Event Logeventlog.txt ファイルの内容を手動で削除しま
す。(Configuration Service は、10,000 を上限にイベントを蓄積
し、イベント数がその数に達すると、自動的に Event Log サイ
ズを 新の 500 イベントに減らします。)

Save Report選択したサーバの各ストレージ コンポーネントに関
する、現在日における Configuration Service のデータが含まれ
るテキスト ファイルを作成します。

Standard Configuration選択したアレイ コントローラ上に、1 つ
の RAID レベルで 1 つまたは複数の論理ドライブを作成しま
す。Configuration Service が自動的にストレージを構成する、
構成の事前定義が必要な場合に使用します。

Custom Configuration選択したアレイ コントローラで、さまざ
まな RAID レベルの論理ドライブまたは論理ボリュームを構成
または再構成する複数のオプションを提供します。コントロー
ラ ID およびパラメータの設定または変更、RAID セットおよび
スタンバイ ドライブの定義または修正を含め、手動で構成を定
義する必要がある場合に使用します。
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タブ 
ツールバーの下にあるタブを使って、Configuration Service のほかの表示にすばやく
移動できます。

物理(ハード)ドライブ

アレイの構成が完成されるにつれ、Configuration Service ウィンドウに複数のコン
ポーネントが表示されます。デフォルトでは、論理ドライブを構成する物理ドライブ
が表示されます。しかし、Configuration Service メイン ウィンドウでナビゲートし
やすくするために、View → Display HDD under LD を選択解除して、物理(ハード)
ドライブを表示しないように選択することができます。 

Configuration Service のナビゲート

Configuration Service では、標準 Java プログラミング言語のキーボードとナビゲー
ション方法を使用します。

タブ 説明

クリックすると Configuration Service メイン ウィンドウに移動し
ます。

クリックすると Resource Allocation View に移動します。（将来
の使用のため予約済み。）

クリックすると LUN Filter View に移動します。（ファイバ チャ
ネルのみ。）
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▼サーバを追加する

サーバを監視または構成するには、Server List Setup を使って、先にそのサーバを 
Managed Servers リストに追加する必要があります。

1. Configuration Service がまだ実行されていない場合は、起動します。

2. File → Server List Setup を選択します。 

Server List Setup ウィンドウが表示されます。

3. サーバをグルーブ分けします。

a. Server List Setup ウィンドウで Groups をクリックします。 

Group List Setup ウィンドウが表示されます。

b. Group Name フィールドに名前を入力し、Add をクリックします。

c. グループを削除するには、Available Groups リストからグループ名を選択し、
Delete をクリックします。
46 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



d. グループの追加と削除が終了したら、OK をクリックします。 

Server List Setup ウィンドウが表示されます。

4. サーバを追加します。

a. Available Servers リストの下にある Add をクリックします。 

Add Server ウィンドウが表示されます。

b. Solaris では、Server name フィールドにサーバの名前を入力して Return キーを
押します。Microsoft Windows NT/2000 オペレーティング システムでは、Server 
name フィールドにサーバの名前を入力して Enter キーを押します。 

これは、サーバを識別するための名前です。使用しているネットワークのネーム 
サーバ データベースにこの名前がある場合、Configuration Service はこのサーバ
の IP アドレスを検出し、IP Address フィールドに表示します。

Configuration Service がこの名前の IP アドレスを検出できなかった場合は、名前
が間違って入力されたか、名前がサーバのネーム データベースに記録されていま
せん。
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c. 必要に応じて、サーバの TCP/IP アドレスを IP Address フィールドに入力しま
す。

例: 192.168.100.1。

Configuration Service により（上のステップで説明するように） IP アドレスが表
示されなかった場合は、IP アドレスを手動で入力します。

Configuration Service が IP アドレスを検索して自動的に表示する別の方法とし
て、IP Address フィールドの下にある Get IP Address by Name を選択すること
もできます。上のステップで説明するように、この方法は、ネットワークにネー
ム サーバ データベースがあり、そのデータベースに記録されているとおりにサー
バ名を入力した場合にのみ有効です。そうでなければ、IP アドレスを手動で入力
する必要があります。

5. サーバのAutomatic Discoveryを選択または選択解除します。

a. サーバ インベントリへのアクセスも制限するような高いセキュリティを必要とす
る環境では、Auto Discovery に No を選択します。

No を選択すると、Configuration Service は起動時にサーバ情報を取り出しませ
ん。サーバのアイコンは（アクティブを示す紫ではなく）白色で表示され、発見
されていないことを示します。発見されていないサーバをダブルクリックする
と、Configuration Service は ssmon ユーザー パスワードの入力を求めます。オプ
ションとして、サーバを選択し、File → Login を選択することもできます。

Auto Discovery に Yes を選択すると、Configuration Service コンソールの起動時
に、このサーバについて使用可能な情報がすべて取り出されます。 

b. Auto Discovery に Yes を選択した場合、ssmon ユーザをセットアップしたときに
サーバ(または、ドメインか DNS ツリーがある場合はサーバ グループ)に入力した
ものと同じ監視用パスワードを入力します。

Auto Discovery を使ってサーバを確立した後は、Configuration Service にログイ
ンするときに ssmon パスワードを入力する必要はありません。監視特権は自動的
に与えられます。

ただし、管理または構成活動を実行するコマンドを選択するとかならずログイン 
ダイアログボックスが表示され、以前に確立された ssadmin または ssconfig 
ユーザのパスワードを入力して、セキュリティ レベルを変更するよう求められま
す。

c. OK をクリックします。

6. 電子メール アドレスを設定します。 

a. Configuration Service からイベント メッセージを電子メールで受け取るようにす
るには、Mailing Lists タブを選択し、以下の手順に従います。 

サーバ上のクリティカルなイベントに関する情報を受け取るため、自身の電子
メール アドレスと、選択したほかのユーザーのアドレスを入力することができま
す。
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注 – Configuration Service コンソール プログラムをフォアグラウンドで常時実行す
る代わりに、Configuration Service の併用ユーティリティである Diagnostic 
Reporter を使用することができます。このユーティリティはバックグラウンド サー
ビスとして実行され、指定された電子メール アドレスにホストおよびアレイからの
メッセージを送信します。詳細は、『Sun StorEdge 3000 Family Diagnostic Reporter 
ユーザ ガイド』を参照してください。アラートを受信する別の方法については、
「250 ページの「Configuration Service を使用せずに SNMP トラップを送信す
る」」を参照してください。

b. 各ユーザについて、Mail Address フィールドに電子メール アドレスを入力しま
す。

c. Severity リストボックスで、重要度レベルのリストをスクロールし、次のように
選択します。

Critical - ネットワーク管理者による介入を必要とするメッセージ。たとえば、デ
バイス、電源、ファンなどの故障。

Warning - 一般に内部プログラム イベントを示す警告メッセージ。このメッセー
ジが頻繁に発生する場合は、サーバまたはネットワークに問題があることを示し
ている可能性があります。 

Informational - サーバ上のデバイスに関するネットワーク管理者による
介入を必要としないメッセージ。
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どのレベルを選択した場合でも、そのレベルと、それより重要度の高いほかの全
レベルのイベント メッセージを受け取ります。たとえば、Informational を選択し
た場合は、すべての障害が通知されます。これに対し、クリティカルな状況につ
いてだけ通知を受けたい場合は、Critical を選択すれば、Informational または 
Warning のイベントは通知されません。

d. Add to List をクリックします。

リストからユーザを削除するには、その電子メール アドレスを選択し、Delete 
from List をクリックします。

e. 使用するメール サーバを指定します。 

Setup Mail Server ボタンの表示は、電子メール サーバが定義済みであるかどうか
によって、Change Mail Server と切り替わることに注意してください。

新規セットアップでは、Setup Mail Server をクリックします。次に示すような 
Mail Server Setup ウィンドウが表示されます。

f. 前のステップで指定した宛先アドレスに電子メール メッセージを配信する簡易
メール転送プロトコル(SMTP)メール サーバの IP アドレスまたは名前を入力しま
す。

g. Mail Server ウィンドウでの情報の入力が完了したら、OK をクリックします。 

Add Server ウィンドウが開き、Mailing Lists タブが表示されます。

7. Add Server 操作を完了します。

a. このサーバをグループの一部として使用する場合は、Grouping タブを選択しま
す。 

Add Server ウィンドウが表示されます。
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b. リストボックスをクリックすると、選択肢が表示されます。 

c. 必要なグループを選択し、マウス ボタンを放します。

d. OK をクリックして変更を保存します。

8. さらにサーバを追加する場合は、各サーバについて、ステップ 3～7 を繰り返しま
す。

9. このコンソールで管理するサーバを Managed Servers リストに移動します(「46 
ページの「サーバを追加する」」を参照)。

■ 使用可能なすべてのサーバをこのコンソールで管理する場合は、ダイアログボッ
クスの上部にある Add All をクリックします。

■ 個々のサーバを managed 列に移動するには、各サーバを選択して 2 つのリスト
ボックスの間にある Add をクリックします。

■ サーバの追加操作中に変更の必要が生じた場合は、「197 ページの「サーバ エン
トリを編集する」」を参照してください。

10. サーバの追加が終了したら、OK をクリックしてメイン ウィンドウへ戻ります。

注 – アレイが複数のホストに接続され、Configuration Service エージェントが各ホ
ストにインストールされている場合は、各ホストの IP アドレスを入力して Managed 
Servers リストに追加する必要があります。
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▼ログインとログアウト

Configuration Service のログインとログアウト機能は、プログラム内でのセキュリ
ティを提供します。セキュリティ レベルは、3 ユーザ、ssmon、 ssadmin、および 
ssconfig にそれぞれパスワードで設定することにより確立されます。

■ ssmon はソフトウェアの監視レベルを表します。コントローラからのアラートを
表示します。  

■ ssadmin はソフトウェアの管理レベルを表します。再構築、パリティ チェック、
パリティ チェックのスケジュールの機能へのアクセスと、監視機能を提供しま
す。 

■ ssconfig は構成レベルを表します。構成コマンドとプログラムの全要素へのア
クセスを提供します。

1. ログインするには、File → Login を選択します。

監視ユーザーとしてのみ連続アクセスを維持してください。管理または構成レベルを
必要とするコマンドを選択すると、ログイン ダイアログボックスが表示され、適切
なパスワードでそのレベルにログインする必要があります。操作を完了したら、ログ
アウトします。

2. ログアウトするには、File → Logout を選択します。 

管理レベルまたは構成レベルからログアウトするとき、監視レベルへログインする
か、サーバから完全にログアウトするかのオプションが与えられます。
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▼コントローラを管理するサーバを選択する

アレイを管理、監視するためには、Configuration Service エージェントは、アレイの
プライマリ コントローラに割り当てられた論理ドライブのパーティションにマップ
されているホスト LUN にアクセスする必要があります。  

Configuration Service エージェントは、アレイの冗長構成内のセカンダリ コント
ローラに割り当てられた論理ドライブのパーティションにマップされているホスト 
LUN はすべて無視します。

注 – 論理ドライブと LUN の説明は、201 ページの「RAID の基本」を参照してくだ
さい。 

1 つのアレイに複数のサーバが接続されている場合、これらのサーバ上で動作してい
る Configuration Service エージェントがそれぞれ、この同じアレイの管理と監視を
試みる可能性があります。アレイ コントローラに監視コマンドを送信できるのは一
度に 1 つのサーバだけという制限により、監視コマンドが複数のサーバから同時に送
られた場合、コマンドの中には実行されないものもあります。この場合は、報告が不
正確であったり、Configuration Service のプロセスが応答を停止することがありま
す。このような状態を避けるため、サーバ上でのアレイの監視を有効／無効にするよ
うに Configuration Service エージェントを構成できます。

コンソールからコントローラを割り当てる

以下の手順は、コントローラを制御するサーバを Configuration Service コンソール
から割り当てる方法です。

1. 直接接続されているすべてのサーバが、46 ページの「サーバを追加する」の指示ど
おりに追加されたことを確認します。 

これにより、両方のホスト名が Controller Assignments に確実に表示されます。

2. Configuration Service メイン ウィンドウで、Array Administration → Controller 
Assignment を選択します。 

Assign Server to Manage a RAID Controller ウィンドウが表示されます。 

3. Server to manage this controller リストからサーバを選択し、Apply をクリックしま
す。

これにより、選択したサーバがアレイ コントローラを管理するようになります。同
時に、リスト内のほかの全サーバがこのアレイを管理できないようになります。
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4. Close をクリックして、この表示を閉じます。

Configuration Service メイン ウィンドウには、このアレイ用に監視が有効になって
いるサーバの下だけに、アレイ コントローラ デバイスのアイコンが表示されます。 
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サーバ割り当ての変更 

コントローラを管理するサーバを割り当てると、管理サーバに関する情報が作成され
ます。Configuration Service は、コントローラ上にこの情報を格納し、管理サーバを
追跡するためにこれを使用します。たとえば保守などのためにサーバをシャットダウ
ンする場合、コントローラを管理するために別のサーバを割り当てようとすると、
Configuration Service はコントローラから格納された情報を読み取り、コントローラ
がすでに管理されているという警告を表示します。

注 – 強制的に新規サーバを割り当てる場合、現在のサーバ割り当てを上書きできま
す。

view and edit Host luns → Edit Host-ID/WWN Name List と呼ばれるファームウェ
ア アプリケーション メニューを使用して、管理サーバ名を表示できます。

たとえばアレイを新しい場所に移動する場合など、サーバ割り当てを変更する際に
は、アレイを移動する前に56 ページの「管理サーバの割り当てを解除する」の手順
に従って管理サーバの割り当てを解除する必要があります。 

アレイをすでに移動した場合には、アレイを起動する際に、コントローラが別のサー
バによって管理されている、という警告メッセージが表示されます。56 ページの
「端末ウィンドウを使用して手動でサーバを削除する」の手順に従って、サーバを手
動で削除する必要があります。ファームウェア アプリケーションにアクセスする方
法は、ご使用のアレイ用の『Sun StorEdge 3000 Family RAID ファームウェア ユーザ 
ガイド』を参照してください。

Configuration Service は、
サーバ名を ASCII 文字セットの
16 進法の値で格納します。
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▼ 管理サーバの割り当てを解除する

1. Configuration Service メイン ウィンドウから Array Administration → Controller 
Assignment をクリックします。

2. サーバ割り当てを解除するアレイ コントローラを選択します。

3. From the Server to manage this controller: リスト ボックスから none を選択しま
す。

選択したコントローラが今後サーバによって管理されないことを確認する以下の警告
メッセージが表示されたら、Close をクリックします。

4.  53 ページの「コンソールからコントローラを割り当てる」の手順に従って、コント
ローラを管理するサーバを選択します。

▼ 端末ウィンドウを使用して手動でサーバを削除する

ファームウェア アプリケーションにアクセスする方法は、ご使用のアレイ用の『Sun 
StorEdge 3000 Family RAID ファームウェア ユーザ ガイド』を参照してください。

1. メイン メニューから view and edit Host luns を選択して Return キーを押します。

2. Edit Host-ID/WWN Name List を選択して、Return キーを押します。

3. Name List から sscsMgr を選択して、Return キーを押します

4. Delete Host-ID/WWN Name List を選択して、Return キーを押します。

5. Yes を選択して Return キーを押します。
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▼エージェントのパラメータを構成する(オプショ
ン)
このセクションでは、ポーリング時間、定期デバイス発見時間、SMART 監視、アウ
トオブバンド ストレージ管理などのエージェント パラメータの構成手順を説明しま
す。構成には View → Agent Options Management コマンドを使用します。 

1. メイン ウィンドウから View → Agent Options Management を選択します。 

Agent Options Management ウィンドウが表示されます。

注 – 1 つまたは複数のグループが構成されていて、その 1 つがメイン ウィンドウで
選択されている場合、Agent Options Management は使用できないことがあります。
有効にするには、グループ以外のアイコンを選択し、View をクリックします。

2. Monitoring Frequency in Seconds で、希望の間隔(秒単位)を入力します。

この値は、Configuration Service エージェントによる監視で、デバイス、アレイ コ
ントローラ、格納装置のステータス変化を調べるための連続ポーリングの間隔です。
デフォルト値は 60 秒です。Configuration Service コンソールで、デバイス ステータ
ス変化をより頻繁に更新したい場合は、この値を小さくします。
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注 – ポーリング間隔を増加すると、I/O 負荷が重い場合に、エラー メッセージの出
力に悪い影響をおよぼす可能性があります。

3. Periodic Device Discovery で、Configuration Service が新しいデバイスがないか
チェックする希望の間隔(分単位)を入力します。

Periodic Device Discovery の値は、Configuration Service が新しいデバイスを検出
するため各デバイス ID をスキャンする頻度を指定します。デフォルト値の 0 は、
Configuration Service が新しいデバイスをスキャンしないことを意味します。この数
値が大きいほど、デバイス ID のスキャン頻度が少なくなることに注意してくださ
い。

逆に、この数値が小さいほど、デバイス ID がより頻繁にスキャンされます。 小値
は 5 分間です。

4. Interval of trap generation で、トラップ メッセージの送信間隔（秒単位）を入力し
ます。 

この値が 60 秒以上である場合、Configuration Service は、イベントがクリアまたは
修正されるまで、指定された時間間隔でその特定のトラップについてメッセージを送
信します。たとえば、ファンが故障した場合、故障が修理されるまでの間、ファン故
障のメッセージが 60 秒おきに送信されます。

この値がゼロであると、Configuration Service(および Diagnostic Reporter)はその特
定のイベントについてメッセージを 1 回だけ送信します。たとえば、ファンが故障し
た場合、電子メールが 1 通だけ送信されます。

5. Timeout of heartbeat lost で、故障サーバのメッセージの送信間隔（分単位）を入力
します。 

デフォルト値は 15 分で、値の範囲は 1～30 分です。 

6. SMART 監視を有効にするには、チェックボックスを選択します。

SMART 監視とは、予想される故障をハード ドライブが報告するためのメソッドで
す。ほとんどのディスク ベンダーは、この機能を搭載したドライブを供給していま
す。Configuration Service エージェントは、非請求の要求センスを発行してこの機能
を監視します。この要求が基礎ホスト動作環境またはシステム デバイス ドライバと
競合する場合は、SMART 監視をオフにすることができます。

7. 上記いずれかのオプションを選択した場合は、OK をクリックして変更を保存しま
す。
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サーバの TCP/IP アドレスを示す Setting Agent Options 通知メッセージ ボックス が
表示されます。

8. OK をクリックして手順を終了します。

コントローラのプライマリ エージェント情報の詳細は、134 ページの「アウトオブバ
ンド ストレージ管理」を参照してください。

▼ JBOD サポートを有効にする(SCSI のみ)
Sun StorEdge 3310 SCSI アレイでは、JBOD （Just a Bunch Of Disks - 単なるディス
クの束）のサポートは、JBOD がワークステーションに直接接続されている場合にだ
け使用します。この機能を使用すると、周辺デバイスの状態とイベントを監視できま
す。JBOD が RAID アレイに接続されている場合、RAID コントローラにより JBOD 
の状態とイベントが監視されます。 

注 – JBOD サポートを有効にすると、I/O に影響がおよぶ可能性があります。

1. 57 ページの「エージェントのパラメータを構成する(オプション)」の手順に従いま
す。

2. JBOD サポートを選択します。

JBOD の監視の詳細は、219 ページの「JBOD の監視(SCSI のみ)」を参照してくださ
い。
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▼ストレージの構成を確認する

Configuration Service をインストールし、Configuration Service で管理するスト
レージのサーバをすべて追加した後、ストレージの構成を確認する必要があります。 

注 – ほとんどのアレイは、出荷前に構成されています。既存の構成をすべて削除
し、構成し直す場合は、69 ページの「フル構成」を参照してください。現在の構成
に対して変更や追加を行う場合は、157 ページの「構成の更新」を参照してくださ
い。

1. サーバ アイコンがオンライン（つまり、サーバ記号が紫色）であることを確認しま
す。  

電源投入時に、Configuration Service が自動的に起動します。

2. Configuration Service メイン ウィンドウに表示されるストレージ構成をチェックし
ます。

3. 複数のサーバを管理している場合は、チェックしたいサーバを選択します。 

サーバ アイコンが紫でない場合、サーバの状態を確認します(表 9-1 参照)。サーバ ア
イコンに衛星ディッシュが付いている場合 、サーバは発見プロセス にある可能
性があり、しばらくしてから使用できます。  

4. ストレージをチェックしたいサーバの左に表示されるコンテナ記号 をクリックし
ます。

Configuration Service は、下図に示すように、サーバに接続されている各アレイ コ
ントローラをグラフィックで表示します。 
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5. 詳細情報を見るには、ストレージをチェックするホスト アダプタまたはアレイ コン
トローラの横にあるコンテナ記号 をクリックします。

アレイがまだ構成されていない場合、論理ドライブ(コントローラの LUN)は表示さ
れません。

アレイが完全に構成されている場合、Configuration Service は、選択されたアレイ 
コントローラに関連付けられたデバイスと論理ドライブを表示します。下図は、デバ
イスが表示された画面例です。  

論理ドライブの左にあるコンテナ記号 をクリックすると、それに割り当てられた
物理ドライブが表示されます。

注 – View → Display HDD under LD を選択または選択解除することで、論理ドライ
ブを構成する物理(ハード)ドライブを表示するように選択できます。

インストールされているアレイ製品によって、実際の構成は上図に示す構成とは大き
く異なる場合があります。

アレイが構成されていない場合は、「69 ページの「フル構成」」の構成手順を参照
してください。

6. RAID レベルと論理ドライブの構造をチェックします。

7. アレイが構成済みで、その構成が希望どおりのものであれば、次のセクションへ進ん
でください。 

構成を変更する場合は、69 ページの「フル構成」を参照してください。 
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▼論理ドライブの構成を保存する

論理ドライブの構成情報がアレイ コントローラと、それに接続された物理ドライブ
に保存されていても、火災などの災害が発生した場合にコントローラとドライブの両
方が破壊されることがあります。現在の論理ドライブ(LUN)の構成のバックアップ 
コピーを、ディスケットなどのアレイ以外のほかの外部メディアに複数作成してくだ
さい。少なくとも 1 つのバックアップ コピーをサイト外の金庫または安全な場所に
保管しておきます。構成のバックアップ コピーを使用すれば、アレイを完全に再構
成する必要なく、新しいコントローラに構成を復元できます。現在の構成のバック
アップ コピーがないと、データが失われることがあります。

以下の場合には、アレイ コントローラの構成を必ずファイルに保存してください。

■ 新しいストレージ システム格納装置をインストールする、または既存の格納装置
内のコントローラの SCSI ID を変更する場合

■ アレイ コントローラを交換する場合

■ アレイ コントローラを再構成する、または論理ドライブをアレイ コントローラに
追加する場合

■ 故障ドライブからスタンバイ ドライブにデータを再構築する場合

構成をファイルから復元する方法は、151 ページの「論理ドライブの構成を復元す
る」を参照してください。

1. 保存したい構成を持つコントローラを選択します。

2. Configuration → Save Configuration を選択します。 

Save Configuration window ウィンドウが表示されます。
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3. 必要なドライブとフォルダにナビゲートし、更新する構成ファイル(.cfg 拡張子で示
される)を見つけます。

構成ファイルをディスケットまたはアレイ外部のドライブに保存します。つまり、こ
れらの構成ファイルのコピーをサイト外に保管してください。

4. 構成ファイルの名前を指定し、Save をクリックします。 

Save Configuration ウィンドウが表示されます。

5. 保存している構成の説明を入力し、OK をクリックします。

Configuration Service は、コントローラの構成情報を .cfg ファイルに保存します。

▼サーバにパーティションを作成する

ストレージが希望どおりの構成となった後、各動作環境でのストレージ アレイを
パーティションすることができます。 

Solaris 動作環境

以下の手順は一般的なガイドラインです。詳細手順は、Sun Solaris OE のマニュアル
でパーティションとファイル システムの説明を参照してください。
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1. 新しい LUN をラベル付けするため、次のように入力します。

format コマンドは、システム ディスクと、アレイに接続されているほかのドライブ
を表示します。

新しい LUN は、アレイで使用するためのセットアップ用に、先に format コマンド
を使ってラベル付けする必要があります。format コマンドを実行すると、使用可能
な LUN とハード ディスクが表示されます。  

2. 使用するデバイスを選択します。 

プロンプトに応じて、デバイスにラベルを付けます。

3. partition と入力し、既存のパーティション テーブルを表示します。

4. 必要に応じてパーティション テーブルを編集し、変更を行った場合はラベルを付け
ます。

5. newfs コマンドを使って、パーティション上にファイル システムを作成します。

6. mount コマンドを使用するか、または /etc/vfstab を編集して mountall コマン
ドを使用することにより、ファイル システムをマウントします。

# フォーマット
64 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



Microsoft Windows NT パーティション 

このセクションの手順を始める前に、Microsoft Windows NT が新しいストレージ容
量を認識するようにコンピュータをリブートする必要があります。以下の手順は一般
的なガイドラインです。詳細手順は、Microsoft Windows NT の説明書を参照してく
ださい。

注 – このステップはリモートでは実行できません。サーバから実行する必要があり
ます。

1. Start → Programs → Administrative Tools → Disk Administrator を選択します。

2. 各 Disk Administrator メッセージボックスで、 Yes を選択します。

3. カーソルを水平バーに移動して論理ドライブを選択し、マウスを左クリックします。

4. Disk Administrator Partition → Create を選択します。

プロンプト ウィンドウが開き、論理ドライブ全体のデフォルト容量を持つパーティ
ションを作成するかどうか尋ねられます。

5. 論理ドライブ上に複数のパーティションを作成する場合は、希望のパーティション 
サイズを入力します。

全部の論理ドライブ容量が使用されるまで、このステップを繰り返します。

6. Disk Administrator Partition → Commit Changes Now を選択します。

この機能を使用すると、Windows NT オペレーティング システムをリブートせず
に、論理ドライブをフォーマットして使用できます。

7. 新規作成したドライブ パーティションを選択します。

8. Disk Administrator Tools → Format を選択します。NTFS(NT ファイル システム)形
式を選択します。

ステップ 7 と 8 を繰り返して、論理ドライブ上に作成した各パーティションをフォー
マットします。

9. フォーマットが完了したら、Disk Administrator を終了します。
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Microsoft Windows 2000 パーティション

以下の手順は一般的なガイドラインです。詳細手順は、Microsoft Windows 2000 の
説明書を参照してください。

1. Settings → Control Panel → Administrative Tools → Computer Management → 
Disk Management を選択します。

Disk Management の下にディスク アイコン  が付いた新しいドライブが表示され
ていることを確認します。

2. 署名するディスクを右クリックして、Write Signature を選択します。

3. パーティションを作成するディスクを選択して、OK をクリックします。

4. (ドライブの容量が表示されている)ドライブ上を右クリックして、Create Partition を
選択します。

5. パーティション ウィザード プロンプトに対して適切に応答します。 

署名するディスクを

右クリックします。

パーティションを作成するドライブ
右クリックします。
66 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



次に行うタスク

これで、Configuration Service （コンソールとエージェント）のインストールとセッ
トアップが完了し、使用できるようになりました。次に行うタスクについては、以下
の各章を参照してください。

■ 103 ページの「アレイの監視」は、Configuration Service によるストレージ デバ
イスの監視方法を説明しています。

■ 143 ページの「アレイの保守」 は、アレイの保守方法を説明しています。パリ
ティ チェック、パリティ チェックのスケジュール、故障ドライブの再構築、バッ
クアップ ファイルからの構成の復元についての詳細が含まれています。

■ 157 ページの「構成の更新」は、ストレージ アレイの構成の更新方法を説明して
います。コントローラ機能の変更、スタンバイ ドライブの作成と変更、使用可能
なサーバの情報の編集方法も含まれています。
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第 7 章

フル構成

アレイの論理ドライブは、Sun にて事前構成されて発送されます。この章は、アレイ
がまだ構成されていない場合、または、既存の構成を完全に削除して構成し直す場合
にのみお読みください。既存の構成を一部変更する場合は、「157 ページの「構成の
更新」」を参照してください。

フル構成に関するトピックは、次のとおりです。

■ 70 ページの「論理ドライブと論理ボリュームの構成」

■ 70 ページの「Standard Configuration を使って論理ドライブを構成する」

■ 73 ページの「Custom Configuration を使って論理ドライブと論理ボリュームを構
成する」

■ 85 ページの「論理ボリュームを作成しパーティションに分割する」

■ 87 ページの「構成をクリアする」

■ 87 ページの「構成レベルからログアウトする」

■ 88 ページの「ホスト LUN の割り当て」

■ 88 ページの「ホスト LUN を追加（マップ）する」

■ 90 ページの「ホスト LUN を削除（マップ解除）する」

■ 90 ページの「構成ファイル」

■ 91 ページの「構成をバックアップ ファイルに保存する」

クラスタ構成をセットアップする場合は、227 ページの「クラスタ構成の使用」を参
照してください。

Configuration メニューのコマンドとツールバーのアイコンは、パリティ チェックな
どのアレイ管理プロセスが実行中の場合に一時的に無効になる場合があります。メ
ニュー コマンドは、Configuration Service コンソールがサーバ上でインベントリを
リフレッシュしている間も使用不可になります。リフレッシュ プロセスの間はサー
バ アイコンに衛星ディッシュ記号が付いて表示されます。
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注意 – アレイの構成を始める前に、既存のすべてのデータを外部デバイスにバック
アップしてください。再構成により、既存の論理ドライブ構成がすべて上書きされま
す。既存の論理ドライブ構成を上書きすると、事実上すべてのデータが消去されま
す。

論理ドライブと論理ボリュームの構成
RAID レベルを 1 つまたは複数使用するかにより、Standard Configuration または 
Custom Configuration を使用して論理ドライブを構成できます。論理ボリュームの
構成は、Custom Configuration しか使用できません。 

注 – Sun StorEdge 3310 SCSI アレイでは、1 論理ドライブあたり 大 32 パーティ
ションを含む論理ドライブを 大 8 つ作成できます。LUN は 大 128 まで割り当て
可能です。１つの論理ボリュームは、 大 32 個 のパーティションに分割できます。
Sun StorEdge 3510 FC アレイでは、1 論理ドライブあたり 大 128 パーティションを
含む論理ドライブを 大 8 つ作成できます。LUN の割り当ては 大 1024 です(各ホ
スト ID への LUN の割り当ては 大 32 です)。１つの論理ボリュームは、128 個まで
のパーティションに分割できます。 

▼ Standard Configuration を使って論理ドライブを
構成する

Standard Configuration Options では、アレイ コントローラに接続されたすべてのス
トレージを 1 つの RAID レベルで簡単に接続できます。必要な操作は、RAID コント
ローラと RAID レベルを指定することだけです。スタンバイ ドライブが必要かどう
かも指定します。Configuration Service によりストレージが自動的に構成され、指定
した RAID レベルと使用可能なドライブの台数に応じて 1 つまたは複数の論理ドラ
イブが作成されます。ライトバック キャッシュはデフォルトで自動的に選択されま
す。構成結果が表示され、 終化の前に構成を承認または拒否することができます。

注意 – Standard Configuration を使用する前に、既存のすべてのデータを外部デバ
イスにバックアップしてください。Standard Configuration により、既存の論理ドラ
イブ構成がすべて上書きされます。既存の論理ドライブ構成を上書きすると、事実上
すべてのデータが消去されます。
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1. ssconfig ユーザとしてログインします。

2. Configuration Service メイン ウィンドウで、必要な RAID コントローラを選択しま
す。

3. Configuration → Standard Configure を選択します。 

Standard Configuration Warning メッセージが表示されます。OK をクリックして、
続行します。

Standard Configuration Options ウィンドウが表示されます。ここで ssconfig とし
てログインしていない場合は、ログイン ダイアログが表示されます。 

ウィンドウに表示されるオプションの中には、使用可能なドライブの台数と 
Microsoft Windows NT オペレーティング システムまたは Solaris 動作環境のどのシ
ステムを使用しているかによって、無効になっているものがあります。

NT Cluster オプションでは、定足の RAID 5 論理ドライブ（100 メガバイト）が作成
された後、残り容量が 2 つの大容量の RAID 5 論理ドライブに割り当てられます。こ
のオプションの場合、3 台以上の物理ドライブが必要です。

4. ウィンドウ上部に表示されるサーバとコントローラ ID が正しいかどうか確認しま
す。

ウィンドウ上部に表示されたサーバとコントローラが正しくない場合は、Cancel を
クリックして、構成ウィンドウを終了し、Configuration Service メイン ウィンドウ
に戻ります。必要なデバイスを選択し、このウィンドウを再度選択します。
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5. ドライブの 1 つをスタンバイ ドライブとして使用するかどうか指定します。

Use a standby drive を選択すると、Configuration Service が、スタンバイ ドライブ
を使用しない RAID レベルを非アクティブにします。（たとえば、RAID 0 はフォー
ルト トレランスがないため、スタンバイ ドライブを使用しても効果がありませ
ん。）

6. 使用可能になった RAID レベルから、構成している論理ドライブに適切な RAID レベ
ルを選択します。

RAID レベル定義は、201 ページの「RAID の基本」を参照してください。

RAID 3 または 5 を選択すると、Standard Configuration は通常、大容量の論理ドラ
イブを 1 つ作成します。ただし、アレイに 31 を超える物理ドライブが含まれる場
合、論理ドライブは複数作成されます。また、RAID 3 または 5 を使用するには、少
なくとも 3 ドライブ必要です。

RAID 1 を選択する場合、それぞれの論理ドライブには 低 2 つ、 大で 44 の物理
ドライブが必要です(ドライブを 4 以上選択する場合、RAID 0+1 レベルの論理ドライ
ブが 1 つ作成されます）。

44 以上のドライブが含まれるアレイで RAID 0 を選択すると、論理ドライブは複数
作成されます。

7. (Solaris OE のみ)リブートせずに新しい論理ドライブを動作環境に自動的に追加する
には、Write a new label to the new LD をクリックします。

8. RAID レベルを選択したら、OK をクリックします。

Confirm Configuration Operation ウィンドウが開き、新しい構成が表示されます。 

9. 表示された構成を受け入れる場合は、OK をクリックします。受け入れない場合は、
Cancel をクリックして Configuration Service コンソールに戻ります。
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▼ Custom Configuration を使って論理ドライブと論
理ボリュームを構成する

Custom Configuration では、さまざまな RAID レベルおよびその他の RAID パラ
メータに応じて論理ドライブを構成または再構成するための複数のオプションが提供
されます。また、新しく作成した論理ドライブを論理ボリュームに追加するオプショ
ンも提供されます。

1. ssconfig ユーザとしてログインします。 

2. Configuration Service メイン ウィンドウで、必要な RAID コントローラを選択しま
す。

3. Configuration → Custom Configure を選択します。 

Custom Configuration Options ウィンドウが表示されます。
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■ New Configuration - さまざまな RAID レベルおよび RAID のほかのパラメータを
使用し、新しい論理ドライブを構成し、論理ボリュームに追加できます。New 
Configuration コマンドは、アレイ コントローラ上の以前の構成を消去します。

■ Add LDs/LVs to the Current Configuration - 既存の構成に新しい論理ドライブま
たは論理ボリュームを追加できます。このコマンドは、コントローラ上のほかの
構成済み論理ドライブを消去しません。

■ Dynamically Grow and/or Reconfigure LDs/LVs - 論理ドライブおよび論理ボ
リュームの容量を拡張したり、既存の論理ドライブおよび論理ボリュームに SCSI 
ドライブを追加したり、すべてのメンバ ドライブをより大きい容量のドライブに
コピーして交換したりできます。

■ Make or Change Standby Drives - アレイ コントローラに関連付ける新しいスタン
バイ ドライブを 1 つまたは複数追加できます。

■ Change Host LUN Assignments - 既存の論理ドライブ、論理ボリューム、および
パーティションをホスト チャネルに割り当てることができます。

■ Change Controller Parameters - コントローラ パラメータを変更できます。

■ Manage Existing LDs/LVs and Partitions - 個々の論理ドライブまたは論理ボ
リュームを削除したり、既存の論理ドライブおよび論理ボリュームからパーティ
ションを作成または削除したりできます。

■ Configure Web Server - Web ブラウザを通してアレイを管理または監視できるよ
うに Web サーバを構成できます。

この章では、New Configuration オプションについてのみ詳しく説明します。
Configure Web Server については、138 ページの「Web によるストレージの管理」で
説明しています。その他のオプションについては、 157 ページの「構成の更新」で説
明しています。 

New Configuration オプション

New Configuration オプションを使い、論理ドライブの構成を使用環境のニーズに合
わせてカスタマイズできます。さまざまな RAID レベルで、1 つまたは複数の論理ド
ライブのパーティションを作成できます。その後、(パーティションが作成されてい
ない) 1 つの論理ボリュームに 2 つ以上の論理ドライブを追加して、SCSI では 大 32 
まで、ファイバ チャネルでは 大 128 までパーティションを作成できます。

注 – Solaris 動作環境のシステムでは、Configuration Service コンソールが使用中に
ロックした場合、そのプロセス番号を取得して、41 ページの「コンソールが使用中
にロックした場合」で説明するように、ウィンドウを閉じて、再度開くことができま
す。
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New Configuration を使用する前に

初めて New Configuration を使用して論理ドライブまたは論理ボリュームを作成す
る前に、次のステップをよく理解しておいてください。この情報をあらかじめ知って
いると、論理ドライブまたは論理ボリュームを容易に作成できます。 

1. 論理ドライブ内に含める物理ディスクの合計台数を決定します。

データのセキュリティが重要である場合は、残りのディスクをスタンバイ ドライブ
にします。

注 – 論理ドライブのサイズが 253 ギガバイトを超える場合は、「78 ページの「253 
ギガバイトより大きい論理ドライブを準備する」」を参照してください。

2. スタンバイ(スペア)ドライブをローカルにするか、グローバルにするかを決定しま
す。

スタンバイ ドライブとは、論理ドライブに関連付けられた物理ドライブが故障した
場合に自動データ 再構築をサポートするスペアとして指定されているドライブで
す。別のドライブと交換するスタンバイ ドライブは、少なくとも故障したドライブ
と同じサイズでなくてはなりません。また、故障したドライブは RAID 1、3、または 
5 である必要があります。

ローカル スペア ドライブは、１つの指定論理ドライブに割り当てられるスタンバイ 
ドライブです。この指定論理ドライブのメンバー ドライブが故障すると、ローカル 
スペア ドライブは自動的にメンバー ドライブとなりデータの再構築を始めます。

グローバル スペア ドライブは、指定した 1 つの論理ドライブだけのスタンバイとし
て働くのではありません。任意の論理ドライブのメンバ ドライブが故障すると、グ
ローバル スペア ドライブはその論理ドライブのメンバとなり、自動的にデータの再
構築を始めます。

3. RAID レベルを選択します。Configuration Service は、その RAID レベルで作成でき
る最大サイズの論理ドライブを自動的に計算します。

4. 論理ドライブのパーティションを分割するかどうか決定します。

パーティションとは、論理ドライブ(または論理ボリューム)を論理的に分割したもの
です。パーティションにより、ファイル管理、複数のユーザ、その他の目的に、それ
ぞれ別個の論理ドライブ(または論理ボリューム)が存在しているかのような外観を与
えます。

注 – パーティションは、初期構成時、または論理ドライブの作成後に分割できま
す。
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注 – 論理ドライブにパーティションを作成してしまうと、論理ボリュームに追加す
ることはできません。
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5. New Configuration ウィンドウに表示されるディスク容量について理解します。

■ Max Drive Size (MB) - 選択された物理ディスク(各ディスクの合計容量)あたりの
大サイズが表示されます。 

この値を小さくすれば、より小さい論理ドライブを作成できます。残り容量は、
後にドライブを拡張した場合に使用できます（170 ページの「論理ドライブまたは
論理ボリュームの容量を拡張する」の説明を参照）。

■ Part Size (MB) - 論理ドライブまたは論理ボリュームの合計サイズである全ディス
クの合計容量が表示されます。

注 – 論理ドライブの 大使用可能容量は、 小の物理ディスク サイズに等しくなり
ます。たとえば、18 ギガバイトのディスクを追加した後に 70 ギガバイトのディスク
を論理ドライブの一部として追加した場合、 大使用可能容量はドライブあたり 18 
ギガバイトです。

6. 論理ドライブを論理ボリュームの一部にするかどうか決定します。 

注 – 論理ドライブのパーティションを作成したあとは、論理ボリュームに追加でき
ません。

7. 論理ボリュームのパーティションを分割するかどうか決定します。

注 – パーティションは、初期構成時に、または論理ボリュームの作成後に分割でき
ます。

8. バックグラウンド レートを決定します。バックグラウンド レートとは、アレイ管理
活動（故障ドライブの再構築、パリティ チェック、初期化など）に割り当てられ
た、使用可能なアレイ コントローラ CPU 時間のパーセンテージです。 

バックグラウンド レートが 100% に設定されている場合、アレイ管理活動がほかの
システム活動よりも優先されます。0% の場合は、アレイ コントローラにほかの活動
がないときにのみアレイ管理活動が実行されます。
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▼ 253 ギガバイトより大きい論理ドライブを準備する

Solaris 動作環境では、newfs を含むさまざまな操作のために、ディスク ジオメトリ
が必要です。253 ギガバイトより大きい Solaris 動作環境の論理ドライブに適切なド
ライブ ジオメトリは、ファームウェア アプリケーションを使用して Host 
Cylinder/Head/Sector Mapping Configuration（ホスト シリンダ / ヘッド / セクタ
のマッピング構成）を構成する必要があります。ファームウェア アプリケーション
にアクセスする方法は、ご使用のアレイ用の『Sun StorEdge 3000 Family RAID 
ファームウェア ユーザ ガイド』を参照してください。

1. ファームウェア アプリケーションの Main メニューで、view and edit Configuration 
parameters を選択します。

2. ホスト側の SCSI パラメータを選択します。

3. Host Cylinder/Head/Sector Mapping Configuration (ホスト シリンダ / ヘッド / セクタ
のマッピング構成）を選択します。

4. Sector Ranges を選択して、255 と指定します。

5. Sector Ranges を選択して、64 と指定します。

6. Cylinder Ranges を選択して、<65536 と指定します。
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▼ New Configuration を使用して論理ドライブを作成しパー
ティションを分割する

初めて New Configuration を使用して論理ドライブを作成し、パーティションを分
割する前に、75 ページの「New Configuration を使用する前に」の手順を見直して
ください。

以下のステップは、新しい論理ドライブに新しい構成を適用する例です。3 つの論理
ドライブを選択し、RAID 5 論理ドライブとして構成します。小さい論理ドライブが
作成され、パーティションに分けられます。

注意 – New Configuration コマンドを使用する前に、既存のすべてのデータを外部
デバイスにバックアップしてください。Configuration Service は、アレイ コント
ローラに定義された論理ドライブを自動的に初期化します。

1. ssconfig ユーザとしてログインします。 

2. Configuration Service メイン ウィンドウで、必要な RAID コントローラを選択しま
す。

3. Configuration → Custom Configure を選択します。 

4. New Configuration をクリックします。 
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New Configuration Warning メッセージボックスが表示されます。

5. OK をクリックします。 

6. ウィンドウ上部に表示されるサーバとコントローラが正しいかどうか確認します。

表示されたサーバとコントローラが正しくない場合は、Cancel をクリックして、
New Configuration ウィンドウを終了し、Configuration Service メイン ウィンドウ
に戻ります。適切なディスク コントローラを選択し、New Configuration を再度選
択します。

7. 必要であれば、コントローラの Background Rate を選択します。 

8. Select disks for Logical Drive リストボックスで、最初のディスクを選択し、Add 
Disk をクリックします。 

さらに 2 つディスクを選択し、3 つのディスクが下のリストボックスに表示されるよ
うにします。 

選択を間違えた場合や変更したい場合は、ドライブのリストからそのドライブを選択
し、Remove Disk をクリックします。

注 – 論理ドライブはまだパーティションが分割されていないため、Part Size (MB) と 
Available Size (MB) は同じです。単一の論理ドライブが、単一のパーティションと見
なされています。
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9. RAID レベルを選択します。この例では、RAID レベル 5 を選択します。

これは、この論理ドライブ内の全部のディスクに適用されます。 

この例では、新しい論理ドライブは 3 つの物理ディスクから構成され、合計サイズは 
Available Size (MB)　フィールドに示されるように 103428 メガバイトです。

各 RAID レベルの論理ドライブあたりのドライブの 大台数は次のとおりです。

■ RAID 0 - 44   
■ RAID 1 - 2   
■ RAID 0 - 44   
■ RAID 3 または 5 - 31

4 つ以上のドライブを選択する場合、RAID 0+1 レベルの論理ドライブが作成される
ことに注意してください。

10. Max Drive Size を設定します。

Max Drive Size には、各ディスクの合計容量が表示されます。この値を小さくすれ
ば、より小さい論理ドライブを作成できます。

Max Drive Size -  
各ディスクの合計容量
を表示します。

Available Size - 
全ディスクの合計容量
( 論理ドライブの合計
サイズ ) を表示します。
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注 – Max Drive Size は変更せずに Partition Size を変更した場合、Configuration 
Service は指定されたパーティション サイズで新しいパーティションを作成します。
論理ドライブ サイズの残り容量は 後のパーティションに移動されます。残り容量
は、後にドライブを拡張した場合に使用できます（170 ページの「論理ドライブまた
は論理ボリュームの容量を拡張する」の説明を参照）。パーティションが作成された
後はドライブ容量を編集することはできません。

11. Channel リストボックスと SCSI ID リストボックスから、新しい論理ドライブを
マップする先のホスト チャネルと SCSI ID を選択します。

注 – この時点で論理ドライブをマップしたくない場合は、Channel リストボックス
から Do Not Map を選択します。

注 – Sun StorEdge 3310 SCSI アレイでは、1 論理ドライブあたり 大 32 パーティ
ションを含む論理ドライブを 大 8 つ作成できます。LUN は 大 128 まで割り当て
可能です。１つの論理ボリュームは、 大 32 個 のパーティションに分割できます。
Sun StorEdge 3510 FC アレイでは、1 論理ドライブあたり 大 128 パーティションを
含む論理ドライブを 大 8 つ作成できます。LUN は 大 1024 まで割り当て可能です
(各ホスト ID へは 大 32 まで LUN を割り当て可能)です。１つの論理ボリューム
は、 大 128 個 のパーティションに分割できます。

12. 次に何をするかによってこのステップは異なります。

■ 別の論理ドライブを作成するには、New LD をクリックしてステップ 1 ~ 11 を繰
り返してください。

■ この論理ドライブを論理ボリュームに追加するには、Add to LV をクリックし
て、「85 ページの「論理ボリュームを作成しパーティションに分割する」」を参
照してください。

■ 論理ドライブにパーティションを作成するには、次のステップを行います。この
例では、小さい論理ドライブが作成され、パーティションに分割されます。 

13. 小さい論理ドライブを作成するには、Max Drive Size フィールドに 2000 を入力しま
す。 

注 – 論理ドライブのサイズには、6000 メガバイトではなく、4000 メガバイトが表示
されます。これは、このドライブが RAID 5 レベルであるため、1 ドライブ分の容量
(2000 メガバイト)がパリティ用に割り当てられるからです。
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14. パーティションを作成するため、Part Size フィールドに 1000 を入力し、Add 
Partition をクリックします。

注 – 論理ドライブを論理ボリュームに追加する予定がある場合、論理ドライブを
パーティションに分けないでください。論理ドライブのパーティションを分割する
と、論理ボリュームに追加できません。

同じサイズのパーティションを複数作成するには、作成するパーティションの数だけ 
Add Partition をクリックします。Part Size フィールドにパーティションのサイズを
入力し、たとえば 100*128 というように、作成するパーティションの数を掛ける(*)こ
ともできます。メガバイトが残る場合、 後のパーティションに追加されます。

パーティションを追加するたび、Available Size (MB) に表示される残りの容量は、追
加したパーティションのサイズ分減少します。

次の例に示すように、元の 4000 メガバイトのうち 1000 メガバイトが Partition 0 に
割り当てられた場合、残りの 3000 メガバイトは自動的に Partition 1 に移動されま
す。残りの使用可能容量は、Available Size (MB) に表示されます。
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15. （Solaris OE のみ）リブートせずに新しい論理ドライブを動作環境に自動的に追加
するには、Write a new label to the new LD をクリックします。

16. Commit をクリックして論理ドライブの構成を終了するかまたは、New LD をクリッ
クして別の論理ドライブを構成します。 

New LD をクリックすると、未使用のディスクがすべて表示されます。

このアレイの論理ドライブの構成が完了したら、Commit をクリックして、OK をク
リックします。完成した構成が表示されます。 

注 – OK をクリックしたあとで論理ドライブの構成を変更することはできません。  

注 – 初期化中には、LD と LV のサイズは 0 メガバイトと表示されます。
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▼論理ボリュームを作成しパーティションに分割する 
1 つの論理ボリュームは 2 つ以上の論理ドライブから構成され、SCSI では 32 まで、
ファイバ チャネルでは 128 まで、パーティションに分割できます。動作時にホスト
は、分割されていない論理ボリューム、つまり論理ボリュームの 1 つのパーティショ
ンを単一の物理ドライブとして認識します。 

1. 79 ページの「New Configuration を使用して論理ドライブを作成しパーティションを
分割する」のステップ 1 ～ 11 の説明のとおり、論理ドライブを作成します。

注 – 論理ボリュームに追加する論理ドライブのパーティションは分けないでくださ
い。パーティションが分けられた論理ドライブは、論理ボリュームに追加できませ
ん。

2. Commit をクリックする前に、論理ドライブを論理ボリュームに追加するには、Add 
to LV をクリックします。

論理ドライブが、LV Definition ボックスに追加されます。論理ボリュームの合計サ
イズが、Available Size (MB) フィールドに表示されます。 
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注 – 論理ボリュームはまだパーティションが分割されていないため、Part Size (MB) 
と Available Size (MB) は同じです。単一の論理ボリュームが、単一のパーティショ
ンと見なされます。

3. 論理ボリュームに追加する別の論理ドライブを作成するには、New LD をクリックし
ます。

4. 論理ドライブを作成し、Add to LV をクリックしてその論理ドライブを論理ボリュー
ムに追加します。

論理ボリュームに追加するすべての論理ドライブについて、このステップを繰り返し
ます。

5. パーティションを作成するため、Part Size フィールドにパーティションのサイズを
入力し、Add Partition をクリックします。

同じサイズのパーティションを複数作成するには、作成するパーティションの数だけ 
Add Partition をクリックします。Part Size フィールドにパーティションのサイズを
入力し、たとえば 100*128 というように、作成するパーティションの数を掛ける(*)こ
ともできます。

パーティションを追加するたび、Available Size (MB) に表示される残りの容量は、追
加したパーティションのサイズ分減少します。

論理ドライブは

論理ボリュームに追加
されるので、LV Definition 
に表示されます。

Available Size - 
全ディスクの合計容量
( 論理ドライブの合計
サイズ ) を表示します。
86 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



6. 別の論理ボリュームを作成するため、または単独の論理ドライブを作成するために、
論理ドライブを論理ボリュームに追加したら、Commit LV をクリックします。

論理ボリュームの作成が終了し、単独の論理ドライブを作成しない場合、Commit を
クリックします。

注 – 論理ボリュームを作成し終わり、New Configuration ウィンドウを終了すると
きに、Commit の代わりに誤って Commit LV をクリックすると、さらに別の論理ド
ライブを作成しなければならなくなります。作成しない場合は、Cancel をクリック
して論理ドライブを再度構成しなければなりません。

既存の構成に論理ボリュームを追加または削除する方法、または既存の構成で論理ボ
リュームのパーティションを分割する方法は、「157 ページの「構成の更新」」を参
照してください。

▼構成をクリアする

New Configuration ウィンドウでの構成プロセス中に構成が気に入らない場合は、そ
れをクリアすることができます。

1. Clear をクリックすると、すべての物理ドライブと論理ドライブが表示から消えま
す。 

2. New LD をクリックして新しい論理ドライブを定義するか、Commit をクリックしま
す。

3. Commit をクリックすると、警告プロンプトが表示されます。OK をクリックしま
す。 

Configuration Service は、選択されたアレイ コントローラの全構成を初期化しま
す。

注 – ホスト LUN は、論理ドライブの初期化が完了した後で自動的にマップされま
す。

▼構成レベルからログアウトする

構成操作が終了したら、ログアウトしてプログラムの監視レベルへ戻ります。 

1. File → Logout を選択します。

2. Logout to monitoring mode を選択し、OK をクリックします。
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ホスト LUN の割り当て
サーバが論理ドライブまたは論理ボリュームを認識するには、まずホスト チャネル
／ID にマップされなければなりません。論理ドライブまたは論理ボリュームがホス
ト チャネル／ID にマップされると、LUN になります。次のセクションでは、論理
ドライブまたは論理ボリュームをホスト チャネルにマップする方法および削除する
方法を説明します。

注 – 論理ドライブまたは論理ボリュームを 初に作成する場合、Do Not Map が選
択されていない限り、論理ドライブまたは論理ボリュームの初期化が完了したあとで
ホスト LUN は自動的にマップされます。

注 – Sun StorEdge 3310 SCSI アレイでは、1 論理ドライブあたり 大 32 パーティ
ションを含む論理ドライブを 大 8 つ作成できます。LUN は 大 128 まで割り当て
可能です。1 つの論理ボリュームは、 大 32 個 のパーティションに分割できます。
Sun StorEdge 3510 FC アレイでは、1 論理ドライブあたり 大 128 パーティションを
含む論理ドライブを 大 8 つ作成できます。LUN は 大 1024 まで割り当て可能です
(各ホスト ID へは 大 32 まで LUN を割り当て可能)です。1 つの論理ボリューム
は、 大 128 個 のパーティションに分割できます。

▼ホスト LUN を追加（マップ）する

1. Configuration → Custom Configure を選択します。

2. Custom Configuration Options メニューから、Change Host LUN Assignments を選
択します。 
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Change Host LUN Assignments ウィンドウが表示されます。

3. Select Host Channel and SCSI ID リストボックスを使い、LUN を割り当てるチャネ
ルと ID を選択します。

使用可能な LUN がすべて Partitions の下に表示されます。参考のために、指定した
チャネルに使用される LUN のリストは Used LUNs に表示され、パーティションが
割り当てられたチャンネル、ID、および LUN のリストは Partition Assignment に表
示されます。 

注 – 論理ドライブまたは論理ボリュームが追加または作成されると、プライマリ コ
ントローラまたはセカンダリ コントローラとして割り当てられます(コントローラの
割り当て)。その後、論理ドライブまたは論理ボリュームは初期化され、プライマリ
またはセカンダリ チャネル ID にマップされます。論理ドライブまたは論理ボリュー
ムをマップ解除し、異なるコントローラが割り当てられている別のホスト チャネル 
ID に再度マップする場合、コントローラはリセットする必要があります。論理ドラ
イブまたは論理ボリュームをマップ解除し、同じコントローラが割り当てられている
別のホスト チャネル ID に再度マップする場合、コントローラをリセットする必要は
ありません。論理ドライブまたは論理ボリュームにマップされているパーティション
が残っている場合、マップ解除されているパーティションのみを、同じコントローラ
が割り当てられているホスト チャネル ID にマップできます。
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4. 必要なパーティションを LDs/LVs フィールドから選択し、Assign Host LUN をク
リックして変更を適用します。 

複数のパーティション( 大 32まで)をマップするには、 後のパーティションまでス
クロールし、Shift キーを押しながら間にある項目をすべて選択します。Assign Host 
LUN をクリックします。

Delete Host LUN がアクティブになります。

5. 終了したら、OK をクリックして変更を保存し、メイン メニューへ戻ります。

注 – ホスト チャネルのマップ中にエラー メッセージが表示された場合は、ステップ 
1～5 を繰り返してください。

▼ホスト LUN を削除（マップ解除）する

1. Change Host LUN Assignments ウィンドウが表示された状態で、削除する LUN を 
Host LUN Assignments フィールドから選択します。

2. Delete Host LUN をクリックします。

3. 終了したら、OK をクリックして変更を保存し、メイン メニューへ戻ります。

構成ファイル
現在の構成のバックアップ コピーを、ディスケットやアレイ以外のほかの外部メ
ディアに保存してください。構成情報がアレイ コントローラと、それに接続された
物理ドライブに保存されていても、火災や洪水などの災害が発生した場合にコント
ローラとドライブの両方が破壊されることがあります。構成のバックアップ コピー
を使用すれば、ストレージ アレイを完全に再構成する必要なく、新しいコントロー
ラに構成を復元できます。 

以下の場合には、アレイ コントローラの構成を必ずファイルに保存してください。

■ 新しいストレージ システム格納装置をインストールする、または既存の格納装置
内のコントローラの SCSI ID を変更する場合

■ アレイ コントローラを交換する場合

■ 論理ドライブを再構成する、またはアレイ コントローラに追加する場合

■ 故障ドライブからスタンバイ ドライブにデータを再構築する場合
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▼構成をバックアップ ファイルに保存する

1. 保存したい構成を持つコントローラを選択します。

2. Configuration → Save Configuration を選択します。

Save Configuration ウィンドウが表示されます。

3. 必要であれば、構成ファイルを保存する先のドライブとフォルダへナビゲートしま
す。 

構成ファイルをディスケットまたはアレイ外部のドライブに保存します。

4. 構成ファイルの名前を指定し、Save をクリックします。

Save Configuration ウィンドウが表示されます。

5. 保存している構成の説明を入力します。

6. OK をクリックします。 

Configuration Service は、コントローラの構成情報を .cfg ファイルに保存します。
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構成のロード

ドライブまたはコントローラが損傷したため交換する必要が生じた場合は、151 ペー
ジの「論理ドライブの構成を復元する」を参照してください。構成ファイルをロード
し、論理ドライブの構成を復元する方法が説明されています。
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第 8 章

LUN フィルタリング(ファイバ チャ
ネルのみ) 

この章では、Sun StorEdge 3510 ファイバ チャネル アレイ用の LUN フィルタを作成
して、同じストレージを共有する大規模なファイバ チャネル ネットワークを維持す
る方法を説明します。この章には以下の項目が含まれます。

■ 93 ページの「概要」
■ 95 ページの「LUN フィルタの割り当て」
■ 95 ページの「LUN Filter View にアクセスする」
■ 96 ページの「HBA デバイスを手動で追加する」
■ 98 ページの「標準ホスト マッピングを削除する」
■ 99 ページの「論理ドライブをホストにマップする」
■ 102 ページの「LUN フィルタを削除する」

概要
ストレージ インフラを効果的に維持するには、データが常時どの程度アクセス可能
で安全であるかが重要な要素となります。Configuration Service では、LUN フィル
タリング サポートを使用して、安全で一元化されたストレージへのアクセスを管理
します。 

LUN フィルタリングは、同じアレイに接続されている複数のサーバに、1 台のサー
バから 1 つの論理ドライブへの専用パスを提供します。同じ論理ドライブに接続して
いるほかのサーバには、その論理ドライブは隠されているか、認識またはアクセスで
きません。つまり、LUN フィルタは、アレイ デバイスがホスト デバイスによってア
クセスおよび認識される方法を管理します。通常、1 つのアレイ デバイスを 1 台のホ
スト デバイスのみにマップして、ほかのホストが同じアレイ デバイスにアクセスし
て使用できないようにします。また、LUN フィルタリングを使用すると、複数の論
理ドライブまたはパーティションを同じ LUN 番号にマップできるので、必要な場
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合、異なるサーバが固有の LUN 0 を持ってブートできるようになります。LUN フィ
ルタリングはまた、各 HBA が通常ハブを通じて 2 倍の数の論理ドライブを認識して
しまうのを、マッピングで明確にする貴重な役割を果たします。

各ファイバ チャネル デバイスには、ワールド ワイド ネーム(WWN)と呼ばれる固有
の識別子が割り当てられています。WWN は IEEE によって割り当てられるもので、
IP の MAC アドレス、またはインターネット上の URL に類似しています。これらの 
WWN は、デバイスの存続期間中使われます。LUN フィルタリングではこの WWN 
を使って、特定の論理ドライブが排他的に使用するサーバを指定します。各論理ドラ
イブを WWN で識別される 1 台のホストのファイバ チャネルの HBA カードにマッ
プするには、簡単なドラッグ アンド ドロップ方式が使用されます。 

次の例で示すように、LUN 01 をホスト チャネル 0 にマップして WWN1 を選択する
と、サーバ A はその論理ドライブへの専用パスを持つことになります。サーバに対
するフィルタを作成しない限り、すべてのサーバは LUN02 と LUN03 を認識し、こ
れらにアクセスし続けます。

図 8-1 LUN フィルタリングの例

LUN フィルタリングの利点は、LUN セキュリティを維持しながら、Windows NT 
などの多くのホストを共通のファイバ チャネル ポートを通じてアレイに接続できる
ことです。

02 03

WWN
(1) 210000E08B021D15

(2) 210000E08B021D15

(3) 210000E08B021D15

LUN ID LUN ID LUN ID
01 XX XX

XX 02 XX

XX XX 03

WWN1 WWN2 WWN3

A: B C

01
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LUN フィルタの割り当て
LUN フィルタを割り当てるには、以下の手順を実行する必要があります。

■ LUN フィルタ ウィンドウにアクセスする

■ HBA デバイスを手動で追加する(必要な HBA が認識できない場合)

■ 標準のマッピングを削除する

■ 論理ドライブをホストにマップする

▼ LUN Filter View にアクセスする

1. Filter View タブをクリックし、LUN Filter View にアクセスします。 

2. コンテナ記号 をクリックすると、デバイス ツリーが展開され、左側にサーバの詳
細、右側にアレイ デバイスの詳細が表示されます。 
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▼ HBA デバイスを手動で追加する

表示される Hosts の下に目的の HBA がない場合、Configure Host/WWN ウィンド
ウから手動でこれを追加します。

1. Configuration → Configure Host/WWN を選択します。

2. Available Hosts リストから、HBA デバイスを追加するホストを選択し、Edit をク
リックします。

ホストが Connected Hosts リスト内に表示されている場合は、そのホストを選択し
て Remove をクリックし、Available Hosts リストに移動します。

3. Add/Edit Host ボックスで、Add をクリックします。
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4. 次の Add/Edit HBA ボックスで、新しい Adapter Name と適切な WWN を入力し、
OK をクリックします。

WWN の決定の詳細は、『233 ページの「ホストのワールド ワイド ネームの決
定」』を参照してください。

5. Configure Host/WWN ウィンドウで編集したホストを選択し、Add をクリックし、編
集したホストを Connected Hosts リストに移動して OK をクリックします。  

LUN Filter 表示に移動すると、新しい HBA デバイスは灰色で表示され、LUN フィ
ルタリングに使用できるようになっています。 
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▼標準ホスト マッピングを削除する

標準マッピングを使用すると、すべてのホストが標準マッピングされたすべての論理
ドライブを認識できるようになります。LUN フィルタリングによって、特定のホス
トへのマッピングが制限されます。LUN フィルタを割り当てる前に、標準ホスト 
マッピング(M ラベル で表示)をアレイから削除する必要があります。 

1. All Hosts の各項目をクリックし、Storage Pools までドラッグ アンド ドロップしま
す。

2. OK をクリックすると次のメッセージが表示されます。 

標準ホスト LUN マッピングの削除に成功したことを確認するメッセージが表示され
ます。

3. ホストがアレイのプライマリ エージェントでないときに、デバイスをそのホストに
マップしたい場合には、そのデバイスを選択し、Configuration → Configure 
Host/WWN を選択します。

4. Available Hosts リストから必要なホストをハイライト表示し、Add をクリックして
そのホストを Connected Hosts リストに追加します。 

ホスト サーバが追加されたことを確認するメッセージが表示されます。 

5. Close をクリックして構成情報を保存し、ウィンドウを終了します。

6. 複数のホストを 1 つのアレイにマップしたい場合には、Configuration → LUN Filter 
Properties を選択して、そのアレイをプルダウン メニューから選択します。 

7. Hardware Filter チェックボックスと Map to Multiple Hostscheck チェックボックス
を選択し、OK をクリックします。 

注 – Hardware Filter チェックボックスを選択解除すると、フィルタ マッピングは作
成できず、標準マップのみを作成できます。

Operation will delete all standard maps of Logical Drive X 
Partition X. Do you want to continue?
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▼論理ドライブをホストにマップする

1. LUN Filter 表示をしていることを確認します。そうでない場合、Filter View タブをク
リックします。

2. Storage Pools から論理ドライブを選択し、Hosts の下にある適切な HBA カードまで
ドラッグ アンド ドロップします。 

アレイに接続されている HBA カードが分からない場合、その論理ドライブをホスト
までドラッグ アンド ドロップします。 

プログラムは、ホスト内の各 HBA カードのアレイをフィルタするように求めるプロ
ンプトを表示します。(これは、接続されている HBA カードにはそれが認識されてお
り、ほかの HBA カードについてはそれが表示されていないことを意味します。)
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3. マッピングの確認を求めるプロンプトが表示されたら、OK をクリックします。

Specify Map Information ウィンドウが表示されます。複数の HBA カードが存在す
る場合、Configuration Service は自動的に、ホストにリストされている 初の HBA 
カードに論理ドライブをマップします。

4. 必要なチャネルと LUN ID 番号を使用して、論理ドライブをプライマリ コントロー
ラまたはセカンダリ コントローラに割り当てたら、OK をクリックします。 

HBA カードをプライマリ コントローラまたはセカンダリ コントローラに割り当てる
のは、 初の LUN フィルタ割り当て時に選択され、その LUN フィルタ割り当てを
削除してやり直さない限り、変更できません。 
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LUN フィルタを 1 つのアレイの 2 台目のホストに適用するには、96 ページの「HBA 
デバイスを手動で追加する」のステップ 6 から99 ページの「論理ドライブをホスト
にマップする」のステップ 3 までを繰り返してください。 

2 人のユーザが同時に同じ論理ドライブにアクセスすると、データの破損が発生する
可能性があることを知らせる警告プロンプトが表示されます。OK をクリックして、
2 台目のホストを追加します。 

次の例では、Sun StorEdge 3510 ファイバ チャネル デバイスには、2 台の別のホスト
に対する LUN フィルタ(フィルタを表す文字 F に注意)機能があります。
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▼ LUN フィルタを削除する

1. 関連付けられた WWN を選択します。

2. Storage Pools までドラッグ アンド ドロップします。 

3. マッピングを削除することの確認を求めるプロンプトが表示されたら、OK をクリッ
クします。 

4. 再確認を求める 2 つ目のプロンプトに対し、OK をクリックします。 
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第 9 章

アレイの監視 

この章では、Configuration Service でアレイを監視する方法を説明します。
Configuration Service メイン ウィンドウと、メイン ウィンドウからアイコンをダブ
ルクリックすると表示されるコンポーネント表示ウィンドウについて説明します。ま
た、Event Log の機能と、Configuration Service の報告機能についても説明します。
この章には以下のセクションが含まれます。

■ 103 ページの「Configuration Service メイン ウィンドウ」
■ 110 ページの「詳細デバイス情報の表示」
■ 124 ページの「Event Log」
■ 128 ページの「Save Report」
■ 134 ページの「View Report」
■ 134 ページの「アウトオブバンド ストレージ管理」
■ 138 ページの「Web によるストレージの管理」

Configuration Service メイン ウィンドウ
Configuration Service メイン ウィンドウからは、すべての アレイ デバイスのステー
タスを一目で確認できます。Configuration Service コンソールにより監視されるサー
バに接続されたデバイスと論理ドライブのステータスが表示されます。デバイスに
は、アレイ コントローラ、ディスク ストレージ格納装置、物理ディスク ドライブ、
およびその他の SCSI デバイスが含まれます。

このウィンドウのツリー構造は、各サーバに接続されているすべてのデバイスの詳細
を提供します。ツリーの左側にある  または  のコンテナ記号は、そのデバイス
が展開表示であるか縮小表示であるかを示します。  コンテナ記号をクリックする
と、下層にあるデバイスが表示されます。  コンテナ記号は、そのレベル及び下層
のデバイスがすべて表示されていることを示します。
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下図は、Configuration Service メイン ウィンドウでの展開表示の例です。 

 

注 – SN# はアレイの固有 ID を表します。

下図は、縮小表示の例です。

 

詳細情報を見るには、アイコンをダブルクリックすると、コンポーネント表示ウィン
ドウが開きます。コンポーネント表示については、この章の後の方で説明していま
す。
104 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



Configuration Service メイン ウィンドウのほかの特徴は、デバイスの状態が色と記
号で区別されているため、注意を要するデバイスを容易に識別できることです。ス
テータスはデバイス ツリーに沿って伝播されるので、障害をデバイス レベルまで追
跡することができます。デバイス ステータスの詳細は、表 9-1 を参照してくださ
い。

オンライン ヘルプ

オンライン ヘルプにアクセスするには、Help → Contents を選択します。オンライ
ン ヘルプは HTML 形式で、Internet Explorer または Netscape から実行できます。
オンライン ヘルプには、プログラムの主要機能に関する情報が含まれています。

製品構成のツリー表示

各サーバ（またはサーバ グループ）について、デバイスは階層構造のツリーとして
表示されます。サーバ（またはグループ）が 上層に、アレイ コントローラがその
下層に表示されます。残りのデバイス(論理ドライブ、物理ドライブ、および格納装

表 9-1 デバイス ステータス状態

色 記号 状態

紫 なし グループ、サーバ、またはデバイスがオンライン。 

白 なし ユーザーがこのサーバにログインしていない。

黄色 このグループまたはサーバの 1 つまたは複数のコンポー
ネントが正常に動作していないが、アレイは機能してい
る。たとえば、1 台の物理ドライブが故障した論理ドラ
イブが性能低下状態で動作している。

赤 このグループまたはサーバの 1 つまたは複数のコンポー
ネントが動作していない。論理ドライブの 2 台のディス
ク ドライブが故障した場合、または格納装置の 3 つの
ファンが故障した場合は、クリティカル状態となる。

灰色 グループ、サーバ、またはデバイスが応答しない。

?
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置)がどのように表示されるかは、表示されるアレイとコントローラによって多少異
なる場合があります。このセクションでは、ツリー表示でのウィンドウ表示の例を示
します。

グループ

グループは、デバイス ツリー内のサーバの論理上の集合です。この新しいデータ オ
ブジェクトにより、複数のサーバを 1 つのカテゴリにまとめることができます。 

グループ オブジェクト  はほかのツリー オブジェクトと同様に表示され、同様
に操作できます。グループ オブジェクトはアイコンで表示され、通常はそのサーバ
と同じステータスを受け継ぎます。下図は、グループ アイコンが展開され、従属ま
たは下層のサーバ オブジェクトを表示した画面です。

グループは、複数のサーバを 1 つのカテゴリにまとめるための新しいデータ オブ
ジェクトです。グループの概念はドメインに類似しています。グループを使用する
と、Configuration Service 内のサーバが管理しやすくなります。管理する全サーバを
リニア ツリーで表すのではなく、Configuration Service のオペレータは、サーバを
類似セットまたはグループとして整理できます。

グループはサーバと同様、色と記号で状態が区別されます。この方法では、各状態を
表す色の優先度は次のようになります。 

■ クリティカル - 赤（ 高）
■ 応答なし - 灰色
■ 低下 - 黄色
■ 適 - 紫
■ ログインなし - 白 
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サーバ アイコンは、そのストレージ システム内で も高い状態の色を受け継ぎま
す。同様に、グループ アイコンは、そのサーバの中で も高い状態の色を受け継ぎ
ます。ただし、次のような応答なし、またはログインなしのサーバの場合を除きま
す。

グループ アイコンが無効（非アクティブ）である場合、そのグループに接続された
すべてのサーバが応答していないことを意味します。グループ内の全サーバより少な
い数のサーバが非応答の場合、そのグループ アイコンは赤で表示され、クリティカ
ル状態であることを示します。たとえば、グループ内に 4 台のサーバがある場合に 3 
台以下のサーバが応答していないと、そのグループ アイコンが赤色になります。

グループ アイコンが白色 (Configuration Service にログインしていない) の場合、グ
ループ内の 1 台以上のサーバが完全に構成されていないか、ステータスが移行中であ
ることを示しています。表 9-2 には、2 台のサーバ グループのアイコンの色の例を示
しています。 

グループは必須ではありません。たとえば、グループなしで 15 台のサーバを持つよ
うに、または 10 台のサーバから成る 1 つのグループとトップ レベルにさらに 5 台の
サーバを持つように Configuration Service を設定できます。Configuration Service 
では任意の組み合わせが可能です。

グループの数と 1 つのグループ内に許可されるサーバの数は、使用可能なシステム 
メモリーによってのみ制限されます。サーバがあるグループのメンバーであり、ユー
ザーがそのグループをグループ リストボックスから削除した場合、そのグループ内
の全サーバは、Configuration Service により「グループなし」カテゴリに再割り当て
されます。Configuration Service は、メイン ウィンドウに表示されるツリーを自動
的に再マップします。

表 9-2 2 台のサーバによるグループの色

サーバ 1
 アイコンの色

サーバ 2
 アイコンの色 グループ アイコンの色

灰色
灰色

灰色
黄色、赤、紫、または白

灰色（応答なし）
赤（クリティカル）

白 白 白（ログインなし）

白 黄色 黄色（低下）

白 赤 赤（クリティカル）

白
赤

紫
任意の色

紫（ 適）
赤（クリティカル）

黄色 
紫

黄色または紫
紫

黄色（低下）
紫（ 適）
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Configuration Service の監視プロセス 
Configuration Service コンソールはサーバ上の Configuration Service エージェント
と通信して、ネットワーク上のストレージ デバイスを監視します。

Configuration Service が起動すると、サーバの構成時に Auto Discovery を指定した
場合、コンソール ソフトウェアが各被管理サーバ上の Configuration Service エー
ジェントとの通信を確立して開始されます。Auto Discovery を指定しなかった場合
は、各サーバをダブルクリックしてパスワードを入力し、そのサーバの発見プロセス
を開始する必要があります。

コンソールと、各サーバ上の Configuration Service エージェントとの間に TCP/IP 
接続を確立し、インベントリ情報を受け取るには、ネットワークの複雑さに応じて数
分かかることがあります。このプロセス中、Configuration Service メイン ウィンド
ウでのサーバ アイコンは、右側に衛星ディッシュが付いて表示されます。インベン
トリのリフレッシュが終了すると、衛星ディッシュ記号がアクティブ サーバ記号に
変わります。

各サーバ上のエージェントは、そのインベントリを定期的にスキャンして 変更がな
いか調べます。変更があった場合、エージェントはコンソールにイベントを送信しま
す。イベントに応じて、コンソールは、Configuration Service メイン ウィンドウで
のサーバの表示を更新するため、そのサーバの 後のスキャンからのインベントリを
要求することがあります。このプロセス中はサーバ アイコンに衛星ディッシュ記号
が付き、リフレッシュ プロセスが完了してコンソールのメイン ウィンドウが更新さ
れるまでは、構成やアレイ活動コマンドを実行できません。

Configuration Service が実行中でサーバ エージェントとコンソールが接続されてい
る場合、 エージェントはサーバのステータスを確認するためコンソールに定期的に
信号 を送信します。コンソールがエージェントから特定の数の応答を連続して受信
（ハンドシェイク）しなかった場合、コンソールはそのサーバをオフラインとみな
し、サーバから切断します。このサーバのアイコンは非アクティブとなり、横に疑問
符が付いて表示されます。

非アクティブのサーバが Auto Discovery 機能を介してアクティブになっていた場
合、コンソールは定期的にサーバとの通信の再確立を試みます。

定期ステータス スキャンの間に、サーバのインベントリを実行したい場合もありま
す。これを行うには、サーバのアイコンをダブルクリックして Server View ウィンド
ウを表示し、Rescan をクリックします。
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Auto Discovery オプション

Auto Discovery オプションを(サーバを Managed Servers リストに追加するプロセス
の間に、「48 ページの「サーバのAutomatic Discoveryを選択または選択解除しま
す。」」を参照)選択した場合、Configuration Service は自動的にそれらのサーバを
スキャンし、インベントリを実行します。Configuration Service から提供される情報
を取り出すために監視用パスワードを入力する必要はありません。ネットワークの複
雑さとサーバの数に応じて、発見プロセスが完了するまでに数分かかることがありま
す。

これに対し、起動時に Auto Discovery オプションを使用しないように選択した場合
は、サーバのアイコンが白で表示され、現在使用可能な情報はないことが示されま
す。この場合は、各サーバ アイコンをダブルクリックして、適切な監視パスワード
を入力する必要があります。 

File → Login を選択することもできます。サーバのパスワードが入力されると、
Configuration Service は発見プロセスを開始し、選択されたサーバのインベントリを
実行します。 

注 – サーバ インベントリへのアクセスも制限するような高いセキュリティが必要な
環境では、Auto Discovery に No を選択します(「48 ページの「サーバのAutomatic 
Discoveryを選択または選択解除します。」」を参照)。
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詳細デバイス情報の表示 
Configuration Service は、Configuration Service の各エージェントまたはサーバ、
および接続されている アレイ デバイスについて詳細情報を提供します。これらの各
表示で示されるフィールドは、ディスク コントローラの能力によって異なります。

このセクションで説明するコマンドおよびウィンドウは、File メニューの下にある 
Save Report と View Report を除いて、View メニューを通じてアクセスできます。

■ View Group
■ View Server
■ View Controller Configuration
■ View Logical Drive 
■ View Physical Drive 
■ View Enclosure
■ View FRU
■ Array Administration Progress
■ Agent Options Management
■ Save Report
■ View Report
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View Group 

View Group は、メインで選択されているグループを構成するサーバを表示します。
Configuration Service ウィンドウ

View Group にアクセスするには、Configuration Service メイン ウィンドウでグルー
プ アイコン をダブルクリックするか、またはグループ アイコンを選択して、
View → View Group を選択します。

Server List には、指定したグループに接続されている全サーバが表示されます。 

 

表示されたサーバの詳細を見るには、リスト内の該当のステータス レコードを選択
して View をクリックするか、ステータス レコードをダブルクリックします。選択し
たサーバについて説明するウィンドウが表示されます。
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View Server 

View Server は、Configuration Service メイン ウィンドウで選択されたサーバの機能
を表示します。

View Server にアクセスするには、Configuration Service メイン ウィンドウでサーバ 
アイコン  をダブルクリックするか、またはサーバ アイコンを選択して View → 
View Server を選択します。

 

注 – デュアル ポート HBA は、デバイスの接続用に個別のチャネルを持つため、個
別のエントリとして表示されます。

TCP/IP ネットワークの一部であるソケット ポートによりサーバとクライアントが接
続されます。

■ Rescan - 選択されたサーバに、既存のインベントリを再スキャンし、コンソール
をリフレッシュするようコマンドを送信します。通常、各被管理サーバは、その
インベントリの定期スキャンを行い、変更があった場合にコンソールを更新しま
す。割り当てられている全デバイスの診断を実行する場合は、Rescan をクリック
します。このボタンの選択は、定期および自動のステータス更新より優先されま
す。
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■ Probe - 選択されたサーバに、新しいインベントリ（たとえば、RAID コントロー
ラ、JBOD、拡張ユニットなど）を探すようコマンドを送信します。新しいデバイ
スが追加された場合やデバイス名が変更された場合、変更をただちに 
Configuration Service ウィンドウのツリー表示に表示するには、Probe をクリッ
クします。

■ Card List - 指定されたサーバにインストールされている、または接続されている
ホスト アダプタとアレイ コントローラを表示します。表示されたホスト アダプタ
またはアレイ コントローラの詳細を見るには、リスト内の該当のステータス レ
コードを選択して View をクリックするか、ステータス レコードをダブルクリッ
クします。選択したアダプタまたはアレイ コントローラについて説明するウィン
ドウが表示されます。

View Controller Configuration

View Controller Configuration は、アレイを形成するコンポーネントを表示します。 

View Controller Configuration にアクセスするには、Configuration Service メイン 
ウィンドウでアレイ アイコン をダブルクリックするか、またはアレイ アイコン
を選択して View → View Controller を選択します。
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バッテリが故障すると、アレイは Configuration Service メイン ウィンドウに黄色(低
下)のデバイス ステータス記号を表示し、Battery フィールドに Bad と示します。 

ウィンドウ下部にあるタブには、RAID コントローラの LUN、それに接続された物
理デバイス、コントローラが配置されている格納装置、さらに周辺デバイスの構成に
ついての詳細情報が表示されます。別のタブの情報を表示するには、そのタブをク
リックします。

Controllers タブ

このウィンドウにアクセスするには、Configuration Service メイン ウィンドウで
アレイ アイコンをダブルクリックするか、またはアレイ アイコンを選択して 

View → View Controller を選択します。次に、Controller タブをクリックします。 

Controller タブには、2 つのコントローラが表示されます。どちらかのコントローラ
の詳細情報を見るには、必要なコントローラをダブルクリックするか、またはコント
ローラを選択して View をクリックします。コントローラがプライマリであるかセカ
ンダリであるかによって、View Primary または View Secondary Controller 
Configuration ウィンドウが表示されます。117 ページの「View Primary/Secondary 
Controller Configuration」を参照してください。
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Physical Drives タブ

このウィンドウにアクセスするには、Configuration Service メイン ウィンドウで
アレイ アイコンをダブルクリックするか、またはアレイ アイコンを選択して 

View → View Controller を選択します。次に、Physical Drives タブをクリックしま
す。 

下図は、View Controller Configuration で Physical Drives タブが表示された画面で
す。

Physical Drives タブには、アレイに関連付けられた物理ドライブが表示されます。
表示されたドライブの詳細を見るには、そのドライブをダブルクリックするか、また
はドライブを選択して View をクリックします。View Physical Drive ウィンドウが
表示されます。
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View Physical Drive の詳細は、120 ページの「View Physical Drive」を参照してく
ださい。

Enclosure Info タブ

このウィンドウにアクセスするには、Configuration Service メイン ウィンドウの 
Enclosure アイコン をダブルクリックするかまたは、アレイ アイコン  を選
択して、View → View Controller を選択します。Enclosure Info タブを選択します。
格納装置を選択し、View をクリックします。

Enclosure Info タブに表示される情報には、電源、ファン、格納装置温度のステータ
スなどがあります。View Enclosure の詳細は、122 ページの「View Enclosure」を参
照してください。

View FRU

アレイの現場交換可能ユニット（FRU ID）情報を表示するには、View FRU をク
リックします。FRU ID 情報の例は、「123 ページの「View FRU」」を参照してくだ
さい。

View Controller Parameters

View Controller Parameters をクリックして、チャネル、RS 232、キャッシュ、ディ
スク アレイ、ドライブ I/F、ホスト I/F、冗長性などの詳細情報を表示します。情報
を見るには、表示したい項目のタブをクリックします。コントローラのパラメータを
変更する方法は、182 ページの「コントローラのパラメータを変更する」を参照して
ください。
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View Primary/Secondary Controller Configuration

View Primary Controller Configuration および View Secondary Controller 
Configuration ウィンドウは、Configuration Service メイン ウィンドウで選択された 
RAID コントローラの機能を表示します。プライマリ コントローラの機能を表示する
には、Configuration Service メイン ウィンドウでプライマリ コントローラを選択し
て View → View Controller  を選択するか、プライマリ コントローラをダブルクリッ
クします。

下の 2 つの図は、プライマリ コントローラの表示例です。
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下の 2 つの図は、セカンダリ コントローラの表示例です。
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Logical Drives タブ

この表示ウィンドウにアクセスするには、Configuration Service メイン ウィンドウ
でプライマリまたはセカンダリ RAID コントローラ アイコン をダブルクリック
するか、またはコントローラ アイコンを選択して View →Controller を選択します。

RAID Controller Parameters ウィンドウで編集可能なコンポーネント パラメータを
表示するには、View Controller Params をクリックします。

論理ドライブを表示するには、Logical Drives タブでドライブを選択してダブルク
リックするか、またはドライブを選択して View をクリックします。

View Logical Drive

View Logical Drive は、Configuration Service メイン ウィンドウで選択された論理
ドライブの機能を表示します。 

この表示ウィンドウには、次のいずれかの方法でアクセスします。 

■ Configuration Service メイン ウィンドウで、論理ドライブ アイコン  をダブ
ルクリックします。 
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■ 論理ドライブ アイコンを選択し、View → View Logical Drive を選択します。 

■ RAID コントローラ アイコン をダブルクリックし、リストボックスから論理ド
ライブを選択して、View をクリックします。 

表示されたドライブの詳細を見るには、そのドライブのステータス レコードをダブ
ルクリックするか、またはドライブを選択して View をクリックします。View 
Physical Drive ウィンドウが表示されます。 

View Physical Drive 

View → View Physical Drive を選択すると、選択した物理ドライブの機能が表示さ
れます。表示ウィンドウに示されるタイトルは、選択されたデバイスによって異なり
ます。

■ ディスク ドライブ の場合は、View Physical Drive ウィンドウと呼びます。
■ テープ ドライブ の場合は、View Tape ウィンドウと呼びます。
■ CD-ROM の場合は、View CD-ROM ウィンドウと呼びます。 

これらのウィンドウのいずれかにアクセスするには、Configuration Service メイン 
ウィンドウで物理デバイスをダブルクリックするか、またはデバイスを選択して 
View → View Physical Drive を選択します。
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■ Associated Partitions -  選択したデバイスが 1 つまたは複数の論理ドライブ パー
ティションに関連付けられている場合にのみ表示されます。

■ View - 関連付けられた論理ドライブがある場合にアクティブになります。

上図は、選択した物理ドライブが 1 つのパーティションに関連付けられている場
合の View Physical Drive ウィンドウの例です。 

■ Remaining Size - ディスク ドライブの容量の一部が 1 つまたは複数の論理ドライ
ブに使用されている場合の残りの未使用容量。

■ RPM - 物理ドライブの毎分回転数。

■ SMART Drive - ドライブが障害予知機能を備えているかどうかを示します。

物理ドライブを選択して View を選択することもできます。View Logical Drive ウィ
ンドウ(テーブルなし)が表示されます。

View Tape ウィンドウと View CD-ROM ウィンドウは上図のウィンドウに似ていま
すが、表示されるカテゴリは多少異なります。 
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View Enclosure

View Enclosure ウィンドウには、Configuration Service メイン ウィンドウで選択さ
れるアレイ格納装置(Sun StorEdge 3310 A という名前で識別され、Id は常に 14 また
は15)のコンポーネントとアラームの機能が表示されます。

1. EMU アイコン を選択します。

2. View → View Enclosure を選択します。

ウィンドウ上部にある 2 つのセクションに、格納装置の識別と関連情報が表示されま
す。アレイに複数の格納装置がある場合、Enclosure Number リストボックス(ウィン
ドウの右上隅にある)を使って、同じアレイ コントローラに接続されている別の格納
装置を表示することができます。

アレイ内の FRU ID と全 FRU に関する情報を表示するには、View FRU をクリック
します。

ウィンドウの Alarm State セクションは、アレイに SCSI Accessed Fault-Tolerant 
Enclosure（SAF-TE）カードまたは SCSI Enclosure Services (SES) カードがインス
トールされている場合にのみ適用されます。 
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■ Alarm State フィールドに Alarm! が表示され、Reset ボタンがアクティブになっ
ている場合は、ドライブ、ファン、電源、またはバッテリの故障、あるいは格納
装置内の異常温度が原因のアラーム状態が存在することを意味します。装置の可
聴アラームが鳴ります。

■ このアラーム状態の発生後 Configuration Service で監視を続行するには、この
ウィンドウの Reset をクリックするか、またはアレイ格納装置の Reset ボタンを押
す必要があります。 

■ 構成レベルのセキュリティ特権が与えられているユーザーだけが Configuration 
Service からアラームをリセットできます。故障したコンポーネントを交換する
か、または装置内部の温度が異常でないかチェックしてください。

ウィンドウの下部には、ウィンドウに表示されているコンポーネントのステータスが
示されます。スロット内にデバイスがインストールされていると、そのデバイスを表
すドライブ アイコンが表示され、デバイスの状態が色と記号で示されます。

View FRU

FRU とは、現場交換可能ユニットです。FRU は、新しいシステムの組み立てや、 現
場でのシステムの修理に使用する部分です。Sun FRU ID （現場交換可能ユニット識
別）プログラムは、FRU に存在する FRU 特定の構成、診断、および故障情報を取り
込み、送信し、解析するための Sun 全体に渡るソリューションです。 

アレイ内の FRU ID と 全 FRU に関する情報を表示するには、View →  View FRU を
選択します。Serial Number (シリアル番号)、Model (モデル)、Description (説明)、
Vendor ID (ベンダー ID)、Time (FRU がプログラムされた日時)、および Location (
場所)が表示されます。
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注 – View Controller Configuration ウィンドウ、View Primary Controller 
Configuration ウィンドウ、および View Secondary Controller Configuration ウィン
ドウでも、View FRU をクリックして特定のコントローラの FRU を表示できます。

Array Administration Progress

Array Admin Progress は、新しい論理ドライブの初期化の進行状況を表示します。
このコマンドにアクセスするには、View → Array Admin Progress を選択します。

Agent Options Management

Agent Options を使い、ポーリング時間、定期デバイス発見時間、SMART 監視など
の Configuration Service エージェントのオプションをカスタマイズできます。

Agent Options にアクセスするには、View → Agent Options Management を選択し
ます。詳細は、57 ページの「エージェントのパラメータを構成する(オプション)」を
参照してください。

Event Log
Configuration Service コンソールは、被管理サーバが生成するイベントと、
Configuration Service コンソール自身が生成するイベントを受信、記録、表示しま
す。

イベントのほとんどは、被管理サーバ上の Configuration Service エージェントに
よって、以下の場合に生成されます。

■ サーバ自身も含め、被管理サーバ上のデバイスのステータス変化（デバイスの故
障、誤動作、切断などが原因）

■ インベントリの変更（デバイスの追加または削除）

■ 構成の変更（初期構成セットアップおよび後の構成変更）

■ サーバで実行されるアレイ プロセス（初期化、パリティ チェック、再構築）

アレイ プロセスは Configuration Service コンソールにより開始されますが、プロセ
スがサーバ上で開始された後に動作通知イベントを生成するのはサーバ エージェン
トです。
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Configuration Service コンソールははるかに少ない数のイベントを生成します。たと
えば、被管理サーバから特定の数のハートビートを連続して受信しなかった場合にイ
ベントを生成します。

コンソールはイベントを受信すると、それを Configuration Service の Event Log 
ファイル eventlog.txt に記録し、Event Log ウィンドウに表示します。また、イ
ベントがサーバ上で発生した場合は、イベントの通知がサーバの動作環境／システム
のイベント ログに送られます。NT サーバでは、NT イベント ログに送られます。さ
らに、イベントがサーバ上で発生した場合で、そのサーバが SNMP エンタープライ
ズ管理コンソール（HP OpenViewなど）にトラップを送信するようにセットアップ
されていた場合、サーバ エージェントはそのコンピュータにもトラップ メッセージ
を送信します。

受信したイベントに応じて、関連サーバの 後の定期スキャンからのインベントリを
要求するため、コンソールがリフレッシュ プロセスを開始することがあります。こ
れは、コンソールが Configuration Service メイン ウィンドウのサーバのインベント
リを更新できるようにするためです。 

このリフレッシュ プロセス中はサーバ アイコンに衛星ディッシュ記号が付き、リフ
レッシュ プロセスが完了してメイン ウィンドウが更新されるまでは、Configuration 
Service の構成やアレイ活動コマンドを実行できません。

Event Log ファイル

Configuration Service の Event Log ウィンドウには一度に 500 までのイベントが表
示されます。500 を超えるイベントがある場合は、 新の 500 のイベントだけが 
Event Log ウィンドウに表示されます。ただし、Configuration Service は、記録され
たイベント数が 10,000 に達するまでイベントを Event Log ファイル eventlog.txt 
から削除しません。

■ イベント数が 10,000 に達すると、Configuration Service は Event Log ファイルの
サイズを 新の 500 イベントに切り詰め、ふたたび 10,000 の制限に達するまでイ
ベントを蓄積し続けます。

■ 各イベント レコードのフィールドはセミコロンで区切られているため、このファ
イルを容易にデータベースにインポートできます。

■ eventlog.txt  は、Configuration Service コンソール プログラムのファイルが
インストールされているディレクトリにあります。
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Event Log ウィンドウ

Event Log にアクセスするには、View → Event Log を選択します。このウィンドウ
は、Close をクリックすることにより、表示内容を失わずに閉じることができます
(View メニューを使い再表示できます)。

Configuration Service コンソールは、Event Log ウィンドウが開いているかどうかに
関わらず、コンソールが実行中であればイベントを受信します。

1. ログ ファイルを削除するには、Delete Logfile をクリックします。 

確認ウィンドウが開き、ログ ファイルを保存するかどうか尋ねられます。

2. 次のいずれかのオプションを選択します。

■ プロンプトで yes を選択し、フォルダとファイル名を選択してログ ファイルを保
存します。 

■ プロンプトで no を選択します。

ログ ファイルの内容が削除されます。

注 – ツールバーの Save Event Log アイコンと Delete Event Log アイコンを使用して
も、eventlog.txt ファイルの内容を保存および削除できます。
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各イベント レコードには、下表に示すフィールドが含まれています。

重要度レベル
■ Critical - ネットワーク管理者による介入を必要とするメッセージ。たとえば、デ

バイス、電源、ファンなどの故障。

■ Warning - 一般に内部プログラム イベントを示す警告メッセージ。このメッセー
ジが頻繁に発生する場合は、サーバまたはネットワークに問題があることを示し
ている可能性があります。

■ Informational - サーバ上のデバイスについて、ネットワーク管理者による介入を
必要としないメッセージ。

選択したレベルと、それより上の重要度レベルのアラームの通知を受け取ります。つ
まり、Informational を選択した場合はすべてのアラーム状態が通知されます。これ
に対し、Critical を選択した場合は Critical アラームだけを受け取ります。

メッセージの詳細は、251 ページの「トラブルシューティング」を参照してください。 

表 9-3 イベント レコードのフィールド

日付 イベントが発生したときのサーバの日付。

時刻 イベントが発生したときのサーバの時刻。

サーバ サーバの IP アドレスとサーバ名。

カード イベントのカード名（該当する場合）。

重要度
次の 3 つの重要度レベルのうちの 1 つ。Critical、Warning、または 
Informational。（これらについては次のサブセクションを参照。）

エラー コード ダッシュで区切られた基本エラー コードと拡張エラー コード。

テキスト 
メッセージ

イベントを説明するテキスト メッセージ。
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Save Report 
Configuration Service の Save Report オプションを使い、特定のアレイに関して 
Configuration Service で使用可能なすべての情報が含まれるテキスト ファイルを作
成できます。

1. File → Save Report を選択します。 

サーバの ID 確認のための Report ダイアログボックスが表示されます。

2. Save report を選択します。 

Save Report File ウィンドウが表示されます。レポート ファイルは ASCII テキスト 
ファイル形式で保存されています。 
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3. ファイル形式を指定するため、拡張子 .txt を付けたファイル名を入力し、Save をク
リックします。

Configuration Service は、選択されたサーバとそのデバイスに関するインベントリと
ステータスのレポートを作成します。 

レポート ファイルのデフォルトの保存場所は Configuration Service のインストール 
ディレクトリです。インストール ディレクトリが煩雑にならないように、レポート
の保存用にサブディレクトリを作成すると便利です。

下図は、レポート例から抜粋したものです。
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View Report 
Configuration Service の View Report オプションを使い、作成されたレポートを表
示します。

1. File → View Report を選択します。 

レポートを選択するための Open ダイアログボックスが表示されます。

2. 表示するレポートを選択し、Open をクリックします。

アウトオブバンド ストレージ管理 
Configuration Service のアウトオブバンド ストレージ管理能力により、TCP/IP を使
用するネットワーク上のアレイを監視、管理することができます。ストレージに物理
的に接続されたサーバ上で Configuration Service エージェントが実行されることを
必要とするインバンド ストレージ管理（ストレージ管理の標準メソッド）とは異な
り、アウトオブバンド ストレージ管理では、ストレージに物理接続されたサーバ上
で Configuration Service エージェントが実行している必要はありません。アウトオ
ブバンド ストレージ管理では、サーバに追加のソフトウェアをロードする必要がな
く、ネットワークのどこからでもストレージの監視や管理ができるという柔軟性があ
ります。
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下図は、インバンドとアウトオブバンドのストレージ管理構成の例です。

図 9-1 インバンド管理

図 9-2 アウトオブバンド ストレージ管理
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Service コンソール

Configuration 

1.1.1.1

SCSI/FC SCSI/FC

アレイ

1.1.1.3 1.1.1.4

エージェント ......1.1.1.1
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▼アウトオブバンド ストレージ管理を使用する

注 – 始める前に、アレイの静的または動的 IP アドレスをセットアップしてあること
を確認してください。

注 – コントローラ、SAF-TE、およびドライブのファームウェアは、アウトオブバン
ド管理を通してアップグレードすることはできません。

1. サーバを選択します。

2. View → Agent Options Management 選択します。 

3. Agent Options Management ウィンドウで、Out-Of-Band Agent preferred over 
In-Band にチェックマークを付けます。 

注 – このオプションが選択されていると、ストレージ管理方法としてアウトオブバ
ンドが優先されます。アウトオブバンド構成が削除された場合、Configuration 
Service は、サービスが起動／再起動された後でインバンドの管理と監視に戻りま
す。

4. IP Address フィールドにアレイの IP アドレスを入力し、Add をクリックします。

5. Configuration Service がアウトオブバンド アレイを認識し、メイン ウィンドウに表
示するため、そのサーバを選択します。

6. View → View Server を選択します。
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7. Probe をクリックします。

Configuration Service メイン ウィンドウにアウトオブバンドの HBA が表示されま
す。
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▼アレイをアウトオブバンド管理から削除する

1. サーバを選択します。

2. View → Agent Options Management を選択します。

3. Managed Primary Agent リストから削除するアレイを選択し、Remove を選択しま
す。

HBA は Configuration Service メイン ウィンドウに表示されたままです。表示から削
除するには、サービスを停止／再起動する必要があります。

Web によるストレージの管理 
Configuration Service の Web ベースのストレージ管理能力は、Configuration 
Service パッケージ全体をロードする必要なく、アレイを Web を通して管理できるの
で便利です。このセクションでは、Web ベースの管理用にアレイをセットアップ
し、Web ブラウザを通してアレイにアクセスする方法を説明します。 

注 – この機能は Linux ではサポートされません。つまり、Linux 動作環境で実行さ
れるシステムにエージェントをインストールしている場合、Custom Configure ウィ
ンドウの Configure Web Server オプションは使用できません。コンソールをロード
するために Linux Web ブラウザを使用できますが、エージェントは Solaris 動作環境
を実行するシステムにインストールされている必要があります。

Web ブラウザの要件 

Solaris 動作環境
■ Netscape 4.76
■ Java Plug-in 1.2.2_02
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Microsoft Windows NT/2000 オペレーティング システム

■ Internet Explorer 5.0 以降
■ Java Plug-in 1.2.2_02

または

■ Netscape 4.76
■ Java Plug-in 1.2.2_02

アレイのセットアップ

Web からアレイにアクセスするために使用するコンピュータ上に、Configuration 
Service パッケージ全体をロードする必要はありませんが、いくつかの Configuration 
Service ファイルは必要です。したがって、別のサーバに Configuration Service 全体
をインストールして、ここからアレイにファイルを転送できるようにしておく必要が
あります。以下の手順では、Web 管理をセットアップするために必要なファイルを
うまく転送する方法を説明します。

1. ネットワークとアレイをつなぐ Ethernet 接続が存在することと、アレイ用の IP アド
レスを確立していることを確認します。

2. Configuration Service パッケージ全体をインストールしたサーバから、Configuration 
→ Custom Configure を選択します。

3. Configure Web Server を選択します。

4. ストレージに直接接続されたサーバ上で実行されている管理エージェントの IP アド
レスを確認します。

5. ファイルの転送先のアレイの IP アドレスを入力し、OK をクリックします。

注 – デフォルトでは、アレイ用にパスワードは設定されていません。ファームウェ
ア アプリケーションを使用してパスワードを作成した場合、これを入力する必要が
あります。 パスワードの作成または変更方法は、ご使用のアレイ用の 『Sun 
StorEdge 3000 Family RAID ファームウェア ユーザ ガイド』を参照してください。
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ファイルの転送に成功したら、確認メッセージが表示され、Web を通じてコンソー
ルにアクセスできるようになります。
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▼ Web ブラウザからコンソールにアクセスする

1. Web ブラウザを開きます。

2. 次の URL アドレスを入力します。

3. 本書の該当の章の説明を参照して、ストレージの監視、管理、更新などの操作を続け
ます。

http:// ワークステーションの IP アドレス/esm.html
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第 10 章

アレイの保守 

この章では、Array Administration を使ってアレイの保全性を維持する方法を説明し
ます。この章でふれるトピックは以下のとおりです：

■ 143 ページの「Array Administration 活動」
■ 144 ページの「パリティ チェックを実行する」
■ 145 ページの「パリティ チェックをスケジュールする」
■ 147 ページの「故障ドライブ」
■ 147 ページの「スタンバイ ドライブを使ってドライブを自動的に再構築する」
■ 148 ページの「スタンバイ ドライブなしでドライブを再構築する」
■ 149 ページの「再構築プロセスの進行状況をチェックする」
■ 149 ページの「故障ドライブを手動で再構築する」
■ 151 ページの「論理ドライブの構成を復元する」
■ 154 ページの「コントローラをリセットする」
■ 154 ページの「コントローラのビープ音を消音する」
■ 155 ページの「故障コントローラをオンラインに戻す」
■ 156 ページの「Performance Statisticsを表示する」

Array Administration 活動
アレイの初期化、ドライブの再構築および
パリティ チェックなど管理は、必要な論理ドライブまたは物理ドライブのサイズに
よって、時間がかかることがあります。

これらのいずれかのプロセスを開始すると、Controller Array Progress ウィンドウが
表示されます。ウィンドウを閉じる場合、進行状況を表示するには、Progress 
Indicator をクリックします。
アイコン または、View → Array Admin Progress を選択します。 
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▼パリティ チェックを実行する    
パリティ チェックとは、フォールト トレラント論理ドライブまたは LUN （RAID 3 
と 5）の冗長データの保全性をチェックするプロセスです。

1. パリティ チェックを実行する論理ドライブを選択します。

2. Array Administration → Parity Check を選択します。

注 – このメニューのオプションにアクセスするには、ssadmin または ssconfig と
してログインする必要があります。

3. Logical Drive Parity Check ウィンドウが表示されたら、パリティ チェックを実行す
る論理ドライブを選択します。
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パリティ チェックを複数のドライブに対して実行するには、Array Administration 
→ Schedule Parity Check コマンドを使って、パリティ チェックを後で（たとえば 3 
分以内に）実行するようにスケジュールします。スケジュールされたパリティ 
チェックが実行されるとき、複数のパリティ チェックが自動的に順に実行されま
す。

4. Parity Check ボタンをクリックして、パリティ チェック プロセスを開始します。

パリティ チェックが開始されると、Progress Indicator が表示されます。このウィン
ドウを閉じた場合、再度開くには、View →Array Admin Progress を選択するか、
Progress Indicator をクリックします。ウィンドウが開き、各アレイについての完了
状況がパーセンテージで示されます。

▼パリティ チェックをスケジュールする      
特定の論理ドライブ アレイに対して実行時間（たとえば、オフタイムなど）をスケ
ジュールしてパリティ チェックを実行するには、Array Administration → Schedule 
Parity Check を選択します。

■ 被管理サーバに構成されている論理ドライブを何台でもスケジュール用に選択で
きますが、1 つのアレイ コントローラにつき 1 つのスケジュールしか設定できま
せん。

■ 複数の論理ドライブがスケジュールされている場合、パリティ チェックは論理ド
ライブの番号の小さいものから大きいものへと順に実行されます。

■ 1 回のパリティ チェックには平均で 1 ギガバイトのストレージあたり 5 分かかり
ます。

■ パリティ チェックに割り当てるシステム リソースの量は、バックグラウンド レー
トを変更することにより制御できます。

■ パリティ チェックを開始した後で停止することができます。停止した結果、デー
タが破損することはありません。

注 – このメニューのオプションにアクセスするには、ssadmin または ssconfig と
してログインする必要があります。

1. パリティ チェックをスケジュールしたいコントローラを選択します。

2. Array Administration → Schedule Parity Check を選択します。

Schedule Parity Check ウィンドウが表示されます。
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3. このウィンドウの必要なフィールドで値を選択します。

■ Listed Logical Drives - 使用可能なフォールト トレラント論理アレイのリストで
す。複数のドライブを選択する場合は Shift キーを使用します。

■ Background Rate - アレイ管理活動に割り当てられた、使用可能なアレイ コント
ローラ CPU 時間のパーセンテージです。バックグラウンド レートを変更するに
は、Custom Configuration Options ウィンドウで Change Controller Parameters 
を選択します。

■ How Often - パリティ チェックの実行頻度を指定します。

■ Starting Day - このスケジュールを開始する曜日を指定します。

■ Starting Time - このスケジュールの開始日における開始時刻を指定します。

■ Existing Schedule - 現在のパリティ スケジュール(論理ドライブ、頻度、開始日、
および時刻)。

■ Next Parity Check - 次のパリティ チェックの開始日と時刻。

4. 希望どおりのスケジュールとなったら、OK をクリックします。
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故障ドライブ 
このセクションでは、ドライブの故障からの回復手順をスタンバイ ドライブがある
場合とない場合について説明します。何らかの理由でこれらの手順による再構築プロ
セスが開始されなかった場合は、手動による再構築 プロセスの開始方法も提供され
ています。

注意 – 故障が発生する前に各論理ドライブ アレイにインストールされ構成された、
ローカルまたはグローバルのスタンバイ ドライブをインストールしてください。使
用している RAID レベルと実装されているアーカイブ プロシージャによっては、1 
つまたは複数のドライブが故障した場合に多大なデータ損失が起こる可能性がありま
す。さらに、誤動作が発生した場合の即時交換用に、テスト済みのスペア ドライブ
をすぐに使用できるようサイトに用意しておいてください。 

▼スタンバイ ドライブを使ってドライブを自動的に
再構築する

フォールト トレラント論理ドライブに関連付けられたドライブが故障した場合で、
スタンバイ ドライブがグローバルまたはローカル ドライブとして事前にインストー
ルされ構成されていた場合は、故障したドライブが自動的に交換され、指定のスペア 
ドライブを使ってそのデータが再構築されます。これがスムーズに行われるには、常
にスペア ドライブの容量が、交換される故障ドライブの容量に等しいかより大きく
なければなりません。 

再構築 プロセスは通常 1～2 分以内に開始されます。このプロセスはバックグラウン
ドで実行され、コントローラ上にほかの活動がない場合に 1 ギガバイトあたり約 8 分
かかります。

自動再構築 プロセスの間、通常の活動は継続可能ですが、パフォーマンスが低下す
ることがあります。パフォーマンス低下の度合いは、コントローラに設定されたバッ
クグラウンド レートに依存します。

再構築プロセスの進行状況を表示するには、View → Array Admin Progress を選択
します。

1. 故障ドライブを交換して自動再構築機能を再確立します。手順については、ご使用の
アレイ用の『Sun StorEdge 3000 Family 導入・運用・サービス マニュアル』を参照
してください。
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2. 故障ドライブを取り出した後、少なくとも 60 秒待ってから新しいドライブを挿入し
ます。 

交換用ドライブが、少なくとも格納装置内の 大のドライブの容量に等しいことを確
認してください。故障ドライブと同じスロット(ドライブ ベイ)に交換用ドライブをイ
ンストールします。これで、交換用ドライブが新しいスタンバイ ドライブになりま
す。

3. 再構築 プロセスが完了し、論理ドライブがオンラインに戻った後、アレイ コント
ローラの構成を、外部ドライブまたはディスケット上のファイルにバックアップしま
す。

62 ページの「論理ドライブの構成を保存する」を参照してください。

▼スタンバイ ドライブなしでドライブを再構築する

アレイにスタンバイ ドライブがない場合は、自動再構築プロセスを開始するには、
先に故障ドライブを交換する必要があります。

1. スタンバイ ドライブがない場合にドライブの故障から回復するには、故障ドライブ
を交換します。手順については、ご使用のアレイ用の『Sun StorEdge 3000 Family 
導入・運用・サービス マニュアル』を参照してください。 

2. 故障ドライブを取り出した後、少なくとも 60 秒待ってから新しいドライブを挿入し
ます。 

交換用ドライブの容量が、少なくとも故障ドライブの容量に等しいことを確認してだ
さい。故障ドライブと同じアドレス（ドライブ ベイ）に交換用ドライブをインス
トールします。

3. 故障ドライブがそのスロット内で交換された後、そのドライブをスキャンする必要が
あります。

ドライブのスキャン方法は、175 ページの「新しいハード ドライブをスキャンする」
を参照してください。

4. ドライブをスキャンした後、Array Administration → Rebuild を選択して、ドライブ
を手動で再構築する必要があります。
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▼再構築プロセスの進行状況をチェックする

1. View → Array Admin Progress を選択するか、ウィンドウ右上隅にある Progress 
Indicator アイコンをクリックします 。 

Controller Array Progress ウィンドウが開き、再構築の完了パーセンテージが表示さ
れます。ただし、複数のコントローラ上でアレイ活動(初期化、再構築、パリティ 
チェックなど)が進行中の場合は、Select Controller Progress ウィンドウが 初に表示
されます。 

2. 進行状況を表示するコントローラを選択し、OK をクリックします。 

Controller Array Progress ウィンドウが開き、選択したコントローラのアレイの進行
状況が表示されます。143 ページの「Array Administration 活動」を参照してくださ
い。

▼故障ドライブを手動で再構築する

ほとんどの場合、交換用ドライブは自動的に再構築されるため、手動による再構築プ
ロセスを使用する必要はありません。 

故障発生時にスペアが存在しなかった場合や、何らかの理由でドライブが再構築され
なかった場合は、Rebuild を使って手動で再構築プロセスを開始できます。また、再
構築プロセスがリセットにより中断された場合に、Rebuild を使って再構築プロセス
を再開できます。

1. 故障ドライブを交換します。手順については、ご使用のアレイ用の『Sun StorEdge 
3000 Family 導入・運用・サービス マニュアル』を参照してください。

2. 故障ドライブを取り出した後、少なくとも 60 秒待ってから新しいドライブを挿入し
ます。 

交換用ドライブの容量が、少なくとも格納装置内の 大のドライブの容量に等しいこ
とを確認してださい。 

3. Array Administration → Rebuild を選択します。 

Rebuild ウィンドウが表示されます。 
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4. 交換用ドライブのステータス レコードを選択します。

5. OK をクリックして再構築プロセスを開始します。

再構築プロセスはバックグラウンドで実行され、アレイ コントローラ上にほかの活
動がない場合に 1 ギガバイトあたり約 8 分かかります。再構築の間、通常の活動は継
続可能ですが、パフォーマンスが低下することがあります。パフォーマンス低下の度
合いは、コントローラに設定されたバックグラウンド レートに依存します。

6. 再構築プロセスの進行状況をチェックするには、View → Array Admin Progress を選
択するか、ウィンドウ右上隅にある Progress Indicator アイコンをクリックします。

Controller Array Progress ウィンドウが開き、再構築の完了パーセンテージが表示さ
れます。

複数のコントローラ上でアレイ活動(初期化、再構築、パリティ チェックなど)が進行
中の場合は、Select Controller Progress ウィンドウが 初に表示されます。

7. 進行状況を表示するコントローラを選択し、OK をクリックします。 

Controller Array Progress ウィンドウが開き、そのコントローラのアレイ再構築の状
況が表示されます。 
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▼論理ドライブの構成を復元する 
このセクションでは、アレイの構成情報をバックアップ ファイルから復元する方法
を説明します。Save コマンドを使ってバックアップ ファイルが既に保存されていな
ければなりません（90 ページの「構成ファイル」を参照）。アレイ コントローラと
そのドライブが損傷した場合、ストレージ アレイを完全に再構成する必要なく、ア
レイの構成を新しいコントローラに復元できます。

注意 – 構成ファイルが 新のものである場合にのみ、アレイ構成をファイルから復
元してください。古い情報や誤った構成が復元されるとデータが喪失します。

バックアップ ファイルに確実に正しいアレイ構成情報が含まれている場合は、以下
の手順を実行して構成を復元してください。

1. 適切なアレイのコントローラを選択します。

2. Configuration → Load Configuration を選択します。 

Select Configuration File ウィンドウが表示されます。 

3. バックアップ構成ファイルの名前と場所を指定し、Open をクリックします。
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Load Configuration ウィンドウが表示されます。構成のツリー表示を見るには、
Configuration View タブをクリックします。

Saveset Description タブには、構成ファイルを作成したときに指定したファイルの説
明が表示されます。
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4. 保存されている構成をロードするには、OK をクリックします。

Load Configuration Confirmation ウィンドウが表示されます。

続行する前に、Load Configuration Confirmation ウィンドウに表示される情報を注
意して確認してください。

5. この構成をロードするには Apply をクリックします。または、この操作をキャンセル
するには Cancel をクリックします。

Apply をクリックすると、構成操作が続行され、進行状況ウィンドウが表示されま
す。

注 –  アレイの構成バックアップ ファイルの内容を復元した後で LUN を初期化しな
いでください。

6. Microsoft Windows NT の場合、オペレーティング システムをシャットダウンしてか
らリブートしてください。

オペレーティング システムの再初期化は、論理ドライブ構成が Windows NT によっ
て認識されるようにするため必要です。
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▼コントローラをリセットする

コントローラのパラメータを変更するたびに、変更を有効にするためコントローラを
リセットするかどうか尋ねられます。複数の変更を行うときは、1 つ変更するたびに
中断してコントローラをリセットしたくない場合もあります。Issue Reset to the 
Controller オプションを使用すると、複数のパラメータ変更を行った後、コントロー
ラを手動でリセットできます。

1. メイン ウィンドウでストレージ アイコンをどれか選択します。 

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。 

Controller Maintenance Options メニューが表示されます。

4. Issue Reset to the Controller をクリックします。

▼コントローラのビープ音を消音する

コントローラがビープ音を発するようなイベントが発生した場合、たとえば、再構築
中や SCSI ドライブの追加中に論理ドライブが故障した場合、コントローラのビープ
音を消音することができます。 

1. メイン ウィンドウでコントローラのアイコンを選択します。 

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。 

Controller Maintenance Options メニューが表示されます。

4. Mute Controller Beeper をクリックします。

または

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。 

2. Configuration → Custom Configure を選択します。

3. Change Controller Parameters を選択します。

4. Mute Beeper を選択します。
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▼故障コントローラをオンラインに戻す

コントローラが故障した場合、以下の手順でコントローラをオンラインに戻すことが
できます。

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。 

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。 

Controller Maintenance Options メニューが表示されます。

4. Deassert Failed Redundant Controller をクリックします。

または

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。 

2. Configuration → Custom Configure を選択します。

3. Change Controller Parameters を選択します。

4. Redundancy タブを選択します。

5. Set Controller Config フィールドで、Redundant Deassert Reset を選択します。
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▼ Performance Statisticsを表示する

Configuration Service の Performance Statistics を使用して、データ転送率、つまり
アレイが実行されるスピードを決定できます。

1. Array Administration → Controller Maintenance を選択します。

2. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。 

Controller Maintenance Options メニューが表示されます。

3. Performance Statistics をクリックします。

Performance Statistics ウィンドウが表示されます。
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第 11 章

構成の更新

この章は、現在の構成に対して変更や追加を行う場合に参照してください。この章に
は以下のタスクが含まれます。

■ 158 ページの「論理ドライブを追加する、または新しい論理ドライブから論理ボ
リュームを追加する」

■ 162 ページの「論理ドライブまたは論理ボリュームを削除する」

■ 166 ページの「パーティションを作成する」

■ 168 ページの「パーティションを削除する」

■ 170 ページの「論理ドライブまたは論理ボリュームの容量を拡張する」

■ 172 ページの「SCSI ドライブを既存の論理ドライブに追加する」

■ 173 ページの「メンバー ドライブをコピーして交換する」

■ 175 ページの「新しいハード ドライブをスキャンする」

■ 176 ページの「RAID コントローラ ファームウェアをダウンロードする」

■ 179 ページの「ファームウェアとブート レコードをアップグレードする」

■ 180 ページの「ハード ドライブのファームウェアをアップグレードする」

■ 181 ページの「SAF-TE デバイスのファームウェアをアップグレードする」

■ 182 ページの「コントローラのパラメータを変更する」

■ 195 ページの「コントローラのビープ音を消音する」

■ 195 ページの「変更した値を保存する」

■ 196 ページの「スタンバイ ドライブを指定または変更する」

■ 197 ページの「サーバ エントリを編集する」

Configuration メニューのコマンドとツールのアイコンは、パリティ チェックなどの
アレイ管理プロセスが実行中の場合に一時的に無効になる場合があります。メニュー 
コマンドは、Configuration Service コンソールがサーバ上でインベントリをリフレッ
シュしている間も無効として表示されます。リフレッシュ プロセスの間はサーバ ア
イコンに衛星ディッシュ記号が付いて表示されます 。
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構成オプションを使用するには、ssconfig パスワードを使って、ソフトウェアの 
ssconfig セキュリティ レベルでログインする必要があります。構成操作が終了し
たら、ログアウトしてプログラムの監視レベルへ戻ります。

▼論理ドライブを追加する、または新しい論理ドラ
イブから論理ボリュームを追加する

既存の RAID セットの構成に 1 つ以上の論理ドライブを追加したり、新しい論理ド
ライブから論理ボリュームを追加するには、このオプションを使用します。既存の 
論理ドライブから 1 つの論理ボリュームを追加する方法は、「161 ページの「既存の
論理ドライブから論理ボリュームを追加する」」を参照してください。

注 – 論理ドライブのサイズが 253 ギガバイトを超える場合は、「78 ページの「253 
ギガバイトより大きい論理ドライブを準備する」」を参照してください。

1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

注 – 使用可能な物理ドライブがあるアレイが選択されていない限り、この選択項目
は非アクティブです。

3. Custom Configuration Option ウィンドウから、Add LDs/LVs to the Current 
Configuration を選択します。

4. ウィンドウ上部に表示されるサーバとコントローラが正しいかどうか確認します。

5. 新しい論理ボリュームに含めるディスクを選択し、Add Disk をクリックします。

選択を間違えた場合や変更したい場合は、そのドライブを選択し、Remove Disk を
クリックします。

6. RAID レベルを選択します。 

RAID レベル定義は、「201 ページの「RAID の基本」」を参照してください。 

7. Channel リストボックスと SCSI ID リストボックスから、新しい論理ドライブを
マップする先のホスト チャネルと SCSI ID を選択します。

8. Max Drive Size を設定します。 

Max Drive Size には、各ディスクの合計容量が表示されます。この値を小さくすれ
ば、より小さい論理ドライブを作成できます。   
158 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



注 – Max Drive Size は変更せずに Partition Size を変更した場合、Configuration 
Service は指定されたパーティション サイズで新しいパーティションを作成します。
論理ドライブ サイズの残り容量は 後のパーティションに移動されます。残り容量
は、後にドライブを拡張した場合に使用できます（170 ページの「論理ドライブまた
は論理ボリュームの容量を拡張する」の説明を参照）。パーティションが作成された
後はドライブ容量を編集することはできません。

注 – 同じコントローラ上に別の論理ドライブを作成したい場合は、New LD をク
リックします。 Configuration Service は、定義したばかりの論理ドライブを作成し
ます。その後ウィンドウ上部に戻るので、別の論理ドライブを作成できます。Sun 
StorEdge 3310 SCSI アレイでは、1 論理ドライブあたり 大 32 パーティションを含
む論理ドライブを 大 8 つ作成できます。Sun StorEdge 3510 FC アレイでは、1 論理
ドライブあたり 大 128 パーティションを含む論理ドライブを 大 8 つ作成できま
す。 

9. この論理ドライブを論理ボリュームに追加するには、New LD をクリックして、
「160 ページの「論理ドライブを論理ボリュームに追加する」」を参照してくださ
い。

10. このウィンドウでの選択が希望どおりになり、これ以上論理ドライブを定義する必要
がなければ、Commit をクリックします。 

確認ウィンドウが開き、新しい構成が表示されます。
第 11 章 構成の更新 159



11. OK をクリックして構成を受け入れます。 

12. Cancel をクリックして Configuration Service コンソールに戻ります。

これにより追加のフォールト トレランスが提供されます。必要な場合に常にドライ
ブの状態を使用可能に変更できます。

注 – OK をクリックした後で論理ドライブの構成を変更することはできません。

注 – 初期化中には、LD と LV のサイズは 0 メガバイトとして表示されます。

▼ 論理ドライブを論理ボリュームに追加する

1 つの論理ボリュームは 2 つ以上の論理ドライブから構成され、 大 32 個のパー
ティションに分割できます。動作時にホストは、分割されていない論理ボリューム、
つまり論理ボリュームの 1 つのパーティションを単一の物理ドライブとして認識しま
す。 

1. 158 ページの「論理ドライブを追加する、または新しい論理ドライブから論理ボ
リュームを追加する」のステップ 1 ～ 8 で説明するように、論理ドライブを作成し
ます。

注 – 論理ボリュームに追加する論理ドライブのパーティションを分けないでくださ
い。パーティションが分けられた論理ドライブは、論理ボリュームに追加できませ
ん。

2. Commit をクリックする前に、論理ドライブを論理ボリュームに追加するには、Add 
to LV をクリックします。

論理ドライブは、LV Definition ボックスに追加されます。論理ボリュームの合計サ
イズが、Available Size (MB) フィールドに表示されます。 

注 – 論理ボリュームはまだパーティションが分割されていないため、Part Size (MB) 
と Available Size (MB) は同じです。単一の論理ボリュームが、単一のパーティショ
ンと見なされます。

3. その論理ボリュームに追加する別の論理ドライブを作成するには、New LD をクリッ
クします。

4. 論理ドライブを作成し、Add to LV をクリックしてその論理ドライブを論理ボリュー
ムに追加します。

論理ボリュームに追加するすべての論理ドライブについて、このステップを繰り返し
ます。
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5. パーティションの作成方法は、「166 ページの「パーティションを作成する」」を参
照してください。

6. 別の論理ボリュームを作成するため、または単独の論理ドライブを作成するために、
論理ドライブを論理ボリュームに追加したら、Commit LV をクリックします。

論理ボリュームの作成が終了し、単独の論理ドライブを作成しない場合、Commit を
クリックします。

注 – 論理ボリュームを作成し終わり、New Configuration ウィンドウを終了すると
きに、Commit の代わりに誤って Commit LV をクリックすると、さらに別の論理ド
ライブを作成しなければならなくなります。作成しない場合は、Cancel をクリック
して論理ドライブを再度構成しなければなりません。

▼既存の論理ドライブから論理ボリュームを追加す
る

注 – 既存の論理ドライブから論理ボリュームを追加する前に、まず論理ドライブを
マップ解除する必要があります。

1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

注 – 使用可能な物理ドライブがあるアレイが選択されていない限り、この選択項目
は非アクティブです。

3. Custom Configuration Option ウィンドウから、Add LDs/LVs to the Current 
Configuration を選択します。

4. ウィンドウ上部に表示されるサーバとコントローラが正しいかどうか確認します。

5. Use existing LDs を選択して論理ボリュームを作成します。

Select a Logical Drive の下に論理ドライブが表示されない場合、論理ドライブがマッ
プ解除されておらず、そのために選択できません。まず、論理ドライブをマップ解除
する必要があります。

6. 論理ドライブを 1 つ選択して、Add to LV をクリックします。
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7. 別の論理ボリュームを作成するため、または単独の論理ドライブを作成するために、
論理ドライブを論理ボリュームに追加したら、Commit LV をクリックします。

論理ボリュームの作成が終了し、単独の論理ドライブを作成しない場合、Commit を
クリックします。

注 – 論理ボリュームを作成し終わり、New Configuration ウィンドウを終了すると
きに、Commit の代わりに誤って Commit LV をクリックすると、さらに別の論理ド
ライブを作成しなければならなくなります。作成しない場合は、Cancel をクリック
して論理ドライブを再度構成しなければなりません。

▼論理ドライブまたは論理ボリュームを削除する

このオプションを使い、既存の RAID セットの構成から 1 つまたは複数の論理ドラ
イブまたは論理ボリュームを削除します。

注 – 論理ドライブまたは論理ボリュームを削除するには、先にすべての割り当て済
み LUN をマップ解除する必要があります。

Use existing LDs を
選択して論理ボリュームを
作成した場合に、
何もドライブがリストされて
いないときは、
論理ドライブがマップ解除
されていません。
まず、論理ドライブを
マップ解除する
必要があります。
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1. 適切なアレイを選択します。

2. 削除する論理ドライブまたは論理ボリュームを表示します。

3. いずれかの論理ドライブまたは論理ボリュームにホスト LUN が割り当てられている
場合はステップ 4 へ進みます。割り当てられていない場合はステップ 8 へ進みま
す。

4. Configuration → Custom Configure を選択します。

5. Change Host LUN Assignments を選択します。

6. マップ解除する論理ドライブまたは論理ボリュームに割り当てられているホスト 
LUN を選択し、Unmap Host LUN をクリックします。

7. OK をクリックして、Close をクリックします。

8. Configuration → Custom Configure を選択します。

9. Custom Configuration Options ウィンドウで Manage Existing LDs/LVs and Partitions 
を選択します。

10. LDs/LVs タブを選択します。

11. 削除する論理ドライブまたは論理ボリュームを選択して Delete をクリックし、OK 
をクリックします。

論理ボリュームを削除するとき、Delete をクリックすると論理ボリュームは削除され
ますが、論理ドライブを構成する論理ドライブは表示されます。
第 11 章 構成の更新 163



12. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。
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論理ドライブ／論理ボリューム番号について

各論理ドライブを参照する論理ドライブ／論理ボリューム番号は動的で、論理ドライ
ブの作成および削除時に変更されます。この番号は、Dynamically Grow and/or 
Reconfigure LDs/LVs ウィンドウ、Change Host LUN Assignments ウィンドウ、
Manage Existing LDs/LVs and Partitions ウィンドウ、および Configuration Service 
メイン ウィンドウを含む、複数の Configuration Service ウィンドウの論理ドライブ
(LDs/LVs)フィールドに表示されます。

この番号は、論理ドライブを視覚的に追跡するためのプレースホルダとしてのみ使用
され、コントローラにとっては意味がありません。つまり、コントローラはこの番号
を使って論理ドライブまたは論理ボリュームについて報告はしません。たとえば、4 
つ論理ドライブがある場合、LD2 が削除されると、既存の LD3 は LD2 に、LD4 は 
LD3 に動的に変更されます。LD/LV 番号だけが変わります。LUN マッピングと論
理ドライブ上のデータはすべてそのままで変わりません。 

LD/LV フィールドに表示される実際の LD/LV 番号は無意味です。コントローラは
論理ドライブの合計数について報告し、この場合は 3 です。この例では、新しい論理
ドライブが作成された場合、削除された論理ドライブの LD 番号がこのドライブの番
号となり、コントローラは合計 4 つの論理ドライブがあると報告します。既存の論理
ドライブはすべて、元のプライマリ／セカンダリ指定に戻ります。 

注 – 次の例で示すように、ファームウェア端末のメニュー オプション View and 
Edit Logical Drives 上の LG 番号は、視覚的に動的ではありません。論理ドライブが
削除された後、空のプレースホルダが表示されます。コンソールまたは端末から論理
ドライブを作成すると、この空のプレースホルダーに新しい論理ドライブが表示され
ます。
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▼パーティションを作成する

注 – パーティションを作成するには、先にすべての割り当て済み LUN をマップ解除
する必要があります。

1. 適切なアレイを選択します。

2. パーティションを作成する論理ドライブを表示します。

3. いずれかの論理ドライブにホスト LUN が割り当てられている場合はステップ 4 へ進
みます。割り当てられていない場合はステップ 8 へ進みます。

4. Configuration → Custom Configure を選択します。

5. Change Host LUN Assignments を選択します。

6. パーティションを分割する論理ドライブに接続しているホスト LUN を選択し、
Unmap Host LUN をクリックします。

7. OK をクリックして、Close をクリックします。

Manage Existing LDs/LVs and Partitions ウィンドウ ( 右側 ) の LD フィールドは動的です。
これは、論理ドライブが作成および削除されるときに変更されます。
この例では、LD2 が削除され、LD4 が LD3 になり、LD2 が LD1 になります。
端末メニュー オプション View and Edit Logical Drives( 左側 ) で、
LG フィールドは動的ではありません。空のスロットは、LD2 が削除されたことを示します。
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8. Configuration → Custom Configure を選択します。

9. Custom Configuration Options ウィンドウで Manage Existing LDs/LVs and Partitions 
を選択します。

10. Partitions タブを選択します。

11. パーティションする論理ドライブまたは論理ボリュームを選択します。

12. Partition Size をメガバイトで指定し、Create をクリックします。

同じサイズのパーティションを複数作成するには、作成するパーティションの数だけ 
Add Partition をクリックします。Part Size フィールドにパーティションのサイズを
入力し、たとえば 100*128 というように、作成するパーティションの数を掛ける(*)こ
ともできます。メガバイトが残る場合、 後のパーティションに追加されます。

パーティションを追加するたび、Available Size (MB) に表示される残りの容量は、追
加したパーティションのサイズ分減少します。

13. 作成したパーティションのサイズを変更するには、その論理ドライブまたは論理ボ
リュームを選択し、Modify Size をクリックします。 

14. Partition Size フィールドで、新しいサイズをメガバイトで指定し、OK をクリックし
ます。

15. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。

論理ドライブまたは論理ボリュームのパーティションを分割した後、Configuration 
Service メイン ウィンドウで論理ドライブまたは論理ボリュームを開くと、そのパー
ティションが表示されます  。
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論理ドライブ／論理ボリューム番号について

Manage Existing LDs/LVs and Partitions ウィンドウの LDs/LVs フィールドに表示
される論理ドライブ／論理ボリューム番号に関する重要な情報は、「165 ページの
「論理ドライブ／論理ボリューム番号について」」を参照してください。

▼パーティションを削除する

注 – 論理ドライブまたは論理ボリューム上のパーティションを削除するには、すべ
ての割り当て済み LUN をマップ解除する必要があります。

1. 適切なアレイを選択します。

2. パーティションを削除する論理ドライブまたは論理ボリュームを表示します。 

いずれかのドライブ上のパーティションにホスト LUN がマップされている場合はス
テップ 3 へ進みます。マップされていない場合はステップ 7 へ進みます。

3. Configuration → Custom Configure を選択します。

4. Change Host LUN Assignments を選択します。

5. 削除する論理ドライブまたは論理ボリュームにマップされている LUN を選択し、
Unmap Host LUN をクリックします。

6. OK をクリックして、Close をクリックします。

7. Configuration → Custom Configure を選択します。

8. Custom Configuration Options ウィンドウで Manage Existing LDs/LVs and Partitions 
を選択します。

9. Partitions タブを選択します。
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10. 論理ドライブまたは論理ボリューム内で変更または削除するパーティションを選択し
ます。論理ドライブまたは論理ボリューム内の最後のパーティションから選択を開始
します。

11. Delete をクリックして、OK をクリックします。

12. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。
第 11 章 構成の更新 169



▼論理ドライブまたは論理ボリュームの容量を拡張
する

このオプションを使い、既存の論理ドライブまたは論理ボリュームの容量を拡張しま
す。たとえば、18 ギガバイトのドライブがあり、その 9 ギガバイトだけを選択して
論理ドライブを構築してあったとします。残りの 9 ギガバイトを使用するには、論理
ドライブを拡張する必要があります。 

注 – 論理ボリュームを拡張するには、まずその論理ドライブを構成する論理ドライ
ブを拡張する必要があります。

1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

3. Custom Configuration Options ウィンドウで Dynamically Grow and/or Reconfigure 
LDs/LVs を選択します。

4. 拡張する論理ドライブまたは論理ボリュームを選択します。

5. Expand LD/LV タブを選択します。

6. Maximum Drive Expand Capacity フィールドで、論理ドライブまたは論理ボリュー
ムを拡張する容量をメガバイトで指定し、OK をクリックします。 

Maximum Drive Expand Capacity に指定する値は、Maximum Available Drive Free 
Capacity を超えることはできません。
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7. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。

論理ドライブ／論理ボリューム番号について

Dynamically Grow and/or Reconfigure LDs/LVs ウィンドウの LD/LV フィールド
に表示される論理ドライブ／論理ボリューム番号に関する重要な情報は、「165 ペー
ジの「論理ドライブ／論理ボリューム番号について」」を参照してください。

作成時に論理ドライブの最大容量を
使用した場合、0 が表示されます。
別の論理ドライブを追加しない限り、
拡張する余地はありません。
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▼ SCSI ドライブを既存の論理ドライブに追加する 
1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

3. Custom Configuration Options ウィンドウで Dynamically Grow and/or Reconfigure 
LDs/LVs を選択します。

4. SCSI ドライブを追加する論理ドライブを選択します。

5. Add SCSI Drives タブを選択します。

6. Available disks リストから、論理ドライブに追加するドライブを選択します。

7. Add Disk をクリックします。 

選択したドライブが Add disk(s) to LD リストに移動されます。

選択を間違えた場合や変更したい場合は、Add disk(s) to LD リストからそのディス
クを選択し、Remove をクリックします。

8. SCSI ドライブの追加が終了したら、OK をクリックします。

9. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。
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論理ドライブ／論理ボリューム番号について

Dynamically Grow and/or Reconfigure LDs/LVs ウィンドウの LD/LV フィールド
に表示される論理ドライブ／論理ボリューム番号に関する重要な情報は、「165 ペー
ジの「論理ドライブ／論理ボリューム番号について」」を参照してください。

▼メンバー ドライブをコピーして交換する 
このオプションを使い、既存のメンバー ドライブをより大きい容量のドライブにコ
ピーして交換します。たとえば、18 ギガバイトの容量の 3 つのメンバ ドライブを含
む論理ドライブが 1 つあったとします。下図に示すように、この論理ドライブを、そ
れぞれ 36 ギガバイトの容量の新しいメンバ ドライブと交換することができます。

図 11-1 メンバー ドライブのコピーと交換

1. 適切なアレイを選択します。

2. Configuration → Custom Configure を選択します。

3. Custom Configuration Options ウィンドウで Dynamically Grow and/or Reconfigure 
LDs/LVs を選択します。

4. コピーと交換操作を行う対象の論理ドライブを選択します。

5. Dynamically Grow and/or Reconfigure LDs/LVs ウィンドウで Copy and Replace 
Drive タブを選択します。

18 GB18 GB18 GB
新しい

36 GB

36 (GB)36 (GB) 36 (GB)

RAID5 (4 GB)

使用中

未使用

新しい

36 GB

新しい

36 GB

RAID5 (4 GB)

ドライブ ドライブ ドライブ
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6. Drive to Copy Data From リストから、新しいハード ドライブを選択します。

7. Drive to Copy Data To リストから、交換されるハード ドライブを選択し、OK をク
リックします。

新しいドライブで提供される追加容量を使用する方法は、170 ページの「論理ドライ
ブまたは論理ボリュームの容量を拡張する」を参照してください。

8. Confirm Configuration Operation ウィンドウで、OK をクリックして操作を完了し、
Close をクリックします。

9. 操作が完了したら、進行状況ウィンドウを閉じます。

論理ドライブ／論理ボリューム番号について

Dynamically Grow and/or Reconfigure LDs/LVs ウィンドウの LD/LV フィールド
に表示される論理ドライブ／論理ボリューム番号に関する重要な情報は、「165 ペー
ジの「論理ドライブ／論理ボリューム番号について」」を参照してください。
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▼新しいハード ドライブをスキャンする        
ハード ドライブは、アレイをシャットダウンせずに、スキャンして使用可能にする
ことができます。

1. 適切なアレイをダブルクリックします。

2. View Controller Configuration ウィンドウが表示されます。

3. Physical Drives タブを選択し、Scan SCSI Drive をクリックします。
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4. ドライブの正しい入力チャネルと ID を選択します。

スキャンに成功すると、そのドライブが正しく表示され、使用可能になります。

▼ RAID コントローラ ファームウェアをダウンロー
ドする

コントローラ ファームウェアをアップグレードするための次の手順は、単一コント
ローラ構成と冗長コントローラ構成の両方に使用できます。

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。 

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。 

Controller Maintenance Options メニューが表示されます。
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4. ファームウェアだけ(ブート レコードを含まない)をアップグレードする場合は、
Download Firmware オプションを選択します。 

Select Firmware File ウィンドウが表示されます。
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5. ダウンロードするファームウェアを選択し、Open をクリックします。

確認を求める Confirmation Dialog ウィンドウが表示されます。

6. Yes をクリックします。 

ファームウェアを RAID コントローラへダウンロードする進行状況バーが表示されま
す。

7. 進行状況バーが 100% に達したら、OK をクリックします。 

8. ファームウェアがダウンロードされた後、設定が正しいことを確認してください。
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▼ファームウェアとブート レコードをアップグレー
ドする

1. Array Administration → Controller Maintenance を選択します。

2. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。 

Controller Maintenance Options メニューが表示されます。

3. Download Firmware with Boot Record を選択します。

Select Boot Record File ウィンドウが表示されます。

4. ブート レコードを選択し、Open をクリックします。 

5. 必要なファームウェア ファイルを選択します。 

Select Firmware File ウィンドウが表示されます。

6. Open をクリックします。 

Confirmation Dialog ウィンドウが表示されます。

7. 前のサブセクションのステップ 6～8 を繰り返します。
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デバイスのファームウェアのダウンロー
ド
このオプションを使い、ハード ドライブと SAF-TE デバイスのファームウェアを
アップグレードします。

▼ハード ドライブのファームウェアをアップグレー
ドする

1. 適切なアレイを選択します。

2. Array Administration → Download FW for Devices を選択します。

3. Download FW for Disks タブをクリックします。

4. To All disks under Controller を選択してメニューからアレイを選択するか、または 
To All disks under LD を選択してメニューから論理ドライブを選択します。

■ 新しいファームウェアをダウンロードしたくないドライブがある場合は、それら
を Selected Disks リストから選択し、Remove をクリックします。

■ 追加する論理ドライブがある場合は、それらを Available Disks リストから選択
し、Add をクリックします。

■ 異なる製品 ID を持つ複数のドライブがある場合は、ファームウェアをダウンロー
ドするドライブの製品 ID を Product ID リストボックスから選択する必要があり
ます。
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5. Browse をクリックし、ダウンロード ファームウェア ファイルを探します。 

Open をクリックします。

6. ダウンロード ファームウェア ファイルを選択し、Open をクリックして、OK をク
リックします。

ファームウェアのダウンロードが開始されます。

7. 進行状況が 100% に達したら、OK をクリックします。

8. ファームウェアが正しくダウンロードされたことを確認するには、View → View 
Physical Drive を選択し、Product Revision フィールドのファームウェア バージョン
が更新されたことを確認します。

▼ SAF-TE デバイスのファームウェアをアップグ
レードする 

注 – SAF-TE デバイスは、SCSI アレイによって使用され、SES デバイスはファイバ 
チャネル アレイによって使用されます。

1. アレイを選択します。

2. Array Administration → Download FW for Devices を選択します。
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3. Download FW for SAFTE/SES Devices タブをクリックします。

■ デバイスを追加するには、それを Available SAF-TE Devices リストから選択し、
Add をクリックします。

■ デバイスを削除するには、それを Selected SAF-TE Devices リストから選択し、
Remove をクリックします。

4. Browse をクリックし、ダウンロード ファームウェア ファイルを探します。 

5. ダウンロード ファームウェア ファイルを選択し、Open をクリックして、OK をク
リックします。

ファームウェアのダウンロードが開始されます。

6. 進行状況が 100% に達したら、OK をクリックします。

7. ファームウェアが正しくダウンロードされたことを確認するには、View → View 
Enclosure を選択し、Firmware Rev フィールドのファームウェア バージョンが更新
されたことを確認します。

▼コントローラのパラメータを変更する

1. メイン メニューから適切なアレイ コントローラを選択します。

2. Configuration → Custom Configure を選択します。 

必要であれば、ssconfig パスワードを使って、プログラムの構成レベルにログイン
します。
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3. Custom Configuration Options ウィンドウで、Change Controller Parameters を選択
します。 

Change Controller Parameters ウィンドウが開き、Channel タブが表示されます。

注 – Sun StorEdge 3510 FC アレイでは、CurClk は 2.0GHz です。

■ Controller Name - コントローラ名を設定する場合は、Controller Name を選択
し、希望の名前を入力します。OK をクリックして変更を保存します。

■ Controller Unique ID - この ID は自動的に設定されます。
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Channel Tab

1. Channel Settings タブで、編集するチャネルを選択します。

2. Change Settings をクリックします。

Change Channel Settings ウィンドウが表示されます。サーバがアレイを認識するに
は、ホスト チャネルの ID を論理ドライブに割り当て、論理ドライブをそのホスト 
チャネルと ID にマップしなければなりません。このウィンドウを使用すると、ホス
ト／ドライブ チャネルを構成できます。

3. Channel Mode リストボックスから、Host または Drive を選択します。 

Drive チャネルは、ドライブが接続されるチャネル(内部または外部)です。Host チャ
ネルは、サーバに接続されるチャネルです。

注 – コントローラの構成によっては、次の手順で説明するように、プライマリとセ
カンダリ両方のチャネル ID を選択する必要がある場合があります。

4. Available SCSI IDs リストボックスから、PID と呼ばれるプライマリ チャネル ID を
選択します。Add PID をクリックします。

5. コントローラが 2 つある場合は、Available SCSI IDs リストボックスからセカンダリ 
ID を選択し、Add SID をクリックします。
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ファイバ構成内のホスト ID を変更する

1. 15 より上の ID を使用する場合は、Select SCSI ID Range をクリックし、希望の範
囲を選択します。 

注 – 各チャネルの ID は同じ範囲内にある必要があります。

2. Remove をクリックして、PID または SID を削除します。

3. 選択を終えたら、OK をクリックして前のウィンドウに戻ります。

RS 232 タブ

1. チャネル設定をすべて終了した後、Change Controller Parameters ウィンドウで、
RS 232 タブを選択します。

2. 必要なポートを選択し、Change Settings をクリックします。 

Change RS232 Port Settings ウィンドウが表示されます。
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3. デフォルト設定の 9600 も含め、希望の任意のボーレートを選択し、OK をクリック
して前のウィンドウに戻ります。 

Cache タブ

1. Change Controller Parameters ウィンドウで、Cache タブを選択します。

2. リストボックスから Optimization を選択するか、現在の設定を受け入れます。

このオプションは、アレイ内の各ドライブに渡り書き込まれるデータの量を指定しま
す。Sequential I/O は、大きいデータ ブロック、random I/O は小さいデータ ブ
ロックを意味します。

既存の論理ドライブが Optimization set for Random I/O で作成されていた場合、
Sequential I/O モードに変更したときにその論理ドライブをデータの読み書きに使用
することはできません。この逆も同様です。これは、ストライプ サイズがそれぞれ
異なるためです。

3. Write Back を使用するには、そのリストボックスをクリックして、Enabled または 
Disabled を選択します。
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Disk Array タブ

1. Change Controller Parameters  ウィンドウで、Disk Array タブを選択します。 

2. 3 つの Write Verify リストボックスから、Disabled または Enabled をそれぞれ選択し
ます。

通常、エラーはハード ドライブへの書き込み時に発生します。書き込みエラーを防
ぐため、ハード ドライブが書き込まれたデータを検証するようにコントローラで強
制できます。

■ Write Verify on Initialization - 論理ドライブの初期化中に書き込み後の検証を実行
する。

■ Write Verify on Rebuild - 再構築プロセス中に書き込み後の検証を実行する。

■ Write Verify on Normal - 通常の I/O 要求時に書き込み後の検証を実行する。
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3. Rebuild Priority リストボックスで、使用可能な 4 つのオプションである、Low、
Normal、Improved または High から選択します。

RAID コントローラは、バックグラウンドでの再構築機能を提供します。つまり、コ
ントローラは、論理ドライブの再構築中にほかの I/O 要求を処理できます。ドライ
ブの再構築に要する時間は主に、再構築する論理ドライブの合計容量に依存します。
また、再構築処理はホスト コンピュータまたは動作環境から完全にトランスペアレ
ントです。

■ Low - デフォルト設定。コントローラの 小のリソースを再構築に使用する。

■ Normal - 再構築プロセスを速める。

■ Improved - 再構築プロセスにより多くのリソースを割り当てる。

■ High - コントローラの 大のリソースを使用し、再構築プロセスを も短い時間
で完了する。
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Drive I/F タブ

1. Change Controller Parameters ウィンドウで、Drive I/F タブを選択します。

2. SCSI Motor Spin Up field フィールドで、Disabled または Enabled を選択します。

SCSI Motor Spin Up は、ディスク アレイ内の SCSI ドライブの始動方法を指定しま
す。同時に電源投入されたハード ドライブとコントローラに電源装置が十分な電流
を供給できない場合、ハード ドライブを順次にスピンアップするのが、電源投入時
の消費電流を低下させる 良の方法の 1 つです。デフォルトでは、電源投入時に全部
のドライブがスピンアップします。 

3. Power Up SCSI Reset フィールドで、Enabled または Disabled を選択します。

コントローラは、電源が入るとデフォルトで SCSI バス リセット コマンドを SCSI バ
スに送ります。これを無効化すると、コントローラは次回電源投入時に SCSI バス リ
セット コマンドを送信しません。

デュアル ホスト コンピュータを同じ SCSI バスに接続すると、SCSI バス リセット
は、実行中のすべての読み取り／書き込み要求に割り込みます。これにより、動作環
境またはホスト コンピュータが誤動作することがあります。このような状態を避け
るため、電源投入時の Power Up SCSI Reset は無効(Disable)に設定してください。

4. Disk Access Latency を設定します。

この機能は、電源投入後にコントローラがハード ドライブにアクセスを試みるまで
の遅延時間を設定します。デフォルトは 15 秒です。

5. Tag Count Per drive を設定します。

これは、各ドライブに同時に送信できるタグの 大数です。ドライブには内蔵キャッ
シュがあり、ドライブはこれを使用して、受け取るすべての I/O 要求（タグ）を分
類するので要求をより速く完了できます。

キャッシュ サイズとタグ 大数は、ドライブのブランドとモデルにより異なりま
す。デフォルト設定の 32 を使用してください。 大タグ カウントを Disable に設定
すると、ドライブの内蔵キャッシュが無視されます(使用されません)。

コントローラは、1～128 の調節可能タグ カウントのタグ コマンドをキューに入れて
処理できます。

6. SAF-TE Polling Period (Sec) フィールドで、リストボックスからさまざまな時間オプ
ションを選択するか、または 0.0 を選択してこのオプションを無効にします。無効に
した場合、インストール済みのすべてのイベント報告モジュール(ERM)はポーリング
されません。
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7. SCSI I/O Timeout (Sec) フィールドで、0.5～10 秒の値を選択します。

SCSI I/O Timeout は、コントローラがドライブからの応答を待つ時間間隔です。コ
ントローラがドライブに対して読み取りや書き込みを試みたときに、ドライブが 
SCSI I/O タイムアウト値内に応答しない場合、そのドライブは故障ドライブと見な
されます。

SCSI I/O Timeout のデフォルト設定は７秒です。この設定は変えないでください。
これより低いタイムアウト値を設定すると、ドライブがまだ処理を再試行中の場合
や、ドライブがまだ SCSI バスと調停できていない場合でもコントローラがドライブ
を故障していると判断してしまう恐れがあります。また、上記より高いタイムアウト
値を設定すると、コントローラのドライブ待機中にホスト側がタイムアウトしてしま
う恐れが出てきます。

ドライブ盤からの読み取り中にドライブがメディア エラーを検出すると、ドライブ
は前の読み取りを再試行するか、ヘッドを再調整します。ドライブは、メディア上に
不良ブロックを見つけると、その不良ブロックを同じディスク ドライブ上の別のス
ペア ブロックに再割り当てします。ただし、この処理は時間がかかります。これら
の操作実行にかかる所要時間はドライブのブランドとモデルにより異なります。

SCSI バス調停の際、より高い優先順位のデバイスがバスを 初に使用します。より
低い優先順位のデバイスは、優先順位の高いデバイスがバスを使い続けていると、 
SCSI I/O タイムアウトを受け取ることがあります。

8. Drive Check Period (Sec) フィールドで、0.5～30 秒の値を選択します。

Periodic Drive Check Time は、コントローラが SCSI バス上のドライブをチェックす
る時間間隔です。デフォルト値は Disabled です。これは、バス上で何も活動がない
場合、コントローラからはドライブが故障したかまたは削除されたかが分からないこ
とを意味します。この間隔を設定すると、アレイ活動がないときに Configuration 
Service がドライブの故障を検出できます。ただし、パフォーマンスが低下します。
190 Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



Host I/F タブ

1. Change Controller Parameters ウィンドウで、Host I/F タブを選択します。

2. Max Queued IO Count を設定します。 

この機能を使い、コントローラがホスト コンピュータから受け入れることができる 
I/O キューの 大サイズをバイト単位で設定します。デフォルトは 256 秒です。定義
済みの範囲は 1～1024 バイトですが、Auto Computer (自動的に設定する)モードを選
択することもできます。

3. LUNs Per Host を設定します。

この機能は、ホスト SCSI ID あたりの LUN 数を変更するために使います。デフォル
ト設定は 32 LUN で、使用可能な事前定義された範囲は 1 ～ 32 LUN です。
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Redundancy タブ

1. Change Controller Parameters ウィンドウで、Redundancy タブを選択します。 

3 つの読み取り専用のフィールド、Controller Configuration、Controller Status、お
よび Secondary Serial No が表示されます。

2. Set Controller Config フィールドで、オプションを選択します。 

■ Redundant Deassert Reset - 停止してあったコントローラをオンラインに戻す場
合。

■ Redundant Force Sec Fail - セカンダリ コントローラを強制停止する場合。

■ Redundant Force Pri Fail - プライマリ コントローラを強制停止する場合。

注 – 冗長プライマリ構成で両方のコントローラを設定してください。両方を設定し
ておくと、どれがプライマリでどれがセカンダリであるかコントローラによって判断
され、コントローラ間の競合を防ぐことができます。
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3. 変更を保存するには、Change Controller Parameters ウィンドウで、Issue Controller 
Reset を選択します。

4. Close をクリックして Configuration Service メイン メニューのツリーに戻ります。

Network タブ

1. Change Controller Parameters ウィンドウで、Network タブを選択します。

2. IP アドレス、サブネット マスク、またはゲートウェイ アドレスを手動で設定するに
は、Change Settings をクリックします。

3. DHCP/RARP サーバの環境でアレイを設定してある場合、Enable Dynamic IP 
Assignment を選択して、アレイでネットワークから自動的に IP アドレスを取得でき
ます。 
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▼コントローラのビープ音を消音する

コントローラがビープ音を発するようなイベントが発生した場合、たとえば、再構築
中や SCSI ドライブの追加中に論理ドライブが停止した場合、ビープ音を消音するこ
とができます。

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。 

2. Array Administration → Controller Maintenance を選択します。

3. ssconfig としてログインしていない場合は、パスワードを求めるプロンプトが表示
されます。ssconfig パスワードを入力します。 

Controller Maintenance Options メニューが表示されます。

4. Mute Controller Beeper をクリックします。

または

1. メイン ウィンドウで、必要なコントローラのアイコンを選択します。 

2. Configuration → Custom Configure を選択します。

3. Change Controller Parameters を選択します。

4. Mute Beeper を選択します。

▼変更した値を保存する

1. 上記に説明するすべてのパラメータが希望どおりの設定値になったら、Configuration 
→ Custom Configuration を選択します。

2. Change Controller Parameters をクリックします。

3. Issue Controller Reset を選択します。

4. OK をクリックして Close をクリックし、Configuration Service メニューのツリーに
戻ります。
第 11 章 構成の更新 195



▼スタンバイ ドライブを指定または変更する

スタンバイ ドライブは、フォールト トレラント（非 RAID 0）論理ドライブが故障
した場合にデータの自動再構築をサポートするスペアとして機能します。別のドライ
ブに取って代わるスタンバイ ドライブは、故障したドライブと少なくとも同じサイ
ズでなければなりません。また、故障したディスクに従属するすべての論理ドライブ
が冗長（RAID 1、3、5、または 1+0）でなければなりません。

この機能を使い、グローバルまたはローカルのスタンバイ ドライブを指定すること
や、準備完了ドライブの状態をスタンバイに変更したり、スタンバイ ドライブの状
態を準備完了に変更したりできます。グローバル スペアとして指定されているドラ
イブは、既存のどのドライブのメンバーが故障した場合でも再構築します。アレイ 
コントローラに 1 つまたは複数のスタンバイ ドライブを関連付けることができま
す。ローカル スペアは、特定の論理ドライブに割り当てる必要があり、その論理ド
ライブ内のメンバー用にのみ再構築します。

1. Configuration Service メイン ウィンドウで、必要なアレイ コントローラを選択しま
す。

2. Configuration → Custom Configure を選択するか、Custom Configuration ツールを
クリックします。

必要であれば、ssconfig パスワードを使って、プログラムの構成レベルにログイン
します。Custom Configuration Options ウィンドウが表示されます。

3. Custom Configuration Options ウィンドウで Make or Change Standby Drives を選択
します。

Make or Change Standby Drives ウィンドウが表示されます。
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4. ウィンドウ上部に表示されるサーバとコントローラ ID を確認します。

別のサーバまたはコントローラを選択する場合は、Cancel をクリックして 
Configuration Service ツリー表示に戻り、必要なサーバまたはコントローラを選択し
てからステップ 2 と 3 を繰り返します。

5. 指定または変更するドライブを選択します。

6. ドライブの状態を、Ready（準備完了）、Global StandBy（グローバル スタンバ
イ）、またはStandBy for LD# （ローカル）から選択して指定または変更します。

7. Modify をクリックします。

8. Apply をクリックして、Close をクリックします。

9. 構成を変更した場合は必ず、新しい構成をファイルに保存してください。 (For 
details, see 90 ページの「構成ファイル」) 

使用可能サーバ
Server List Setup ウィンドウの Available (使用可能)リストまたは Managed Servers (被
管理サーバ)リストのエントリを削除または変更することが必要な場合もあります。

▼サーバ エントリを編集する

1. File → Server List Setup を選択します。Server Setup ウィンドウが表示されます。 

必要に応じて、Server List Setup ウィンドウで、サーバ名を Managed Servers リス
トから Available Servers リストに移動します。編集できるのは、Available Servers 
リストに表示されているサーバだけです。
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2. Available Servers リストからサーバ名を選択し、Edit をクリックします。 

Edit Server ウィンドウが表示されます。
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3. 必要な変更を行います。OK をクリックして変更を保存します。

このウィンドウのフィールドの説明は、「46 ページの「サーバを追加する」」を参
照してください。Add Server ウィンドウと Edit Server ウィンドウに表示される
フィールドは同じです。

IP アドレス ショートカット:ネットワーク アドレスが変更されている場合は、Get IP 
Addr by Name をクリックします。サーバの名前はネットワークで使用するネーム 
サービスによって記録されているため、サーバ名を入力すると、Configuration 
Service がその正しい IP アドレスを検索して表示します。 

サーバに使用する名前がサーバのネットワーク名と同じでない場合や、ネーム サー
ビスがまだ更新されていない場合は、そのサーバを削除して追加し直します。

4. サーバ名を Managed Servers リストに戻します。

5. OK をクリックして Edit Server ウィンドウを終了します。
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付録 A

RAID の基本

この付録では、RAID 用語の概要や RAID レベルなど、RAID に関する基本知識を提
供します。取り上げるトピックは以下のとおりです。

■ 201 ページの「RAID 用語の概要」
■ 207 ページの「RAID レベル」
■ 215 ページの「ローカル スペア ドライブとグローバル スペア ドライブ」

RAID 用語の概要
RAID (独立ディスクの冗長アレイ)は、ストレージ システムの処理能力を向上させる
ために使用されるストレージ技術です。このテクノロジでは、ディスク アレイ シス
テムの信頼性を確保し、単一ディスク ストレージ上の複数のディスク アレイが提供
するパフォーマンスの向上を得ることができます。

RAID のおもな基本概念は、次の 2 点です。 

■ 複数のハード ドライブ上にデータを分散させ、パフォーマンスを向上させる。

■ 複数のドライブを適切に使用することで、どのドライブが故障してもデータの損
失やシステム ダウンタイムが発生しないようにする。

ディスク障害が発生した場合でも、ディスクには通常どおりアクセスし続けられ、そ
の障害はホスト システムに対して透過的です。
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論理ドライブ

論理ドライブは、独立した物理ドライブのアレイです。論理ドライブの作成により、
より優れた可用性、容量、およびパフォーマンスが実現されます。論理ドライブは、
ホストにとってローカル ハード ディスク ドライブと同様に認識されます。 

図 11-2 複数の物理ドライブを含む論理ドライブ

論理ボリューム

論理ボリュームは、複数の論理ドライブによって構成されます。論理ボリュームは、
SCSI では 大 32 のパーティションに、ファイバ チャネルでは 大 128 のパーティ
ションに分割できます。動作時にホストは、分割されていない論理ボリューム、つま
り論理ボリュームの 1 つのパーティションを単一の物理ドライブとして認識します。

ローカル スペア ドライブ

ローカル スペア ドライブは、１つの指定論理ドライブに割り当てられるスタンバイ 
ドライブです。この指定論理ドライブのメンバー ドライブが故障すると、ローカル 
スペア ドライブは自動的にメンバー ドライブとなりデータの再構築を始めます。

グローバル スペア ドライブ

グローバル スペア ドライブは、指定した 1 つの論理ドライブだけのスタンバイとし
て働くのではありません。任意の論理ドライブのメンバ ドライブが故障すると、グ
ローバル スペア ドライブはその論理ドライブのメンバとなり、自動的にデータの再
構築を始めます。
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SCSI チャネル

SCSI チャネル(SCSI バス)は、ワイド機能(16 ビット SCSI)が使用可能な場合、 大 15 
のデバイス(コントロール自身を除く)に接続できます。ファイバ チャネルを使用し、
ループあたり 大 125 のデバイスを接続できます。各デバイスは固有の SCSI ID を 1 
つ持っています。

図 A-1は、この概念を図式化したものです。たとえば文書をキャビネットに保管する
とき、いずれかの引出しに入れる必要があります。SCSI から見ると、SCSI ID は
キャビネットのようなもので、引出しが LUN (論理ユニット)に相当します。各 SCSI 
ID は 32 個の LUN を使用できます。データは SCSI ID の LUN の 1 つに保存できま
す。ほとんどの SCSI ホスト アダプタは LUN を別の SCSI デバイスのように扱いま
す。

図 A-1 SCSI ID/LUN

論理ドライブは、SCSI またはファイバのチャネル ドライブ グループから形成されま
す。同じ論理ドライブ内の物理ドライブが、同じ SCSI チャネルに接続されている必
要はありません。また、各論理ドライブを、異なる RAID レベルに構成することも可
能です。
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ドライブは、指定した論理ドライブに、ローカル スペア ドライブとして、あるいは
グローバル スペア ドライブとして割り当てることができます。データ冗長性を持た
ない論理ドライブ(RAID 0)には、スペアを使用できません。 

図 A-2 論理ドライブ構成内のドライブの割り当て
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論理ドライブまたは論理ボリュームを複数のパーティションに分割することや、論理
ドライブ全体を 1 つのパーティションとして使用することができます。

図 A-3 論理ドライブ構成内のパーティション

論理ドライブ 0

RAID 5 (8 GB)

論理ドライブ 1

RAID 3 (6 GB)

パーティション 0 2 GB

パーティション 1 1 GB

パーティション 2 5 GB

パーティション 0 2.5 GB

パーティション 1 1.5 GB

パーティション 2 2 GB
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各パーティションは、ホスト SCSI ID 下の LUN、またはホスト チャネル上の ID に
マップされます。各 SCSI ID/LUN は、ホスト コンピュータにとって 1 つの個別の
ハード ドライブとして機能します。

図 A-4 パーティションからホスト ID/LUN へのマッピング
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論理ドライブ 0
パーティション 2
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パーティション０
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図 A-5 パーティションを ID 下の LUN にマップする

RAID レベル
RAID アレイは、ミラーリング、ストライピング、複製化、およびパリティ技術の組
み合わせを使用した、さまざまな方法で導入できます。これらの異なるテクノロジ
は、RAID レベルと呼ばれます。各レベルでは、パフォーマンス、信頼性、およびコ
ストが異なります。各レベルでは、フォールト トレランスを導入するために異なる
アルゴリズムが使用されています。

RAID には、RAID 0、1、0+1、3、5、1+0 (10)、3+0 (30)、および 5+0 (50) の 8 つの
レベルがあります。このうち、RAID レベル 1、3、5 がもっとも一般的に使用されて
います。

次の表は、RAID レベルについて簡単にまとめたものです。 

表 A-1 RAID レベルの概要

RAID レベ
ル 説明

サポートされてい
るドライブ数 容量 冗長性

0 ストライピング 2-44 N No

1 ミラーリング 2 N/2 Yes

0+1 ミラーリングとス
トライピング

4 ～ 44 (偶数のみ) N/2 Yes

ID 0

LUN 0LUN 1LUN 2LUN 3LUN 4LUN 5

論理ドライブ 0 論理ドライブ 1

ホスト SCSI チャネル

論理ドライブ 1

論理ドライブ 1
パーティション０

論理ドライブ 0
パーティション 2

論理ドライブ 0
パーティション０

パーティション 1パーティション 1 パーティション 2

4.5 GB 5 GB 2 GB

1 GB 1.5 GB 2 GB
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容量とは、データ ストレージに使用できる物理ドライブの総数(N)です。たとえば、
容量 = N-1 で、論理ドライブ内のディスク ドライブの総数が 6 つ(36M バイトのドラ
イブ)である場合、ストレージに使用できるディスク空き容量は、ディスク ドライブ 
5 つ分(5 x 36MB (180M バイト))と等しくなります。この -1 は全 6 ドライブの内のス
トライピング量を示しています。これがデータの冗長性を確保し、サイズはディスク 
ドライブ 1 つ分と同じです。 

RAID 3+0 (30) と 5+0 (50) の容量は、ボリューム内の各論理ドライブに付き、物理ド
ライブの総数 (N)から 1 を引いたものです。たとえば、論理ドライブ内に 36M バイ
トあるディスク ドライブが合計 20 あり、論理ドライブの総数が 2 である場合、スト
レージに使用できるディスク空き容量は、ディスク ドライブ 18 個分(18 x 36MB 
(648M バイト))と等しくなります。

RAID 0 

RAID 0 では、データが論理ブロックに分割され、複数のドライブにストライピング
されるブロック ストライピングが導入されます。他の RAID レベルと異なり、冗長
性の機能はありません。ディスクに障害が発生したら、データは失われます。

ブロック ストライピングでは、ディスク容量の合計はアレイ内の全ドライブの総容
量と等しくなります。ドライブの組み合わせは、単一の論理ドライブとしてシステム
に表示されます。

RAID 0 は 高のパフォーマンスを提供します。これは、アレイ内のすべてのディス
ク間で同時にデータを転送できるからです。さらに、異なるドライブへ同時に読み書
きすることができます。

3 専用パリティを持
つストライピング

3-31 N -1 Yes

5 分散パリティ付き
ストライピング

3-31 N -1 Yes

1+0 (10) RAID 1 論理ドライ

ブのストライピング

2 ～ 8 の論理ドライブ N/2 Yes

3+0 (30) RAID 3 論理ドライ

ブのストライピング

2 ～ 8 の論理ドライブ N- 論理

ドライブ

の数

Yes

5+0 (50) RAID 5 論理ドライ

ブのストライピング

2 ～ 8 の論理ドライブ N- 論理

ドライブ
の数

Yes

表 A-1 RAID レベルの概要

RAID レベ
ル 説明

サポートされてい
るドライブ数 容量 冗長性
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図 A-6 RAID 0 構成

RAID 1 

RAID 1 では、同じデータが 2 つのドライブに記録されるディスク ミラーリングが導
入されます。別のディスクにデータのコピーを 2 つ保持することで、ディスク障害か
らデータを保護できます。RAID 1 アレイ内のディスクに障害が発生した場合、もう
一方の正常なディスク(コピー)が必要なすべてのデータを提供するので、ダウンタイ
ムを回避できます。

ディスク ミラーリングでは、使用可能な容量の合計は、RAID 1 アレイにおける 1 つ
のドライブの容量と等しくなります。したがって、たとえば 1G バイトのドライブを 
2 つを組み合わせた場合、使用可能な総容量が 1G バイトの単一の論理ドライブが形
成されます。ドライブの組み合わせは、単一の論理ドライブとしてシステムに表示さ
れます。

注 – RAID 1 は拡張できません。RAID レベル 3 および 5 では、既存のアレイにドラ
イブを追加することで拡張が可能です。

論理ドライブ（Logical drive）。

物理ディスク

ストライピング

ブロック 1

ブロック 2

ブロック 3

ブロック 5

ブロック 7

ブロック 1ブロック 3

ブロック 4

ブロック 5

ブロック 6

ブロック 7

ブロック８

ブロック 4

ブロック 6

ブロック８

ブロック 2
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図 A-7 RAID 1 構成

データ保護機能に加えて、この RAID レベル(RAID 1)はパフォーマンスも向上させま
す。複数の I/O が平行して発生した場合、これらの I/O をディスク コピー間に分散
することで、実際のデータ アクセス時間の合計を減少させます。

論理ドライブ（Logical drive）。

物理ディスク
ブロック 1

ブロック 2

ブロック 3

ブロック 4

ブロック 5

ブロック 6

ブロック 7

ブロック８

ブロック 2

ブロック 3

ブロック 4

ブロック 1

ブロック 2

ブロック 3

ブロック 4

ブロック 1

ミラーリング
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RAID 1(0+1)

RAID 1(0+1)は RAID 0 と RAID 1 の機能、つまりミラーリングとディスク ストライ
ピングを組み合わせたものです。RAID 1(0+1)を使用すると、1 ステップで多数の
ディスクのミラーリングを構成できるので、時間を節約できます。これはユーザが選
択できる標準の RAID レベル オプションではないので、コントローラによってサ
ポートされる RAID レベル オプションのリストには表示されません。選択するディ
スク数によって、RAID 1 と RAID 1(0+1)のどちらを使用するのかをコントローラが
自動的に決定します。2 つディスクを選択した場合は、RAID 1 論理ドライブが作成
されます。4 以上の偶数のディスクを選択すると、RAID 1(0+1)が作成されます。

図 A-8 RAID 1(0+1)構成

物理ディスク

ストライピング
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ストライピング
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RAID 3 

RAID 3 では専用パリティ付きブロック ストライピングが導入されます。この RAID 
レベルでは、データが論理ブロック(ディスク ブロックのサイズ)に分割され、さらに
これらのブロックが複数のドライブにストライピングされます。１つのドライブがパ
リティ専用になります。ディスクに障害が発生した場合、パリティ情報と残りのディ
スク上の情報を使用して元のデータを再構築できます。

RAID 3 では、ディスク容量の合計は、パリティ ドライブを除く組み合わせ内の全ド
ライブの総容量と等しくなります。したがって、たとえば 1G バイトのドライブ 4 つ
を組み合わせた場合、使用可能な総容量が 3G バイトである単一の論理ドライブが形
成されることになります。この組み合わせは、単一の論理ドライブとしてシステムに
表示されます。

RAID 3 では、データを小さなチャンクで読み込んだり、連続で読み込むと、データ
転送率が高くなります。ただし、すべてのドライブにスパンされない書き込み操作で
は、パフォーマンスが低下します。これは、新しいデータを書き込むたびに、パリ
ティ ドライブ内に保存された情報を再計算して再書き込みする必要があるからであ
り、I/O が同時に行われるのを制限します。

図 A-9 RAID 3 構成

論理ドライブ（Logical drive）。

ブロック 1

ブロック 2

ブロック 3

ブロック 1

ストライピング

パリティ (1.2)

パリティ (3.4)

物理ディスク

専用パリティ

ブロック 3

ブロック 4

ブロック 5

ブロック 6

ブロック 7

ブロック８

ブロック 7

ブロック 5

ブロック 4
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ブロック 6 パリティ (5.6)
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RAID 5 

RAID 5 では分散パリティ付きの複数ブロック ストライピングが導入されます。
この RAID レベルでは、アレイ内の全ディスクに分散したパリティ情報による冗
長性が提供されます。データとそのデータのパリティは、同じディスク上には保
存されません。ディスクに障害が発生した場合、パリティ情報と残りのディスク
上の情報を使用して元のデータを再構築できます。

図 A-10 RAID 5 構成

RAID 5 では、データに大きなチャンクでアクセスしたり、ランダムにアクセスした
場合、データ転送率が高くなり、同時に多数の I/O が行われる場合、データ アクセ
ス時間が減少します。

論理ドライブ（Logical drive）。 物理ディスク

ストライピング + 非専用パリティ

ブロック 1

ブロック 2

ブロック 3

ブロック 4

ブロック 5

ブロック 6

ブロック 7

ブロック８

ブロック 4

ブロック 1

ブロック 7

パリティ (5.6)

パリティ (3.4)

ブロック 2

ブロック８

ブロック 5

パリティ (3.4)

ブロック 3

ブロック 6

パリティ (7,8)
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高度な RAID レベル

次に示す高度な RAID レベルでは、アレイに内蔵されたボリューム マネージャを使
用する必要があります。これらの RAID レベルの組み合わせにより、RAID 1、3、ま
たは 5 による保護機能と RAID 1 によるパフォーマンスが提供されます。高度な 
RAID を使用するには、 初に RAID 1、3、または 5 アレイを複数作成して、次にそ
れらを組み合わせます。

RAID 1+0 (10)

アレイに内蔵されたボリューム マネージャを使用して組み合わせられた RAID 1 論
理ドライブ。 

RAID 3+0 (30)

アレイに内蔵されたボリューム マネージャを使用して組み合わせられた RAID 3 論
理ドライブ。 

RAID 5+0 (50)

アレイのボリューム マネージャを使用して組み合わせられた RAID 5 論理ドライブ。
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ローカル スペア ドライブとグローバル 
スペア ドライブ
外部 RAID コントローラは、ローカル スペア ドライブ機能とグローバル スペア ド
ライブ機能の双方を提供します。ローカル スペア ドライブは指定したドライブだけ
に使いますが、グローバル スペア ドライブはアレイ内のどの論理ドライブにも使用
できます。 

ローカル スペア ドライブは常にグローバル スペア ドライブより高い優先順位を持つ
ため、ドライブの故障時、両タイプのスペアが同時に利用可能な場合や、故障ドライ
ブ以上のサイズが必要な場合は、ローカル スペア ドライブが使用されます。

RAID 5 論理ドライブでドライブが故障した場合は、故障ドライブを新しいドライブ
と交換して論理ドライブの運用を継続します。故障ドライブの識別については、ご使
用のアレイの『Sun StorEdge 3000 Family RAID ファームウェア ユーザ ガイド』を
参照してください。

注意 – 故障ドライブを取り外そうとして誤ったドライブを取り外してしまうと、故
障ドライブ以外のドライブを故障させてしまうことになるため、その論理ドライブに
はアクセスできなくなります。

ローカル スペア ドライブは、１つの指定論理ドライブに割り当てられるスタンバイ 
ドライブです。この指定論理ドライブのメンバ ドライブが故障すると、ローカル ス
ペア ドライブは自動的にメンバ ドライブとなりデータの再構築を始めます。

ローカル スペア ドライブは常にグローバル スペア ドライブより高い優先順位を持ち
ます。すなわち、ドライブの故障時にローカル スペアとグローバル スペアの両方が
利用可能であると、ローカル スペア ドライブのほうが使われます。 

図 A-11 ローカル（専用）スペア

ローカル スペア 
ドライブ
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グローバル スペア ドライブは、1 つの指定論理ドライブだけでなく、すべての論理
ドライブから利用できます(図 A-12を参照)。任意の論理ドライブのメンバ ドライブ
が故障すると、グローバル スペア ドライブはその論理ドライブのメンバとなり、自
動的にデータの再構築を始めます。

ローカル スペア ドライブは常にグローバル スペア ドライブより高い優先順位を持ち
ます。すなわち、ドライブの故障時にローカル スペアとグローバル スペアの両方が
利用可能であると、ローカル スペア ドライブの方が使われます。 

図 A-12 グローバル スペア

論理ドライブ 0

グローバル スペア ドライブ

論理ドライブ 1 論理ドライブ 2

グローバル スペア ドライブ
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ローカル スペア ドライブとグローバル スペア ド
ライブ、双方の使用

図 A-13では、論理ドライブ 0 のメンバ ドライブは 9GB ドライブで、論理ドライブ 1 
および 2 のメンバ ドライブはすべて 4GB ドライブです。 

図 A-13 ローカル スペア ドライブとグローバル スペア ドライブの混在

ローカル スペア ドライブは常にグローバル スペア ドライブより高い優先順位を持ち
ます。すなわち、ドライブの故障時にローカル スペアとグローバル スペアの両方が
利用可能であると、ローカル スペア ドライブのほうが使われます。 

図 A-13 では、4GB グローバル スペア ドライブは容量不足のため論理ドライブ 0 の
メンバになることはできません。論理ドライブ 0 内のドライブが故障した場合には、
9GB のローカル スペア ドライブが故障ドライブの代わりに使われます。論理ドライ
ブ 1 または 2 内のドライブが故障した場合には、4GB グローバル スペア ドライブが
即時故障ドライブの代わりに使われます。

ローカル スペア ドライブ グローバル スペア ドライブ

(4GB)(9GB)

(9GB)

(9GB)

(4GB)

(4GB)

(4GB)

論理ドライブ 0 論理ドライブ 1 論理ドライブ 2

(9GB)
(4GB)

(4GB)(4GB)
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付録 B

JBOD の監視(SCSI のみ)

この付録では、Sun StorEdge 3310 SCSI アレイでスタンドアロンの JBOD を監視し、
そのファームウェアをダウンロードする方法を説明します。アレイのすべての機能が 
JBOD をサポートしているわけではありません。この付録には以下の手順が含まれま
す。

■ 219 ページの「JBOD サポートを有効にする」
■ 221 ページの「コンポーネントとアラームの機能を表示する」
■ 222 ページの「ハード ドライブのファームウェアをアップグレードする」
■ 223 ページの「SAF-TE デバイスのファームウェアをアップグレードする」
■ 224 ページの「故障ドライブを交換する」

▼ JBOD サポートを有効にする

周辺デバイスの状態と JBOD のイベント監視するには、JBOD サポートを有効にする
必要があります。 

1. View → Agent Options Management を選択します。 

Agent Options Management ウィンドウが表示されます。

2. Enable JBOD Support チェックボックスを選択します。

3. JBOD を Configuration Service メイン ウィンドウに表示するには、新しいインベン
トリを検出する必要があります。View → View Server を選択し、Probe をクリック
します。

4. OK をクリックします。 

Configuration Service メイン ウィンドウに JBOD が表示されます。

シングルバス構成では、下図に示すように、JBOD の両ポートがサーバ上の 1 つの 
HBA に接続されています。
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デュアルバス構成では、下図に示すように、各ポートが自身の HBA に接続されてい
ます。

注 – デュアルバス構成では、各ポートが異なるサーバに接続されている場合、
Configuration Service は、ポート B に接続されたサーバからのみ JBOD を監視でき
ます。
220  Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



▼コンポーネントとアラームの機能を表示する

View Enclosure ウィンドウには、JBOD のコンポーネントとアラームの機能が表示さ
れます。

1. EMU アイコン  を選択します。

2. View → View Enclosure を選択します。

FRU ID 情報を表示するには、View FRU をクリックします。
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デバイスのファームウェアのダウンロード
このオプションを使い、JBOD のハード ドライブと SAF-TE デバイスのファームウェ
アをアップグレードします。

▼ハード ドライブのファームウェアをアップグレード
する

1. 任意の JBOD コンポーネントを選択します。

2. Array Administration → Download FW for Devices を選択します。

3. Download FW for Disks タブをクリックします。

4. 新しいファームウェアのダウンロード先ドライブを Available Disks リストから選択
し、Add をクリックします。

削除する論理ドライブがある場合は、それらを Selected Disks リストから選択し、
Remove をクリックします。
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5. Browse をクリックし、ダウンロード ファームウェア ファイルを探します。その
ファイルを選択し、Open をクリックして OK をクリックします。

ファームウェアのダウンロードが開始されます。

6. 進行状況が 100% に達したら、OK をクリックします。

7. Configuration Service を更新するため、View → View Server を選択します。

8. Probe をクリックし、OK をクリックします。

9. ファームウェアが正しくダウンロードされたことを確認するには、View → View 
Physical Drive を選択し、Product Revision フィールドのファームウェア バージョン
が更新されたことを確認します。

▼ SAF-TE デバイスのファームウェアをアップグ
レードする

1. 任意の JBOD コンポーネントを選択します。

2. Array Administration → Download FW for Devices を選択します。

3. Download FW for SAFTE Devices タブをクリックします。

4. デバイスを追加するには、それを Available SAF-TE Devices リストから選択し、Add 
をクリックします。

デバイスを削除するには、それを Selected SAF-TE Devices リストから選択し、
Remove をクリックします。
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5. Browse をクリックし、ダウンロード ファームウェア ファイルを探します。その
ファイルを選択し、Open をクリックして OK をクリックします。 

ファームウェアのダウンロードが開始されます。

約 70% 完了すると、アレイがビープ音を発し、LED が点滅し始めます。

6. 進行状況が 100% に達したら、OK をクリックします。

7. Configuration Service を更新するため、View → View Server を選択し、Probe をク
リックします。

8. OK をクリックします。

9. ファームウェアが正しくダウンロードされたことを確認するには、View → View 
Enclosure を選択し、Firmware Rev フィールドのファームウェア バージョンが更新
されたことを確認します。

▼故障ドライブを交換する

ドライブの故障は、赤のステータス記号  で示されます。故障したドライブを交
換した後、以下の手順を実行してください。 
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Solaris 動作環境

1. ドライブが自動的にオンラインに戻った（つまり、赤のデバイス ステータス記号が
消えた）場合は、次のコマンドを実行します。

2. 次のコマンドを実行します。

3. ドライブが自動的にオンラインに戻らない（つまり、赤のデバイス ステータス記号
が消えない）場合は、次のコマンドを入力して、再構成リブートを実行します。

Microsoft Windows NT/2000 オペレーティング システム

1. 新しいドライブをインストールします。手順については、ご使用のアレイの『Sun 
StorEdge 3000 Family 導入・運用・サービス マニュアル』を参照してください。

2. View → View Server を選択し、Rescan をクリックします。

3. Configuration Service が新しいドライブを認識することを確認するため、そのドライ
ブを Configuration Service メイン ウィンドウで選択します。

4. View → View Physical Drive を選択し、情報を確認します。

# devfsadm

# format

# reboot -- -r
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付録 C

クラスタ構成の使用

Microsoft Windows NT を使用している場合、Configuration Service は共有 SCSI ス
トレージを監視できます。この付録には以下の項目が含まれます。

■ 227 ページの「クラスタ構成の計画」
■ 228 ページの「クラスタ構成の要件」
■ 228 ページの「クラスタ構成をセットアップする」

まず、適切なハードウェアでクラスタ構成をセットアップする必要があります。これ
には、Microsoft Windows NT Server、Enterprise Edition と Service Pack 3 または 
4、および Microsoft Cluster Server（MSCS）ソフトウェアが必要です。

クラスタ構成をセットアップする場合は、この付録を必ずお読みください。

クラスタ構成の計画
クラスタ構成の種類は Configuration Service で 初にストレージをどのように構成
するかに影響するため、クラスタ構成をセットアップする前に、その種類を決定する
必要があります。

クラスタ構成には主に次の 2 種類があります。 

■ ホット スタンバイ サーバ クラスタでは、すべての LUN がクラスタ内の 2 台の
サーバのどちらかに属します。LUN を所有するサーバが故障した場合、LUN 
は、その時点までアイドル状態であった第 2 サーバに移動されます。この構成に
は 小 2 つの LUN が必要です。

■ 負荷バランス クラスタでは、一部の LUN が 1 台のサーバで管理され、ほかの 
LUN がもう 1 台のサーバで管理されます。両方のサーバがデータを同時に処理し
ますが、それぞれ異なる LUN の I/O を処理します。 
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小 3 つの LUN を定義する必要があります。これにより、1 つの小さい LUN を定
足ディスク用に確立でき、より大きな LUN をクラスタ内の各サーバに使用できま
す。定足ディスクは、サーバに障害が発生した際にクラスタを回復するために必要な
クラスタ構成データを維持します。

クラスタ構成の要件
Microsoft Cluster Server ソフトウェアをインストールするとき、クラスタ情報を維
持する定足ディスクとして使用するディスクを確認してください。

クラスタ構成では、Configuration Service は一度に 1 台のサーバ（定足ディスクを持
つサーバ）でのみ実行できます。Configuration Service を実行しているサーバに障害
が発生した場合、Cluster Administrator によって第 1 サーバのディスク負荷が第 2 
サーバに自動的に移動され、そのサーバ上で Configuration Service のサービスが起
動されます。

2 台のサーバによるクラスタ構成では、クラスタ自身がその IP アドレスを使って 
Configuration Service の Managed Servers リストにある被管理サーバになります。ク
ラスタ セットアップ手順の 後のステップに示すように、クラスタを Managed 
Servers リストに追加して、Configuration Service で動作するようにします。

▼クラスタ構成をセットアップする

以下は、2 台のサーバによるクラスタ構成にアレイをセットアップするための概要手
順です。

1. サーバをセットアップします。

a. それぞれのサーバが PCI バスと、共有 SSI ストレージの一部ではないブート ディ
スクを備えた 2 台のサーバをセットアップします。

b. 各サーバに Ultra-Wide や差動ホスト アダプタなどのホスト アダプタ カードをイ
ンストールし、共有 SCSI バス上の各ホスト アダプタに固有 SI ID を設定しま
す。

c. 各サーバに 2 枚のネットワーク アダプタ カードをインストールします。

d. 各サーバのブート ディスクに、Microsoft Windows NT Server、Enterprise Edition 
ソフトウェアと Windows NT Service Pack 3 以降をインストールします。

2. デュアル アクティブ アクティブ ストレージ サブシステムをインストールし、これ
を両ホスト アダプタに接続します。 

インストール手順については、該当の説明書を参照してください。
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3. 各サーバに Configuration Service エージェントをインストールします。 

a. もう 1 台のサーバにConfiguration Service をインストール前に、Configuration 
Service を実行しているサーバ上でそのサービスを停止します。 

b. Configuration Service のサービスを実行しているサーバが、プライマリ コント
ローラに割り当てられた論理ドライブにマップされたホスト LUN にアクセスでき
ることを確認します。

c. エージェントのインストール手順は、インストールについての該当の章を参照し
てください。 

エージェントをインストールした後、リブートする必要はありません。ここで、
エージェントをインストールした後に、サーバ上の Configuration Service のサー
ビスを必ず停止してください。

注 – 次の 2～3 のステップでは、例として 1 台のサーバだけを対象とします。

4. Configuration Service コンソール ソフトウェアをインストールする。

Configuration Service コンソールは、サーバの 1 つ、またはサーバが常駐するネット
ワーク上の任意のコンピュータにインストールできます。Configuration Service を使
い、アレイをリモートで構成し、監視することができます。詳細手順は、インストー
ルについての該当の章を参照してください。

5. Configuration Service のサービスを起動したサーバを、Configuration Service コン
ソールの Managed Servers リストに追加します（「46 ページの「サーバを追加す
る」」を参照）。 

かならず Auto Discovery を選択し、ssmon パスワードを追加します。

6. Configuration Service コンソール ソフトウェアを使い、アクティブ サーバ上の 
Configuration Service ストレージを確認して構成し、そのサーバをリブートします。

デュアル アクティブ アクティブ ストレージ サブシステム上でストレージ アレイが
事前構成されている場合があります。構成済みであるかどうかは、Configuration 
Service のツリー表示で確認する必要があります。

ストレージが未構成の場合、または構成を変更する場合は、1 台のサーバ上のすべて
の LUN を構成してください。後で、Microsoft Cluster Server ソフトウェアのインス
トール後に、Cluster Administrator を使ってサーバ間のストレージを割り当てるこ
とができます。

7. NT Disk Administrator を使い、パーティションを作成して、アクティブ サーバ上の 
LUN をフォーマットします。 
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a. 必要であれば、ディスクのドライブ文字を再割り当てします。 

パーティションは NTFS でフォーマットする必要があります。

Microsoft Windows NT は、デュアル アクティブ アクティブ コントローラ上の 
LUN をクラスタ内の両方ののサーバ上にあるとみなします。パーティションと論
理ドライブは 1 台のサーバ上にのみ作成できます。あとで、MSCS のインストー
ル後に、Cluster Administrator を使って 2 台のサーバ間でストレージを分配する
ことができます。

2 台のサーバの共有 SCSI ストレージのドライブ文字は同じでなければなりませ
ん。一方のサーバに追加の CD-ROM ドライブや外部ハード ディスクがあるが、
もう一方にはない場合、共有ストレージのドライブ文字を再割り当てする必要が
あることもあります。このステップの後、他方のサーバをチェックして、ドライ
ブ文字が同じであることを確認します。

b. 共有ストレージに割り当てられたドライブ文字を書き留めます。

8. 第 2 サーバにアクセスします。 

a. Disk Administrator を起動し、第 2 サーバのドライブ文字が第 1 サーバと同じであ
ることを確認します。 

同じでない場合は、両サーバで同じになるようにドライブ文字を再割り当てしま
す。

9. 第 2 サーバをシャットダウンします。

10. 第 1 サーバに Microsoft Cluster Server ソフトウェアをインストールし、サーバをリ
ブートします。 

a. MSCS のインストール後、Cluster Administrator を起動し、クラスタを認識する
ことを確認します。

11. 第 2 サーバにアクセスし、第 1 サーバに結合することによりこのサーバに MSCS を
インストールしてから、リブートします。

a. 第 2 サーバに MSCS をインストールしたあと、第 2 サーバをリブートし、両方の
サーバがクラスタに含まれていることを Cluster Administrator で確認します。

12. Cluster Administrator でディスク グループを調節します。 

定数ディスクとその他のディスク（ある場合）が、 初に構成した第 1 サーバの下の 
1 つのディスク グループ内に一緒に含まれていることを確認します。この手順の詳細
は、Microsoft Cluster Service の説明書を参照してください。

注 – 2 つの LUN を同じディスク グループ内に入れた後、ディスク グループが 1 つ
空になり、これは削除できます。

13. 第 1 サーバ上の定足ディスクを持つグループに Configuration Service のサービスを
追加します。
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a. 両方のサーバで、Configuration Service の 3 つのサービス、Configuration Service 
Startup、Configuration Service Monitor、および Configuration Service Server を
停止し、それらを手動に設定します。

b. Cluster Administrator を使い、Configuration Service の各サービスを、定足ディス
クを持つグループへのリソースとしてインストールします。 

各サービスを以下に示す順序で入力しますが、その名前は指示どおりの形式（2 語
を連結）でタイプします。各サービスをインストールした後、サービスをオンラ
インにし、アクティブ サーバ上で起動します。

サービスを一般サービスとして入力します。各リソースの従属性を入力するよう
求められます。このグループの従属性は以下のとおりです。

■ 定足ディスクに関連付けられたディスク
■ その他のディスク（このグループに追加されたものがある場合）
■ Configuration ServiceStartup
■ Configuration ServiceMonitor
■ Configuration ServiceServer

Configuration ServiceStartup は、グループ内に既に存在する 2 つのディスクに従
属します。Configuration ServiceMonitor は Configuration Service Startup に従属
し、Configuration ServiceServer は Configuration Service Monitor に従属しま
す。

14. 2 台のクラスタ サーバを Configuration Service のクラスタ IP アドレスに 1 つのア
イコンとして表示するには、CLUSTER.TXT を編集します。

このファイルは、Configuration Service コンソールのファイルと同じ場所にありま
す。これは、コンピュータのシステム ディスクで、Configuration Service コンソー
ルがインストールされている場所にあります。ドライブ C がシステム ディスクの場
合、パスは次のようになります。

C:\Program Files\Sun\sscs
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以下のテキストは、このファイルの内容を示しています。

15. このファイルの最後の行を編集して、まずクラスタの IP アドレスを挿入し、次にク
ラスタを構成する 2 台のサーバの IP アドレスを挿入します。 

a. 先頭のシャープ記号(#)を削除します。

16. Configuration Service コンソールを起動して、第 1 サーバを Managed Servers リス
トから削除し、クラスタをサーバとしてこのリストに追加します。

a. Server List Setup 機能にアクセスします。46 ページの「サーバを追加する」を参
照してください。 

かならず Auto Discovery を選択し、ssmon パスワードを追加します。クラスタ名
を入力すると、ネットワークで DNS が使用可能な場合は Configuration Service 
によりその IP アドレスが提供されます。

これで、クラスタ構成が Configuration Service で動作するよう正しく設定されま
した。Configuration Service を実行しているサーバに障害が発生した場合、その
ディスク グループが第 2 サーバに移動され、Cluster Administrator によってその
サーバ上で Configuration Service のサービスが自動的に起動されます。

注 – 1 台のサーバが故障した場合、Configuration Service コンソールでのクラスタ 
アイコンが紫から灰色に変わるまでに 大 15 分かかることがあり、再び紫に戻るま
でにさらに 10 分かかる場合もあります。

片方のサーバ上にあるストレージの一部に負荷バランス構成を使用する場合は、
Cluster Administrator を使って、1 つまたは複数のディスク グループをもう一方
のサーバに移動する必要があります。

#Edit this file to map the NT cluster IP address to several
#servers constituting the cluster.
#The format of the entry is:
#<Cluster IP Address>=<server1 IP Address>:<server2 IP Address>
#The IP address must be in dot form.
#Example:If the cluster IP address is 151.239.130.70 and the
#IP addresses of individual servers are 151.239.130.71 and
#151.239.130.72,the entry would be:
# 151.239.130.70=151.239.130.71:151.239.130.72
#
#IMPORTANT NOTE:
#Use only the Cluster IP address to configure an NT cluster
#server on the Configuration Service console.
#
#151.239.130.70=151.239.130.71:151.239.130.72
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付録 D

ホストのワールド ワイド ネームの決定

この付録では、Solaris 動作環境および Microsoft Windows NT を実行するシステム
上でホストのワールド ワイド ネーム(WWN)を決定する方法について説明します。

▼ホストのワールド ワイド ネームを決定するには

LUN フィルタ機能を使用する前に、各 Sun StorEdge 3510 ファイバ チャネル アレイ
を接続する HBA カードと、各カードに割り当てる WWN を識別しておくと便利で
す。

Solaris 動作環境

1. ご使用のコンピュータに新しい HBA デバイスをインストールした場合は、コン
ピュータを再起動してください。

2. 次のコマンドを入力します。

3. 下方向に画面をスクロールして、ファイバ チャネル デバイスと関連する WWN を確
認します。

# luxadm probe
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Linux と Microsoft Windows NT/2000 

1. 特定のホストをブートし、BIOS のバージョンとホストに接続された HBA カード モ
デルを確認します。 

2. 適切なコマンド(一般には alt-q または control-a)を使用して、HBA カードの BIOS に
アクセスします。 

ホストに複数の HBA カードが存在する場合、ストレージに接続されているカードを
選択します。 

3. カードをスキャンして、そこに接続されているデバイスを検出します(通常はスキャ
ン ファイバ デバイスかファイバ ディスク ユーティリティを使用)。

このノード名(または同様のレベル)がワールド ワイド ネームです。

Qlogic カードの例を次に示します。

ID ベンダ  製品名
レベ
ル ノード名 ポート ID

0 Qlogic QLA22xx アダプタ B 210000E08B02DE2F 0000EF
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付録 E

電子メールと SNMP

Configuration Service はイベント完全監視機能と電子メール通知機能を備えていま
す。Configuration Service コンソールは、指定された電子メール アドレスのリスト
に SMTP 電子メール メッセージを送信できます。電子メール システムの中には、
Microsoft Exchange などのように、スクリプトで構成またはプログラムすることによ
り、イベントに応じて管理者を呼び出すことができるものがあります。呼び出しサー
ビスには、これらの電子メール メッセージをページャーに送信できるものもありま
す。

Configuration Service エージェントは、イベントを動作環境のエラー ログに記録し
ます。また、Configuration Service エージェントは、大容量ストレージ イベントに
ついての SNMP トラップを HP OpenView などのエンタープライズ管理コンソール
に送ることもできます。

この付録では、電子メール メッセージを送信できるように Configuration Service コ
ンソールをセットアップする方法を説明します。さらに、SNMP 管理コンソールへ
トラップを送信できるようにサーバを構成する方法、トラップ形式の説明、および 
SNMP に関する基本知識も提供しています。Configuration Service を必要とせずに 
SNMP トラップを送信する別の方法も説明されています。この章には以下の項目が
含まれます。

■ 236 ページの「各サーバに電子メール メッセージを送信する」
■ 238 ページの「トラップを送信するためのサーバのセットアップ」
■ 240 ページの「コミュニティ文字列をチェックする」
■ 242 ページの「トラップの受信者を指定する」
■ 244 ページの「Solaris 動作環境のサーバをセットアップするには」
■ 245 ページの「SNMP のメカニズム」
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▼各サーバに電子メール メッセージを送信する

各被管理サーバに電子メール メッセージを送信するようにコンソールを構成するに
は、Server List Setup 機能を使用します。

1. File → Server List Setup を選択します。 

Server Setup ウィンドウが表示されます。 

 

2. Add をクリックします。

サーバが既に追加されている場合は、それを Available Servers リストに移動して 
Edit をクリックします。

Add Server ウィンドウか、Edit Server ウィンドウが表示されます。この 2 つのウィ
ンドウに表示されるフィールドは同じです。
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3. サーバがまだ追加されていない場合は、Properties タブに情報を入力します。  

詳細は、47 ページの「サーバを追加します。」を参照してください。

4. 電子メールを使ってイベント メッセージを送信するには、Mailing Lists タブを選択
します。 

Add Server ウィンドウが開き、Mailing Lists が選択された状態で表示されます。

a. 各ユーザについて、Mail Address フィールドに電子メール アドレスを入力します。

b. Severity リストボックスで、リストをスクロールして希望の項目を選択します。

c. Add to List をクリックします。 

リストからユーザを削除するには、その電子メール アドレスを選択し、Delete 
from List をクリックします。

d. メール サーバを指定します。Setup Mail Server をクリックします。 

Mail Server Setup ウィンドウが表示されます。 
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前のステップで指定した宛先アドレスに電子メール メッセージを配信する簡易
メール転送プロトコル(SMTP)メール サーバの IP アドレスまたは名前を入力しま
す。

e. Mail Server ウィンドウでの情報の入力が完了したら、OK をクリックします。 

Add Server ウィンドウまたは Edit Server ウィンドウが表示されます。

5. Add Server または Edit Server ウィンドウでの情報の入力が完了したら、OK をク
リックします。 

Server Setup ウィンドウが表示されます。

6. さらにサーバを追加する場合は、各サーバについて、ステップ 2～5 を繰り返しま
す。

7. 必要であれば、このコンソールで管理するサーバを Managed Servers リストに移動
します。 

サーバを編集した場合は、それを Available Servers リストに戻す必要があります。

8. OK をクリックして Configuration Service メイン ウィンドウに戻ります。

トラップを送信するためのサーバのセッ
トアップ
ネットワーク上にエンタープライズ管理コンソール（たとえば、HP OpenView、
IBM NetView など）がある場合、イベントに関するトラップをコンソールに送るよ
うに Configuration Service サーバを設定できます。このセクションでは、必要な構
成手順について説明します。

注 – このセクションの手順は、Configuration Service で SNMP トラップをほかのエ
ンタープライズ管理コンソールに送信する場合にのみ必要です。

注意 – トラップを送信するためにセットアップしているものと同じサーバに HP 
OpenView がインストールされている場合、初期化時のエラーを防ぐため、システム 
リソースを再構成する必要があります。システム リソースを再構成する方法は、256 
ページの「症状:HP OpenView をインストールできない、またはトラップ デーモン
が起動しない。」のトラブルシューティング項目を参照してください。
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Microsoft Windows NT サーバ

SNMP トラップを 1 つまたは複数のエンタープライズ管理コンソールに送信するよ
うに Microsoft Windows NT サーバを構成するには、以下の動作が行われるように
サーバ上の各 SNMP サービスを設定する必要があります。

■ サーバが、エンタープライズ管理コンソールのコミュニティ文字列またはコミュ
ニティ名をリストに表示する。

■ サーバが、エンタープライズ管理コンソールを、Microsoft Windows NT エージェ
ント ソフトウェアからのトラップの受信者としてリストに表示する。
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▼コミュニティ文字列をチェックする

デフォルトのコミュニティ名またはコミュニティ文字列 public を使用することがで
きます。ただし、public 以外のコミュニティ名を選択すると、指定されたコミュニ
ティ文字列を持つコンピュータだけに通信が制限されるため、より高いセキュリティ
が得られます。

Microsoft Windows NT 4.0 のコミュニティ文字列を設定するには、以下の手順を実
行します。

1. Control Panel ウィンドウで Network アイコンをダブルクリックして、Services タブ
が選択されていなければ選択します。

Network Services リストで SNMP サービスまでスクロールし、これをクリックして
選択し、Properties をクリックします。 

Microsoft SNMP Properties ウィンドウが表示されます。

注 – SNMP サービスがインストールされていない場合、これをインストールするに
は Network ウィンドウで Add をクリックします。表示される Select Network 
Service ウィンドウから SNMP サービスを選択できます。コンピュータが必要なファ
イルを SNMP サービスからコピーできるように、Microsoft Windows NT 4.0 CD を
挿入する必要があります。

2. Microsoft SNMP Properties ウィンドウで Security タブをクリックし、Security 設定
を表示します。

3. サーバに使用するコミュニティ名またはコミュニティ文字列が、Accepted 
Community Names リスト内に指定されていることを確認します。

この名前がリストにない場合は、Add をクリックして Service Configuration ウィン
ドウを表示します。入力フィールドで新しい名前をタイプし、ウィンドウ内の Add 
をクリックします。Security タブが表示され、新しい名前が Accepted Community 
Names リスト内に表示されます。

注 – コミュニティ名またはコミュニティ文字列は大文字小文字を区別します。

4. (オプション)必要であれば、デフォルト設定の Accept SNMP Packets from Any Host 
(任意のホストから SNMP パケットを受け入れる)を Only Accept SNMP Packets 
from These Hosts (これらのホストからのみ SNMP パケットを受け入れる)に変更
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し、サーバ上の Configuration Service エージェントからトラップを受信するエン
タープライズ管理コンピュータのネットワーク アドレスを追加することができま
す。 

この設定を使用すると、Microsoft Windows NT エージェントが情報を受け入れる先
のコンピュータを指定できるため、より高いセキュリティが得られます。

Configuration Service 管理コンソール ソフトウェアがインストールされたコン
ピュータのネットワーク アドレスを下のリストに追加するには、Add をクリックし
て Security Configuration ウィンドウにアクセスします。Entry ボックスに IP アドレ
スを入力し、ウィンドウ内の Add をクリックします。Security タブが再度表示さ
れ、Configuration Service 管理コンソール コンピュータのアドレスが表示されま
す。

5. OK をクリックします。 
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▼トラップの受信者を指定する

この手順では、サーバからのトラップの受信者としてエンタープライズ管理コンソー
ルをリストします。

注 – 手順を実行するには、トラップを受信するエンタープライズ管理コンソールの 
IP アドレスが必要です。また、前のセクションで指定したものと同じコミュニティ
名が必要です。

エージェント トラップの受信者としてエンタープライズ管理コンソール コンピュー
タを指定するには、以下の手順を実行します。

1. Microsoft SNMP Properties ウィンドウで Traps タブをクリックし、Traps 設定を表
示します。 

2. 前の手順の Security タブで指定したコミュニティ名と同じコミュニティ名が指定さ
れていることを確認します。

コミュニティ名を修正する必要がある場合は、Community Name フィールドに名前
を入力して Add をクリックします。入力フィールドにすでに入っている名前は、上
書き入力をしたあとも保持されます。名前を削除するには、それを選択して Remove 
をクリックします。

3. エンタープライズ管理コンソールの IP アドレスを Trap Destinations リストに追加し
ます。

a. Add をクリックします。

Service Configuration ウィンドウが表示されます。 

b. Entry フィールドに IP アドレスを入力し、Add をクリックします。

Traps タブが表示され、新しいネットワーク アドレスが Trap Destinations リスト
に表示されます。

c. 次の形式で各 IP アドレスを入力します。AAA.BBB.CCC.DDD

先行のゼロをタイプする必要はありません。正しい形式のアドレスの例:
192.168.100.1

4. オプションの Configuration Service トラップを別のエンタープライズ管理コンソー
ルに送信する場合は、そのネットワーク管理ワークステーションのアドレスを入力し
ます。

複数のエンタープライズ管理コンソールがある場合、それぞれのアドレスをここで指
定する必要があります。

5. OK をクリックして、設定を確認します。

6. Close をクリックして、Network ウィンドウを閉じます。
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7. Microsoft Windows NT を終了し、サーバをリブートします。

Configuration Service をインストールする予定の場合は、ソフトウェアのインストー
ルが終了するまでリブートする必要はありません。
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▼ Solaris 動作環境のサーバをセットアップするに
は

Solaris 動作環境のシステムで使用する Configuration Service の場合、sstrapd とい
う SNTP トラップ デーモンへのインターフェイスを通して SNMP バージョン 1 ト
ラップを生成できます。デフォルトでは、このデーモンはブート プロセス中に自動
的には起動しません。トラップ処理を有効にするには、以下の手順を実行します。 

1. 標準のテキスト エディタを使い、ファイル 
/var/opt/SUNWsscs/ssagent/sstrapd.conf を作成します。

このファイルには、SNMP マネージャ コンソールの名前または IP アドレスが含まれ
ます。複数のコンソールがある場合は、それぞれを別の行に入力します。

2. ファイル /etc/init.d/ssagent を編集して、SNMP 関連のスタート セクション
から注釈記号を削除します。注釈行は、先頭に 2 重シャープ記号(##)が付いていま
す。

3. 編集後、ファイルを保存します。

sstrapd デーモンは次回のブートで起動します。または、次のコマンドを実行して
即時に起動できます。

これにより、sstrapd デーモンが起動し、ほかの 2 つの Configuration Service デー
モンが実行していなかった場合は、それらも起動します。以前にデーモンが実行され
ていたかどうかに関わらず、この時点では、各デーモンのインスタンスは 1 つだけ動
作しています。

/etc/init.d/ssagent uptrap
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▼ Linux 動作環境のサーバをセットアップするには

Linux 動作環境のシステムで使用する Configuration Service の場合、sstrapd とい
う SNTP トラップ デーモンへのインターフェイスを通して SNMP バージョン 1 ト
ラップを生成できます。デフォルトでは、このデーモンはブート プロセス中に自動
的には起動しません。トラップ処理を有効にするには、以下の手順を実行します。

1. 標準のテキスト エディタを使い、ファイル /var/opt/SUNWsscs/ssagent/sstrapd.conf 
を作成します。

このファイルを作成する場合は、SNMP マネージャ コンソールのシステム名または 
IP アドレス(各行に 1 つ)のどちらかを含める必要があります。このファイルには、空
白行とコメント行が含まれます。

2. ファイル /etc/init.d/ssagent を編集して、SNMP 関連のスタート セクションから注釈
記号を削除します。

注釈行は、先頭に 2 重シャープ記号(##)が付いています。

3. 編集後、ファイルを保存します。

sstrapd デーモンは次回のブートで起動します。または、次のコマンドを実行して
即時に起動できます。

これにより、sstrapd デーモンが起動し、ほかの 2 つの Configuration Service デー
モンが実行していなかった場合は、それらも起動します。以前にデーモンが実行され
ていたかどうかに関わらず、この時点では、各デーモンのインスタンスが 1 つだけ動
作しています。

SNMP のメカニズム
簡易ネットワーク管理プロトコル（SNMP）は、ネットワーク管理においてもっとも
広く使用されているプロトコルの 1 つです。その名前が示すとおり、ネットワーク 
デバイスを比較的単純な方法で管理します。SNMP は簡単で、無応答のコネクショ
ンレス プロトコルです。

SNMP は当初、インターネット プロトコルの総括、主に TCP/IP （伝送制御プロト
コル／インターネット プロトコル）転送プロトコルの下に働くように設計されまし
た。以来 SNMP は、ほかの一般的な転送プロトコル、たとえば、Novell の IPX/SPX
（Internet Packet Exchange/Sequenced Packet Exchange）などにも対応するように
導入されてきました。

/etc/init.d/ssagent uptrap
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SNMP トラップ メッセージ

Configuration Service エージェントは SNMP を使ってエンタープライズ管理システ
ムに情報を送信します。

トラップを送信するようにサーバを設定すると、Configuration Service のイベント情
報がそのシステムに流れ込むようになります。

Configuration Service のトラップ メッセージには次の情報が含まれています。

■ OID（オブジェクト識別子） 1.3.6.1.4.1.2294.1.2

■ Event Date （月月,日日,年年、たとえば 01,22,98）

■ Event Time （時時:分分:秒秒、たとえば 15:07:23）

■ Server Address and Name （IP アドレス名、たとえば 192.187.249.187 
Administration）

■ Card Name

■ Event Severity （Informational、Warning、Critical）

■ テキスト メッセージ

表示される情報とその形式は、使用している SNMP 管理コンソールによって異なり
ます。

トラップを受信するには、ファイル RST_OID.MIB をエンタープライズ管理コンソー
ルにロードする必要があります。Solaris および Linux 動作環境では、このファイル
は/opt/SUNWsscs/ssagent にあります。Microsoft Windows では、このファイル
は¥Program Files¥Sun¥ssagent にあります。

エージェントとマネージャ

SNMP ソフトウェア モデルは、エージェントとマネージャから成ります。エージェ
ントは、被管理デバイス内の変数を監視できるよう有効にするソフトウェアです。
エージェント ソフトウェアは、管理されるデバイス内に組み込まれているか、デバ
イスが接続されているコンピュータ上で実行されます。

マネージャまたは管理コンソールは、変数に関する要求を SNMP を使ってエージェ
ントに送信するネットワーク監視ソフトウェアです。変数の値は変化するので、マ
ネージャはエージェントを定期的にポーリングします。SNMP マネージャは通常、
エージェントから受け取ったデータを解析し、グラフィカル表示でユーザーに提示し
ます。データは、履歴やトレンド解析のためデータベースに保管できます。

SNMP マネージャの要求に応答することに加え、エージェントは非請求の通知また
はトランザクションラップを管理ステーションに送信することができます。これは、
通常のソフトウェアでの割り込みに似ています。
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管理コンソールでは、トラップに応答してさまざまな活動が行われます。通常、ト
ラップはログに記録され、ログ情報は通知スキームを介して対象のユーザーに転送さ
れます。また、トラップの発生により SNMP マネージャは、ネットワーク全体の現
在のステータスを調べるためエージェントにさらに照会要求を送る、またはアプリ
ケーションを起動するなど、その他の活動も開始します。

管理情報ベース （MIB）
ネットワーク上で、SNMP エージェントを備えた各デバイスが、それに関連付けら
れた 1 つまたは複数の変数またはオブジェクトを持っています。典型的な変数の例と
して、デバイスの名前を追跡する変数があります。これらの変数またはオブジェクト
は、Management Information Base (MIB)というテキスト ファイルの中で説明さ
れています。MIB は、管理される変数を正確にテキストで定義したものです。MIB 
の定義手順は、国際標準化機構（ISO）のインターネット エンジニアリング タスク 
フォース（IETF）により確立されています。

SNMP オブジェクト

ネットワーク管理の変数のいくつかは、すべての LAN ネットワーク デバイスに共通
です。これらの変数の多くは標準化され、MIB-II 変数および MIB-II 拡張と呼ばれて
います。IETF では、標準 MIB-II カテゴリに属さない MIB 用の手順も定義していま
す。これらの変数はプライベート企業 MIB にリストされています。

Configuration Service の変数は、プライベート企業 MIB 内で Configuration Service 
エントリとしてリストされています。たとえば、オブジェクト ID 1.3.6.1.4.1.2294.1.2 
は、Configuration Service の MIB の 1 つの下でエージェント バージョンを追跡する
ための変数のオブジェクト ID(OID)として定義されています。  

図 E-1は、OID がどのように派生するかを図示しています。チェックマークは OID 
内のノードを示します。MIB では、特定の変数またはオブジェクトのデータはその 
OID の下にあります。

Sun のツリー ノードは 2294 です。自身のデバイスを認識するエージェントの開発を
希望するプライベート企業は、固有のツリー ノードの取得を IETF に申請できます。

SNMP 要求タイプ

MIB データへのアクセスをサポートする SNMP 操作には、Get、GetNext、および 
Set があります。Get は、指定されたインデックス値で、テーブル エントリ フィー
ルド値からスカラ値を取り出します。GetNext を使い、テーブル エントリのインス
タンスをトラバースします。各コマンドは、次の対象の列(またはフィールド)内の値
を順次に返します。Set 操作は、MIB 変数の値の作成や変更に使用します。
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SNMP セキュリティ

変数を設定することによりセキュリティの問題が生じます。SNMP V1 (バージョン 1)
は単純なセキュリティ スキームを備えています。各プロトコル データ ユニット
（PDU）に、ユーザー名とパスワードの組み合わせのようなコミュニティ文字列が
含まれています。各エージェントを特定のコミュニティ文字列用に構成することがで
きます。エージェントは、要求 PDU 内のコミュニティ文字列が自身の構成内にある
コミュニティ文字列に一致しない限り、受け取った要求に対して応答しません。
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図 E-1 MIB 変数のオブジェクト識別子
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▼ Configuration Service を使用せずに SNMP ト
ラップを送信する

以下の手順は、Configuration Service を必要とせずに SNMP トラップを送信する別
の方法です。

アレイは、大容量ストレージ イベントについての SNMPトラップを HP OpenView 
などのエンタープライズ管理コンソールに送ることができます。以下の構成では、
SNMP トラップを送信するために Configuration Service エージェントがインストー
ルされている必要がありません。

1. テキスト エディタを開きます。

2. 使用しているネットワークに該当するように各変数値を置き換えて、次の情報をタイ
プします。

[SNMP_TRAP]
ENABLED=1
RECEIVER1=123.123.123.123

[EMAIL]
ENABLED=1
SUBJECT=RAID Event
SENDER_MAIL_BOX=someone@somecompany.com
SMTP_SERVER=123.123.123.123
RECEIVER1=somebody@somecompany.com

3. このファイルを agent.ini という名前で保存します。

4. ワークステーションからアレイに FTP を実行します。

5. ルートのユーザー名をタイプして Return キーを押します。

6. パスワードの入力を求められたら、Return キーを押します。

前にコントローラのパスワードを指定した場合は、ここでそのパスワードを入力する
必要があります。

7. ログインした後、/cfg ディレクトリにアクセスします。

8. このファイルをワークステーションから /cfg ディレクトリに入れます。

9. FTP セッションを終了します。

10. アレイの管理に使用している方法(Configuration Service Console、Telnet、端末セッ
ションなど)を使って、コントローラをリセットします。
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付録 F

トラブルシューティング

この付録では、以下の症状に関するトラブルシューティングの対応策を提供します。

■ 252 ページの「症状:Configuration Service のインストール時に、java -version に
対して 1.2.2 より前の Java Runtime Environment バージョンが出力されるが、マ
シンには既に Java Runtime Environment 1.2.2、1.3、または 1.4 がインストールさ
れている。」

■ 252 ページの「症状:サーバが応答しない、またはサーバがダウンしている可能性
がある。」

■ 253 ページの「症状:既存の論理ドライブから論理ボリュームを追加しようとする
ときに、論理ドライブがリストに表示されない。」

■ 254 ページの「症状:DHCP 環境でのサーバの IP アドレスが変更された。」

■ 254 ページの「症状:サーバからトラップを受信できない。」

■ 256 ページの「症状:HP OpenView をインストールできない、またはトラップ 
デーモンが起動しない。」

■ 257 ページの「症状:ハードウェアを追加または交換したときに、コンソールに変
更が表示されない。」

■ 257 ページの「症状:Solaris 動作環境でのシステムに LG が存在しない。」

■ 257 ページの「症状:環境アラームが報告されない。」

■ 258 ページの「症状:Configuration Service コンソールの動作が遅いように見え
る。」

■ 259 ページの「症状:Diagnostic Reporter が動作を停止した。」

■ 259 ページの「症状: (Solaris/Linux) オンライン ヘルプが表示されない。」
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症状:Configuration Service のインストール時に、java -version 
に対して 1.2.2 より前の Java Runtime Environment バージョンが
出力されるが、マシンには既に Java Runtime Environment 1.2.2、
1.3、または 1.4 がインストールされている。 

1. /usr ディレクトリをチェックして、Java から、Java 1.1 以外の最新バージョンの 
Java へのリンクがあることを確認します。

Java バージョンをチェックするには、次のように入力します。

(Solaris OE）リンクが上記の 新バージョンの Java へのリンクではない場合は、次
のように入力します。

ここで、xxx は Java の 新バージョンです。

症状:サーバが応答しない、またはサーバがダウンしている可能性
がある。

サーバ上で Configuration Service のサービスが実行していることを確認します。

1. （Solaris OE）次のコマンドを入力します。

ssmon と ssserver の両方の名前が表示されるはずです。表示されない場合はス
テップ 2 に進み、表示された場合はステップ 4 に進みます。

(Microsoft Windows NT) Settings → Control Panel → Services にアクセスし、
SUNWscsd Monitor、SUNWscsd Server、および SUNWscsd Startup のサービスが
起動していることを確認します。表示されない場合はステップ 2 に進み、表示された
場合はステップ 4 に進みます。

(Microsoft Windows 2000) Start → Administrative Services → Computer 
Management にアクセスします。Services & Applications をクリックし、
SUNWscsd Monitor、SUNWscsd Server、および SUNWscsd Startup のサービスが
起動していることを確認します。表示されない場合はステップ 2 に進み、表示された
場合はステップ 4 に進みます。

# cd /usr
ls | grep java

rm java
ln -s /usr/xxx /usr/java

# ps -e | grep ss
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2. (Solaris OE/Linux)デーモンを停止してから起動します。手順については、「15 ペー
ジの「Configuration Service エージェントを起動または停止する」」を参照してくだ
さい。

(Microsoft Windows NT/2000）必要なサービスを右クリックして選択し、サービス
を起動または停止します。

3. デーモン／サービスが正常に停止／起動しない場合は、再構成リブートを行います。

4. TCP/IP プロトコル ソフトウェアがロードされていることと、ネットワーク カードお
よびネットワーク接続が機能していることを確認します。

TCP/IP 接続性をテストするには、コマンド ラインで次のように入力します。

応答がない場合は、TCP/IP プロトコル サービスに問題があります。情報システム管
理部に連絡してください。

5. 指定されたサーバ名とパスワードが正しいことを確認します。

名前またはパスワードが正しくない場合は、そのエントリを編集して修正します。
Solaris OE については、「16 ページの「管理（ユーザー）セキュリティ レベルとガ
イドライン」」を参照してください。Windows Microsoft NT/2000 については、
「25 ページの「管理者（ユーザー）セキュリティ レベルとガイドライン」」を参照
してください。Linux OE については、「34 ページの「管理（ユーザー）セキュリ
ティ レベルとガイドライン」」を参照してください。

パスワードは、Configuration Service ユーザーのセットアップ手順で確立したもので
なければなりません。

■ Configuration Service ユーザー（ssmon、ssadmin、ssconfig）が正しくセッ
トアップされていることを確認します。Microsoft Windows NT の場合、ユーザが 
Act as a part of the operating system と Log on as a batch job でセットアップされ
ていることを確認します。

■ ネーム サービス（Windows NT ドメイン、および Solaris OE では NIS または 
NIS+）を使用している場合、ユーザーがネーム サービスに正しく追加されている
ことを確認します。

■ Microsoft Windows NT のドメインにユーザー名を入力した場合、ユーザー名が伝
播されるまでしばらく待ってください。

症状:既存の論理ドライブから論理ボリュームを追加しようとする
ときに、論理ドライブがリストに表示されない。

Select a Logical Drive の下に論理ドライブが表示されない場合、論理ドライブがマッ
プ解除されておらず、そのために選択できません。まず、論理ドライブをマップ解除
する必要があります。

# ping {サーバの IP アドレスまたはサーバ名}
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症状:DHCP 環境でのサーバの IP アドレスが変更された。

DHCP 環境では、サーバが 3 日より長くオフラインになっていた場合に、サーバの 
IP アドレスが変更されることがまれにあります。

この場合、Configuration Service コンソールはサーバの IP アドレスを介してサーバ
と通信するため、その新しい IP アドレスを通知される必要があります。

この状況に対処するには、サーバの新しい IP アドレスを Configuration Service 
Console ソフトウェアの Edit Server ウィンドウに入力します。

1. File → Server List Setup を選択します。

2. サーバ名を Managed Servers リストから Available Servers リストに移動します。

Edit Server ウィンドウが表示されます。このウィンドウには、サーバが構成された
ときのサーバ名と IP アドレスが表示されます。

3. Available Servers リストからサーバ名を選択し、Edit をクリックします。

Edit Server ウィンドウが表示されます。このウィンドウには、サーバが構成された
ときのサーバ名と IP アドレスが表示されます。

4. ネットワーク アドレスが変更されている場合は、Get IP Addr by Name をクリック
します。 

サーバの名前はネットワークで使用するネーム サービスによって記録されているた
め、サーバ名を入力すると、Configuration Service がその正しい IP アドレスを検索
して表示します。そうでなければ、IP アドレスを入力する必要があります。

サーバに使用する名前がサーバのネットワーク名と同じでない場合や、ネーム サー
ビスがまだ更新されていない場合は、IP アドレスを手動で入力する必要がありま
す。

5. サーバの IP アドレスを入力した後、OK をクリックして変更したアドレスを保存
し、Server List Setup ウィンドウに戻ります。

6. サーバ名を Managed Servers リストに戻します。

7. OK をクリックして、Server List Setup ウィンドウを終了します。

症状:サーバからトラップを受信できない。

Configuration Service サーバからのトラップを HP OpenView などの SNMP 管理
ワークステーションで受信できない場合のトラブルシューティングには、以下の手順
を指定してください。

1. サーバ上で SNMP サービスが起動していることを確認します。

次のコマンドを実行して、sstrapd が実行されていることを確認します。
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出力には、sstrapd の名前が含まれているはずです。含まれていない場合は、デー
モンの起動方法について、15 ページの「Configuration Service エージェントを起動
または停止する」を参照してください。

Microsoft Windows NT の場合は、Control Panel → Services にアクセスし、SNMP 
サービスがリストにあり、起動済みであると示されていることを確認します。動作し
ていない場合は、サービスを起動します。詳細は、Microsoft Windows NT の説明書
を参照してください。

2. エンタープライズ管理コンソールの正しいターゲット アドレスとコミュニティ文字
列がサーバ上で正しくセットアップされていることを確認します。

エンタープライズ管理コンソールにトラップを送信できるよう Microsoft Windows 
NT サーバをセットアップするための詳細手順は、238 ページの「トラップを送信す
るためのサーバのセットアップ」を参照してください。

3. Configuration Service MIB が SNMP 管理コンソールにロードされていることを確認
します。

Solaris OE および Linux OE では、RST_OID.MIB ファイルは 
/opt/SUNWsscs/ssagent にあります。Microsoft Windows では、このファイルは
\Program Files\Sun\ssagent にあります。MIB のロード方法については、使用
している SNMP 管理コンソール（HP OpenView など）の説明書を参照してくださ
い。

4. Microsoft Windows NT の場合、Configuration Service の NT レジストリ エントリを
チェックします。 

Configuration Service エントリがない場合は、Configuration Service エージェント
をサーバに再インストールします。

a. まず、

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SNMP\ 
Parameters\ExtensionAgents 

に、SSAGENT のエントリが含まれていることを確認します。

# ps -e | grep ss
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b. 次に、

HKEY_LOCAL_MACHINE\SOFTWARE\Sun\Sun StorEdge Configuration 
Service Agent\SNMP Extension Agent\Current Version

が、次の完全パス名で拡張エージェント プログラムを指していることを確認しま
す。 
C:\PROGRA~1\Sun\ssagent\SSAGENT.DLL

C:\PROGRA~1\Sun\ssagent\ がデフォルトのインストール ディレクトリです。
Configuration Service を他のディレクトリにインストールした場合、そのディレ
クトリをポイントするようにします。

c. 最後に、

SSAGENT.DLL 

は C:\PROGRA~1\Sun\ssagent ディレクトリにあります。

症状:HP OpenView をインストールできない、またはトラップ 
デーモンが起動しない。

SNMP トラップを送信するようにセットアップしたサーバと同じサーバに HP 
OpenView をインストールすると、トラップ デーモンと HP OpenView の両方を実
行するには十分なシステム リソースがありません。以下の手順で、システム リソー
スを再構成してください。

1. /etc/system の最後に次の行を追加します。.

2. サーバをリブートします。

set shmsys:shminfo_shmmax=x2000000
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=256
set shmsys:shminfo_shmseg=256

set semsys:seminfo_semmap=256
set semsys:seminfo_semmni-=512
set semsys:seminfo_semmns=512
set semsys:seminfo_semms1=32
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症状:ハードウェアを追加または交換したときに、コンソールに変
更が表示されない。

ディスク ドライブ、テープ ドライブ、電源、ファンなど、新しい装置を追加した
り、故障したデバイスを交換した場合、Configuration Service コンソールには必ずし
も更新された情報が表示されません。ツリー表示やほかの関連表示に、デバイス ス
テータスの変更が反映されないことがあります。

新しいデバイスを追加した後、次回の定期スキャンの前にそのデバイスが認識される
ようにするには、Server View ウィンドウで Rescan をクリックします。サーバが即
座にインベントリを再スキャンし、コンソールでは、そのサーバのインベントリが更
新され、変更がツリー表示に反映されます。インベントリを適時更新するには、手動
スキャンを実行してください。

Rescan を複数回クリックする必要があることがあります。サーバが再スキャンのプ
ロセスにあるときに、コンソールからインベントリの要求が送信された場合、サーバ
は、現行のスキャンを終了していないため、 後に更新されたインベントリをコン
ソールに送ることがあります。

症状:Solaris 動作環境でのシステムに LG が存在しない。

Configuration Service に LG が表示されない場合は、LG がラベル付けされていて、
Configuration Service から除外されていないことを確認します（インストールされて
いる場合）。

症状:環境アラームが報告されない。

SCSI ベースの格納装置監視機能（SAF-TE カードなど）を備えた格納装置は、
Configuration Service コンソールに環境アラームを送信します。アラーム状態は、ド
ライブ、ファン、電源、またまバッテリの故障、あるいは異常温度により発生しま
す。

環境アラームが発生した場合は、View Enclosure ウィンドウで Reset をクリックし
て、アラームをクリアする必要があります。ソフトウェアで Reset をクリックするに
は、構成セキュリティ特権を持っている必要があります。 

これらのストレージ格納装置の SAF-TE 監視仕様では、アラーム状態が発生した後、
そのアラームがリセットされない限り次のアラームを発生しないように要求されてい
ます。

アラームのリセット後、環境イベントが再び Event Log に表示されるようになりま
す。
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症状:Configuration Service コンソールの動作が遅いように見え
る。

Windows NT での Configuration Service コンソールは、コンソール ワークステー
ション上に少なくとも 10 メガバイトの空き仮想メモリ(物理メモリ＋ページ ファイ
ル サイズ)を必要とします。コンソール プログラムは、物理メモリが多いほど応答が
速くなります。その結果、オペレーティング システムによる、ページ ファイルへの
物理メモリからのメモリのページングが 小化されます。

メモリの使用量が、合計の使用可能仮想メモリ（物理メモリ＋ページ ファイル サイ
ズ）に達すると、過剰なページングにより問題が生じた結果、そのワークステーショ
ン上のすべてのアプリケーションのパフォーマンスが低下することがあります。

合計の仮想メモリを増やすため、物理メモリとページ ファイル サイズを増やしてく
ださい。ページ ファイル サイズを変更するには、Control Panel → System を選択
し、表示される System Properties ウィンドウで Performance タブを選択します。
Windows NT では、Performance タブの Virtual Memory セクションで、ページ 
ファイル サイズを変更します。 
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症状:Diagnostic Reporter が動作を停止した。

Diagnostic Reporter から電子メールを受け取らなくなった場合、Diagnostic 
Reporter が動作を停止した可能性があるため、停止してから再起動する必要があり
ます。

（Solaris OE）次の 3 つの場合に、Diagnostic Reporter が動作を停止し、その状態を
報告しなくなることがあります。対応策は、Diagnostic Reporter を停止して再起動
することです。

■ Configuration Service エージェントが異常停止した場合、または停止されて再起
動された場合、Diagnostic Reporter が動作を停止する。

■ Diagnostic Reporter Config Tool が実行中のときに Diagnostic Reporter デーモン
が停止され再起動された場合、Diagnostic Reporter Config Tool がこのデーモンと
通信不能になることがある。

■ Configuration Service エージェントが異常停止した場合、または停止された場
合、Diagnostic Reporter デーモンがこれを検出せず、電子メールの送信を停止し
たが、Diagnostic Reporter が接続状態にあると緑のステータス記号で示されてい
る。

次のように入力して、Diagnostic Reporter を停止し、再起動してください。

症状: (Solaris/Linux) オンライン ヘルプが表示されない。

オンライン ヘルプの表示に使用する Web ブラウザの絶対パス名が指定されているか
どうか確認します。

1. /opt/SUNWsscs/sscsconsole から 

2. Web ブラウザの絶対パス名を入力します。

# /etc/init.d/ssdgrptd stop 
# /etc/init.d ssdgrptd start

./config_sscon と入力します。
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付録 G

エラー コードとメッセージ

この付録は、エラー コードの一覧と、エラーおよびステータス メッセージ一の覧です。

エラー コード
Event Log （イベント ログ）に説明と共に示されるエラー コードは、各 2 文字の 4 
つのフィールドで構成される 8 文字のコードです。以下の表は、2 文字の各フィール
ドで使用されるエラー コードを説明しています。4 つの 2 文字フィールドの形式は次
のとおりです。

SSMMmmEE

ここで

SS = Severity （重要度）フィールド

MM = Major （メジャー）フィールド

mm = Minor （マイナー）フィールド

EE = Error （エラー）フィールド

表 G-1 Severity フィールド

Severity フィールド 説明

01 Critical

01 クリティカル

02 Warning

02 警告

03 Informational

03 情報
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表 G-2 Major フィールド

Major フィールド 説明

01 Not Used

01 未使用

03 Legacy

03 レガシー

04 RAIDCard Card message

04 RAIDCard カード メッセージ

05 JBOD (Just a bunch of disks) message

05 JBOD （多数のディスクだけ）メッセージ

06 SSMon monitor message

06 SSMon 監視メッセージ

07 dll/shared library message

07 dll／共有ライブラリ メッセージ

08 SSserver message

08 SSserver メッセージ

09 HBA (Host Bus Adapter) message

09 HBA （ホスト バス アダプタ）メッセージ

0A Server Communications message

0A サーバ通信メッセージ

0B Sun StorEdge controller message

0B Sun StorEdge コントローラ メッセージ
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Minor フィールドの定義を下表に示します。Error フィールドの定義が Minor フィー
ルドの定義によって異なるものがあり、その場合は参照先の表が示されています。

表 G-3 Minor フィールド

Minor 
フィール
ド 説明

01 Unknown

01 不明

02 264 ページの「Error フィールド:システム ドライブ状態」を参照してください。

03 265 ページの「Error フィールド:ディスク状態」を参照してください。

04 266 ページの「Error フィールド:SAF-TE 状態」を参照してください。

05 267 ページの「Error フィールド:テープ状態」を参照してください。

06 269 ページの「Error フィールド:冗長状態」を参照してください。

07 270 ページの「Error フィールド:内部状態」を参照してください。

08 270 ページの「Error フィールド:デバイス状態」を参照してください。

09 270 ページの「Error フィールド:初期化状態」を参照してください。 

0A 271 ページの「Error フィールド:無効なクライアント パラメータ」を参照して
ください。

0B 272 ページの「Error フィールド:伝送オープン」を参照してください。

0C 272 ページの「Error フィールド:伝送クローズ」を参照してください。

0D 272 ページの「Error フィールド:メモリ割り振り」を参照してください。

0E RaidCard fault detected.

0E RaidCard フォールトを検出  

0F 273 ページの「Error フィールド:伝送」を参照してください。

10 274 ページの「Error フィールド:コマンド」を参照してください。

11 274 ページの「Error フィールド:コマンド」を参照してください。

12 274 ページの「Error フィールド:メイン通信」を参照してください。

13 275 ページの「Error フィールド:通信非同期」を参照してください。

14 275 ページの「Error フィールド:通信セキュリティ」を参照してください。

15 275 ページの「Error フィールド:タイムアウト」を参照してください。

16 276 ページの「Error フィールド:管理」を参照してください。

17 277 ページの「Error フィールド:ファームウェア」を参照してください。

18 277 ページの「Error フィールド:システム シャットダウン」を参照してください。
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Error フィールド:システム ドライブ状態

19 Dynamic Growth fault detected. 

19 動的成長フォールトを検出 

1C 278 ページの「Error フィールド: Sun StorEdge Set Config」を参照してください。

1D 279 ページの「Error フィールド:Sun StorEdge コントローラ イベント」を参
照してください。

1E 280 ページの「Error フィールド:Sun StorEdge ドライブ側イベント」を参照し
てください。

1F 281 ページの「Error フィールド:Sun StorEdge ホスト側イベント」を参照して
ください。

20 282 ページの「Error フィールド:Sun StorEdge 論理ドライブ イベント」を参
照してください。

23 282 ページの「サーバのイベント管理／監視エラー」を参照してください。

表 G-4 システム ドライブ状態エラー

Error フィールド

01 Offline

01 オフライン

02 Degraded

02 低下

03 Online

03 オンライン

04 Unknown

04 不明

05 Parity Check

05 パリティ チェック

06 Reconstruction

06 再構築

07 Reconfiguration

表 G-3 Minor フィールド (続き)

Minor 
フィール
ド 説明
264  Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



Error フィールド:ディスク状態

07 再構成

08 Dynamic Growth

08 動的成長

09 Nonexistent

09 存在しない

0A Initialization

0A 初期化

表 G-5 ディスク状態エラー

Error フィールド 説明

01 Offline

01 オフライン

02 Degraded

02 低下

03 Online

03 オンライン

04 Unknown

04 不明

05 SMART

05 SMART

06 Dead

06 デッド

表 G-4 システム ドライブ状態エラー (続き)

Error フィールド
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Error フィールド:SAF-TE 状態 

表 G-6 SAF-TE 状態エラー

Error フィールド 説明

01 Power

01 電源

02 Fan

02 ファン

03 Thermal

03 熱

04 Alarm

04 アラーム

05 Locked

05 ロック状態

06 Slot

06 Slot

07 Unknown

07 不明

08 Unable to get SAF-TE information

08 SAF-TE 情報を取得できない

09 Battery 

09 バッテリ

0A Invalid Number of Slots

0A 無効なスロット数

0B Environmental Data Not Available

0B 環境データ使用不能
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Error フィールド:テープ状態

表 G-7 テープ状態エラー

Error フィールド 説明

01 Read

01 読み取り

02 Write

02 書き込み

03 Hard Error

03 ハード エラー

04 Media Error

04 メディア エラー

05 Read Failure

05 読み取り失敗

06 Write Failure

06 書き込み失敗

07 Media Life

07 メディア寿命

08 Not Upgradable

08 アップグレード不能

09 Write Protect

09 書き込み禁止

0A Nonremoval

0A 取り外し不能

0B Cleaning Media

0B クリーニング メディア

0C Unsupported Format

0C サポートされない形式

0D Snapped Tape

0D 切れたテープ

14 Clean Now

14 今クリーニングする
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15 Clean Periodic

15 定期クリーニングする

16 Expired Cleaning Media

16 期限切れクリーニング メディア

1E Hardware A

1E ハードウェア A

1F Hardware B

1F ハードウェア B

20 Interface

20 インターフェイス

21 Eject Media

21 メディアをイジェクトする

22 Down Load Fail

22 ダウンロード失敗

28 Loader Hardware A

28 ローダ ハードウェア A

29 Loader Tray Tape

29 ローダ トレイ テープ

2A Loader Hardware B

2A ローダ ハードウェア B

2B Loader Door

2B ローダ ドア

C8 Query Log Failed

C8 ログ照会の失敗

C9 Inquire Tape Failed

C9 テープ問い合わせの失敗

表 G-7 テープ状態エラー (続き)

Error フィールド 説明
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Error フィールド:冗長状態

表 G-8 冗長状態エラー

Error フィールド 説明

01 Mode OK

01 モード OK

02 No Memory for Negotiation

02 ネゴシエーション用メモリなし

03 Secondary Failure

03 セカンダリ故障

04 Secondary Removed

04 セカンダリを取り外した

05 Detected Removal of Secondary

05 セカンダリの取り外しを検出

06 Detected Insertion of Secondary

06 セカンダリの挿入を検出

07 Primary Failure

07 プライマリ故障

08 Primary Removed

08 プライマリを取り外した

09 Detected Removal of Primary

09 プライマリの取り外しを検出

0A Detected Insertion of Primary

0A プライマリの挿入を検出

0B Unknown State

0B 不明な状態

0C Partner Failed

0C パートナー故障

0D Partner Inserted

0D パートナーを挿入した

0E Partner Removed

0E パートナーを取り外した
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Error フィールド:内部状態 

Error フィールド:デバイス状態

Error フィールド:初期化状態

表 G-9 内部状態エラー

Error フィールド 説明

01 No Memory

01 メモリなし

02 Semaphore

02 セマフォー

03 Thread

03 スレッド

04 No Devices

04 デバイスなし

表 G-10 デバイス状態エラー

Error フィールド 説明

01 Inquiry

01 問い合わせ

02 Unknown

02 不明

表 G-11 初期化状態エラー

Error フィールド 説明

01 dll Initializing

01 dll 初期化中

02 dll Initializing Failed

02 dll 初期化の失敗
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Error フィールド:無効なクライアント パラメータ

表 G-12 クライアント パラメータ エラー

Error フィールド 説明

01 Set Configuration - Configuration Miscompare

01 構成の設定 － 構成の比較誤り

02 Set Configuration - Configuration Device Invalid

02 構成の設定 － 構成デバイスが無効

03 Set Configuration - Enquire Miscompare

03 構成の設定 － Enquire 比較誤り

04 Set Configuration - Enquire2 Miscompare

04 構成の設定 － Enquire2 比較誤り

05 Incorrect Application Length

05 アプリケーションの長さが不正

06 Command not Supported

06 サポートされないコマンド

07 Invalid Command

07 無効なコマンド

08 Set Configuration - General Miscompare

08 構成の設定 － 一般の比較誤り

09 Invalid Length

09 無効な長さ

0A Invalid Card Identifier

0A 無効なカード識別子

0B Invalid Card Name

0B 無効なカード名

0C Invalid Parameter

0C 無効なパラメータ

0D Invalid Command for Card Type

0D カード タイプに対してコマンドが無効

0E Set Configuration - Invalid Additional Parameter 

0E 構成の設定 － 無効な追加パラメータ
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Error フィールド:伝送オープン

Error フィールド:伝送クローズ

Error フィールド:メモリ割り振り

0F Set Configuration - Block Overlap

0F 構成の設定 － ブロックのオーバーラップ

10 Set Configuration - Device Information Invalid

10 構成の設定 － デバイス情報が無効

表 G-13 伝送オープン エラー

Error フィールド 説明

01 Open Transport

01 伝送オープン

表 G-14 伝送クローズ エラー

Error フィールド 説明

01 Close Transport

01 伝送クローズ

表 G-15 メモリ割り振りエラー

Error フィールド 説明

01 Insufficient Memory

01 メモリ不足

02 Insufficient Memory for Administration Operation

02 管理操作のメモリが不足

表 G-12 クライアント パラメータ エラー (続き)

Error フィールド 説明
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Error フィールド:伝送

表 G-16 伝送フィールド エラー

Error フィールド 説明

01 Lock Fault

01 ロック フォールト

02 Insufficient Memory

02 メモリ不足

03 Acquire Lock Fault

03 ロック取得フォールト

04 Release Lock Fault

04 ロック解放フォールト

05 Invalid Command

05 無効なコマンド

06 Invalid Length

06 無効な長さ

07 Invalid Card Name

07 無効なカード名

08 Invalid Card Identification

08 無効なカード識別子

09 No Cards Found

09 カードが見つからない

0A No Devices Found

0A デバイスが見つからない

0B Open Fault

0B オープン フォールト

0C Card Name not Found

0C カード名が見つからない
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Error フィールド:コマンド

Error フィールド:メイン通信

Error フィールド:通信リンク

表 G-17 コマンド コード エラー

Error フィールド 説明

01 Lock Fault

01 ロック フォールト

表 G-18 メイン通信エラー

Error フィールド 説明

01 Socket Fault

01 ソケット フォールト

02 Report Fault

02 レポート フォールト

03 Thread Fault

03 スレッド フォールト

04 Lock Fault

04 ロック フォールト

05 System Fault

05 システム フォールト

表 G-19 通信リンク

Error フィールド 説明

01 Socket Fault

01 ソケット フォールト
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Error フィールド:通信非同期

Error フィールド:通信セキュリティ

Error フィールド:タイムアウト

表 G-20 通信非同期

Error フィールド 説明

01 Socket Fault

01 ソケット フォールト

02 Thread Fault

02 スレッド フォールト

03 Cold Link Fault

03 コールド リンク フォールト

04 Send Event Fault

04 イベント送信フォールト

表 G-21 通信セキュリティ

Error フィールド 説明

01 Security Violation

01 セキュリティ違反

表 G-22 タイムアウト エラー

Error フィールド 説明

01 Configuration Update

01 構成更新

02 Lock Timeout

02 ロック タイムアウト
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Error フィールド:管理

表 G-23 管理エラー

Error フィールド 説明

01 Set Customer Name Fault

01 顧客名の設定フォールト

02 Set Configuration Ended

02 構成の設定終了

03 Initialize

03 初期化

04 Initialize Ended

04 初期化終了

05 Rebuild

05 再構築

06 Rebuild Ended

06 再構築終了

07 Parity Check

07 パリティ チェック

08 Parity Check Ended

08 パリティ チェック終了

09 Set SAF-TE Slot State

09 SAF-TE スロット状態の設定

0A Set SAF-TE Perform Slot

0A SAF-TE 実行スロットの設定

0B Set SAF-TE Send Global

0B SAF-TE グローバル送信の設定

0E Schedule Parity Check

0E パリティ チェックのスケジュール

0F Schedule Parity Check Ended

0F パリティ チェックのスケジュール終了

10 Set Controller Parameters

10 コントローラ パラメータの設定
276  Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



Error フィールド:ファームウェア

Error フィールド:システム シャットダウン

11 Firmware Download

11 ファームウェア ダウンロード

12 Consistency Check for Rebuild Ended

12 再構築の整合性検査終了

表 G-24 ファームウェア ダウンロード エラー

Error フィールド 説明

01 Not a SAF-TE Device

01 SAF-TE デバイスではない

02 Invalid Data Length

02 無効なデータ長

03 Download Failed

03 ダウンロード失敗

04 Check Sum Failed

04 チェックサム失敗

表 G-25 システム シャットダウン エラー

Error フィールド 説明

01 System Shutdown Failed

01 システム シャットダウン失敗

表 G-23 管理エラー (続き)

Error フィールド 説明
付録 G エラー コードとメッセージ 277



Error フィールド:RDP パス変更

Error フィールド: Sun StorEdge Set Config

表 G-26 RDP パス変更エラー

Error フィールド 説明

01 RDP Path Failed

01 RDP パス失敗

02 RDP Path Restored

02 RDP パス回復

表 G-27 Sun StorEdge Set Config エラー

Error フィールド 説明

01 Set Configuration Thread creation Failed

01 構成設定のスレッド作成に失敗

02 Get Logical Drive List Command Failed

02 論理ドライブ リストの取得コマンドに失敗

03 Create Config Command Failed

03 構成の作成 コマンドに失敗

04 Init Completion Status Command Failed

04 初期化完了状態コマンドに失敗

05 Get Configuration Command Failed

05 構成の取得コマンドに失敗

06 Change Volume Config Command Failed

06 ボリューム構成の変更コマンドに失敗

07 Delete Logical Drive Command Failed

07 論理ドライブの削除コマンドに失敗
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Error フィールド:Sun StorEdge コントローラ イベント

表 G-28 Sun StorEdge コントローラ イベント エラー

Error フィールド 説明

01 Controller Reset

01 コントローラ リセット

02 Controller DRAM Parity Error

02 コントローラ DRAM パリティ エラー

03 Redundant Controller Failed

03 冗長コントローラ故障

04 Controller Power Supply Failed

04 コントローラ電源故障

05 Controller Fan Failed

05 コントローラ ファン故障

06 Controller Temperature Alert

06 コントローラ温度アラート

07 Controller UPS AC Power Loss

07 コントローラ UPS AC 電源喪失

08 Controller Initialization Complete

08 コントローラ初期化完了

09 Controller Power Supply Back Online

09 コントローラ電源がオンラインに回復

0A Controller Fan Back Online

0A コントローラ ファンがオンラインに回復

0B Controller Temperature Normal

0B コントローラ温度正常

DB Controller UPS AC Power Back On

0C コントローラ UPS AC 電源が回復
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Error フィールド:Sun StorEdge ドライブ側イベント

表 G-29 Sun StorEdge ドライブ側イベント エラー

Error フィールド 説明

01 Drive Channel Select Timeout

01 ドライブ チャネルの選択タイムアウト

02 Drive Channel SCSI Bus Error

02 ドライブ チャネルの SCSI バス エラー

03 Drive Channel Unexpected Disconnect

03 ドライブ チャネルの予期しない切断

04 Drive Channel Negotiation Error

04 ドライブ チャネルのネゴシエーション エラー

05 Drive Channel Target Timed Out

05 ドライブ チャネルのターゲット タイムアウト

06 Drive Channel Parity Error

06 ドライブ チャネルのパリティ エラー

07 Drive Channel Data Under Or Overrun

07 ドライブ チャネルのデータ アンダーランまたはオーバーラン

08 Drive Channel Undefined Error

08 ドライブ チャネルの未定義エラー

09 Drive Channel SCSI Bus Reset Issued

09 ドライブ チャネルの SCSI バス リセット発行

0A Drive Channel Not Ready Error

0A ドライブ チャネルの準備未完了エラー

0B Drive Channel Target HW Error

0B ドライブ チャネルのターゲット HW エラー

0C Drive Channel Target Media Error

0C ドライブ チャネルのターゲット メディア エラー

0D Drive Channel Unexpected Unit Attention

0D ドライブ チャネルの予期しないユニット呼び出し

0E Drive Channel Unexpected Sense Data

0E ドライブ チャネルの予期しないセンス データ
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Error フィールド:Sun StorEdge ホスト側イベント

0F Drive Channel Block Reassign Fail

0F ドライブ チャネルのブロック再割り当て失敗

10 Drive Channel Block Reassign Success

10 ドライブ チャネルのブロック再割り当て成功

11 Drive Channel SCSI Aborted Command

11 ドライブ チャネル SCSI 中止コマンド

12 Drive Channel SCSI Channel Fail

12 ドライブ チャネルの SCSI チャネル障害

表 G-30 Sun StorEdge ホスト側イベント

Error フィールド 説明

01 Host Channel SCSI Bus Reset

01 ホスト チャネルの SCSI バス リセット

02 Host Channel SCSI Bus Device Reset

02 ホスト チャネルの SCSI バス デバイス リセット

03 Host Channel Abort Tag Message

03 ホスト チャネルのタグ中止メッセージ

04 Host Channel Parity Error

04 ホスト チャネルのパリティ エラー

05 Host Channel Reselect Timeout

05 ホスト チャネルの再選択タイムアウト

表 G-29 Sun StorEdge ドライブ側イベント エラー (続き)

Error フィールド 説明
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Error フィールド:Sun StorEdge 論理ドライブ イベント

サーバのイベント管理／監視エラー

表 G-31 Sun StorEdge 論理ドライブ イベント エラー

Error フィールド 説明

01 Logical Drive SCSI Drive Fail

01 論理ドライブの SCSI ドライブ故障

02 Logical Drive Initialization Fail

02 論理ドライブの初期化失敗

03 Logical Drive Rebuild Fail

03 論理ドライブの再構築失敗

04 Logical Drive Initialization Commenced

04 論理ドライブの初期化開始

05 Logical Drive Initialization Completed

05 論理ドライブの初期化完了

06 Logical Drive Rebuild Commenced

06 論理ドライブの再構築開始

07 Logical Drive Rebuild Completed

07 論理ドライブの再構築完了

表 G-32 サーバのイベント管理／監視エラー

Error フィールド 説明

01 Server to Manage/Monitor has Sun StorEdge changed.

01 管理／監視用サーバの Sun StorEdge アレイが変更された。
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エラー メッセージとステータ スメッ
セージ    
エラー メッセージとステータス メッセージのほとんどは説明を必要としません。表 
G-33は、メッセージに使用されている用語をまとめたものです。表 G-34では、エ
ラー メッセージとステータス メッセージをリストしています。 

表 G-33 置換値 (１ / ２)

値 説明

Channel Card channel number indicating a SCSI channel. A value of 1 
indicates the first channel.

チャネル SCSI チャネルを示すカード チャネル番号。値 1 は、第 1 チャネル
を表す。

Fan Fan number.

ファン ファン番号

Enclosure Enclosure number.

格納装置 格納装置番号

LogicalArray Logical array number.

LogicalArray 論理アレイ番号

LogicalDrive Logical Drive number.

LogicalDrive 論理ドライブ番号

Lun LUN number.

Lun LUN 番号

Name A text name.

Name テキスト名

Power Power supply number.

電源 電源番号

Slot Slot number.

Slot スロット番号

State State of a logical array or a device or an enclosure in text. The 
values are: Critical, Online, Offline, Critical Rebuild, Non Existent, 
Low Battery, Normal
付録 G エラー コードとメッセージ 283



状態 論理アレイ、デバイス、または格納装置の状態（テキスト形式）。
値は次のとおりです。Critical、Online、Offline、Critical 
Rebuild、Non Existent、Low Battery、Normal。

Target A target or SCSI ID number. 

ターゲット ターゲットまたは SCSI ID 番号 

Temperature The temperature in centigrade.

温度 摂氏温度

表 G-34  エラー／ステータス メッセージ

エラー メッセージとステータス メッセージ

A tape has been left in the autoloader by a previous hardware fault. Insert an empty 
magazine to clear the fault. If the fault does not clear, turn the autoloader off and then on 
again. If the problem persists, call the tape drive supplier helpline.

前のハードウェア フォールトにより、自動ローダ内にテープが残されています。空のマガジ
ンを挿入して、フォールトをクリアしてください。フォールトがクリアされない場合は、自
動ローダーをオフにしてからオンにします。問題が解決しない場合は、テープ ドライブの供
給元に連絡してください。

A user named ssconfig must be created for configuring SUNWsscs Diag Reporter.

ssconfig という名前のユーザを SUNWsscs Diag Reporter 用に作成する必要があります。

Abort/Clear-Queue/Abort-Tag Message (SCSI Channel %d, SCSI ID %d, Target Lun %d). 
Possible failure of I/O module, cable, controller, or HBA.

中止／キューのクリア／タグ中止のメッセージ（SCSI Channel %d, SCSI ID %d, Target Lun 
%d）。 
I/O モジュール、ケーブル、コントローラ、または HBA の故障の可能性があります。

Access denied for one or more servers. Log in as an ssconfig user, and then try the 
operation again.

1 つまたは複数のサーバへのアクセスが拒否されました。ssconfig ユーザとしてログイン
し、操作を再試行してください。

Active trap events is empty.

アクティブ トラップ イベントが空です。

Add SCSI Drive into Logical Drive information.

論理ドライブに SCSI ドライブが追加された情報。

Agent Name is empty.

表 G-33 置換値 (２ / ２)

値 説明
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エージェント名が空です。

An error occurred while getting data from the server.

サーバからデータを取得中にエラーが発生しました。

An existing configuration for this package is found. Do you want to restore it?

このパッケージの既存の構成が見つかりました。これを復元しますか?

An HBA card with this WWN already exists.

この WWN で HBA カードが既に存在します。

Another instance of this program is already running!

このプログラムの別のインスタンスが既に実行中です!

Are you sure you want to continue?

続行してよろしいですか?

Are you sure you want to continue?

続行してよろしいですか?

Are you sure you want to delete the log file?

このログ ファイルを削除してよろしいですか?

Are you sure you want to delete the log file?

このログ ファイルを削除してよろしいですか?

Are you sure you want to overwrite the file?

このファイルを上書きしてよろしいですか?

Are you sure you want to rebuild the drive?

このドライブを再構築してよろしいですか?

Array Admin in Progress.

アレイの管理が進行中です。

At least one email address needs to be configured.

低 1 つの電子メール アドレスを設定する必要があります。

Attempted to load a cartridge type, not supported by this drive. The cartridge has been 
automatically ejected. Attempted to load an unsupported tape format.

このドライブでサポートされていないカートリッジ タイプをロードしようとしました。カー
トリッジが自動的にイジェクトされました。サポートされていないテープ形式をロードしよ
うとしました。

Attempted to write to a write-protected cartridge. Remove the write-protection or use 
another tape.

表 G-34  エラー／ステータス メッセージ (続き)
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書き込み禁止カートリッジに書き込みしようとしました。書き込み禁止を解除するか、別の
テープを使用してください。

Audible alarm has an unknown status

警告音が不明な状態にあります。

Audible alarm has been triggered.

警告音が起動されました。

Audible alarm has been turned off.

警告音がオフにされました。

Background check or rebuild operation in progress.

バックグラウンド チェックまたは再構築操作が進行中です。

Background initialization in progress.

バックグラウンド初期化が進行中です。

Background parity check in progress.

バックグラウンド パリティ チェックが進行中です。

Background rebuild operation in progress.

バックグラウンド再構築操作が進行中です。

Background rebuild/check has been successfully terminated by abort command.

バックグラウンド再構築／チェックが中止コマンドにより正常に終了しました。

Background rebuild/check has failed. Cause unknown.
See additional messages.

バックグラウンド再構築／チェックに失敗しました。原因不明。

追加のメッセージを参照してください。

Background rebuild/check has failed. Possible device failure.
See additional messages.

バックグラウンド再構築／チェックに失敗しました。デバイスの故障の可能性があります。

追加のメッセージを参照してください。

Background rebuild/check has failed. Possible system drive failure.

バックグラウンド再構築／チェックに失敗しました。システム ドライブの故障の可能性があ
ります。

Before starting to use SUNWsscsConsole, run /opt/SUNWsscs/sscsconsole/config_sscon 
to input the pathanme of the default Web browser to access HTML help files.
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SUNWsscsConsole を使い始める前に、/opt/SUNWsscs/sscsconsole/config_sscon を実行
し、HTML ヘルプ ファイルにアクセスするためのデフォルト Web ブラウザのパス名を入力
してください。

Begin downloading firmware to devices. Do you want to continue?

ファームウェアのデバイスへのダウンロードを開始します。続行しますか?

Block Reassignment Failure (Ch:%d,Id:%d). Defective drive. Replace.

ブロックの再割り当てに失敗（Ch:%d,Id:%d）。欠陥ドライブです。交換してください。

Block Reassignment Succeeded( Ch:%d,Id:%d.) Informational message. Drive might be 
failing.

ブロックの再割り当てに成功（Ch:%d,Id:%d）。情報メッセージ。不良ドライブの可能性が
あります。

Cannot find the Java Runtime Environment $JRE_MAJOR.$JRE_MINOR or above! 
SUNWsscs Console needs JRE 1.2 or above to run. The Console will try to find it in 
/usr/java, /usr/jre, /usr/local/java, or /usr/local/jre. If you installed the JRE in a 
directory other than one mentioned above, make a link.

$JRE_MAJOR.$JRE_MINOR 以上の Java Runtime Environment が見つかりません
!SUNWsscs コンソールの実行には JRE 1.2 かそれ以降が必要です。コンソールは、これを 
/usr/java, /usr/jre, /usr/local/java または /usr/local/jreで探します。この JRE を上記以
外のディレクトリにインストールしてある場合は、リンクを作成してください。

Cannot get available LUN to assign this parition.

このパーティションに割り当てる使用可能な LUN を取得でません。

Cannot get configuration from controller. The operation is canceled.

構成をコントローラから取得できません。操作はキャンセルされました。

Cannot get SAFTE device status!

SAFTE デバイス ステータスを取得できません!

Changes made to Optimization will NOT take effect until all the logical drives are deleted 
and then the controller is RESET.

適化に対して行われた変更は、すべての論理ドライブが削除され、コントローラがリセッ
トされるまで有効に「なりません」。

Changes made to this setting will NOT take effect until the controller is RESET. Prior to 
resetting the controller, the operation may not proceed normally. Do you want to RESET 
controller?

この設定に対して行われた変更は、コントローラがリセットされるまで有効に「なりませ
ん」。コントローラをリセットしない限り、操作が正常に進行しないことがあります。コン
トローラをリセットしますか?

Click View to select one file.
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View をクリックし、ファイルを 1 つ選択してください。

Collect mail canceled by user.

ユーザーがメールの収集をキャンセルしました。

Completed Dynamic Growth.

動的成長を完了しました。

Configuration information saved successfully!

構成情報が正常に保存されました!

Connect and Login command error

接続およびログイン コマンド エラー

Contact Fax number format is wrong.

連絡先ファックス番号の形式が不正です。

Contact Name is empty

連絡先名が空です。

Contact Phone number format is wrong.

連絡先電話番号の形式が不正です。

Continuing Dynamic Growth - Parity Check Phase Completed.

動的成長の継続 ‐ パリティ チェック段階が完了。

Continuing Dynamic Growth - Rebuild Phase Completed.

動的成長の継続 ‐ 再構築段階が完了。

Controller Event, Controller Init Complete. Controller has been rebooted. Informational 
message.

コントローラ イベント ‐ コントローラの初期化完了。コントローラがリブートしました。
情報メッセージ。

Controller Event, Controller Reset.

コントローラ イベント ‐ コントローラのリセット。

Controller Event, DRAM Parity Error. Likely controller error. If error persists, replace 
defective controller.

コントローラ イベント ‐ DRAM パリティ エラー。おそらくコントローラ エラーです。エ
ラーが継続する場合は、欠陥コントローラを交換してください。

Controller Event, Fan Back On-line. Informational message.

コントローラ イベント ‐ ファンがオンラインに回復。情報メッセージ。
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Controller Event, Fan Failure Detected. Fan is integrated with power supply. Replace power 
supply. Check LED indicators to identify supply.

コントローラ イベント ‐ ファン故障を検出。ファンが電源に統合されています。電源を交
換してください。LED インジケータをチェックして電源を識別してください。

Controller Event, Power Supply Back On-line. Informational message.

コントローラ イベント ‐ 電源がオンラインに回復。情報メッセージ。

Controller Event, Power Supply Failure Detected. Replace power supply. Check LED 
indicators to identify supply.

コントローラ イベント ‐ 電源故障を検出。電源を交換してください。LED インジケータを
チェックして電源を識別してください。

Controller Event, Redundant Controller Failure Detected. Likely controller error. If error 
persists, replace defective controller.

コントローラ イベント ‐ 冗長コントローラ故障を検出。おそらくコントローラ エラーで
す。エラーが継続する場合は、欠陥コントローラを交換してください。

Controller Event, SDRAM Error. Likely controller error. If error persists, replace defective 
controller.

コントローラ イベント ‐ SDRAM エラー。おそらくコントローラ エラーです。エラーが継
続する場合は、欠陥コントローラを交換してください。

Controller Event, Temperature Alert. Check room temperature, clogged or restricted 
airflow. Correct as necessary.

コントローラ イベント ‐ 温度アラート。室温をチェックし、通気に問題がないか調べてく
ださい。必要に応じて修正します。

Controller Event, Temperature Back to Normal. Informational message.

コントローラ イベント ‐ 温度が正常に戻りました。情報メッセージ。

Controller Event, UPS AC Power Back On. Informational message.

コントローラ イベント ‐ UPS AC 電源が回復。情報メッセージ。

Controller Event, UPS AC Power Loss Detected. Contact technical support.

コントローラ イベント ‐ UPS AC 電源喪失を検出。テクニカル サポートに連絡してくださ
い。

Creating Host LUN filter Entry; please wait...

ホスト LUN フィルタ エントリを作成中。お待ちください...

Creating standard Host LUN mapping; please wait...

標準ホスト LUN マッピングを作成中。お待ちください...

Customer Fax number format is wrong.
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顧客ファックス番号の形式が不正です。

Customer name has been updated.

顧客名が更新されました。

Customer Name is empty.

顧客名が空です。

Customer Phone number format is wrong.

顧客電話番号の形式が不正です。

Data is at risk. Media performance of this tape is severely degraded. Copy any data you 
require from this tape. Do not use this tape again. Restart the operation with a different 
tape.

データ喪失の危険があります。このテープのメディア パフォーマンスが著しく低下していま
す。このテープから必要なデータをすべてコピーしてください。このテープは再使用しない
こと。別のテープを使って操作を再試行してください。

Data Under/Overrun(Ch:%d,Id:%d). Likely poorly seated or defective drive. If random 
drives, possible I/O module or cable failure on drive loop.

データ アンダーラン／オーバーラン（Ch:%d,Id:%d）。おそらく、ドライブの装着不良か、
欠陥ドライブが原因です。不特定の複数ドライブで発生する場合は、I/O モジュールまたは
ドライブ ループのケーブルの障害の可能性があります。

Decrypt mail canceled by user.

ユーザーがメールの暗号解読をキャンセルしました。

Deleted disk successfully!

ディスクが正常に削除されました!

Deleting disk; please wait...

ディスクを削除中。お待ちください...

Deleting Host LUN filter Entry; please wait...

ホスト LUN フィルタ エントリを削除中。お待ちください...

Deleting standard Host LUN mapping; please wait...

標準ホスト LUN マッピングを削除中。お待ちください...

Device at [Channel:Target] has been marked DEAD.  

[Channel:Target] にあるデバイスが「デッド」とマークされています。  

Device at [Channel:Target] has failed the self-reliability test. Replace the device.

[Channel:Target] にあるデバイスが自己信頼性テストに失格しました。このデバイスを交換
してください。
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Device information failed.

デバイス情報が使用不能。

Device is being automatically replaced by device [Channel:Target].

デバイスが自動的に、[Channel:Target] と交換されています。

Device will NOT be automatically replaced.

デバイスは自動的に交換「されません」。

Disk at [Channel:Target] has failed. Replace the device.

[Channel:Target] にあるディスクが故障しました。このデバイスを交換してください。

Disk at [Channel:Target] is back online.

[Channel:Target] にあるディスクがオンラインに回復しました。

Disk information is not available.

ディスク情報が使用可能でありません。

Do you want to download firmware to the controller?

コントローラにファームウェアをダウンロードしますか?

Do you want to download firmware with boot recrod to the controller?

コントローラにファームウェアとブート レコードをダウンロードしますか?

Do you want to save the current event log file?

現在の Event Log ファイルを保存しますか?

Do you want to set up the mail server?

メール サーバをセットアップしますか?

Door lock has an unknown status.

ドア ロックが不明な状態にあります。

Door locked.

ドアがロックされています。

Door unlocked.

ドアがロックされていません。

Download Firmware with Boot Record.

ファームウェアとブート レコードをダウンロードします。

Downloading Firmware to the devices

ファームウェアをデバイスにダウンロード中。
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Downloading Firmware to the RAID Controller.

ファームウェアを RAID コントローラにダウンロード中。

Drive SCSI Ch:%d Check drive seating, cables, and I/O module. Replace as required. 
Redundant controllers failed to bind.

ドライブ SCSI Ch:%d。ドライブの装着、ケーブル、および I/O モジュールをチェックして
ください。必要に応じて交換します。冗長コントローラがバインドに失敗しました。

Drive SCSI Ch:%d; Id:%d Likely poorly seated or defective drive. If random drives, possible 
I/O module or cable failure.

ドライブ SCSI Ch:%d、Id:%d。おそらく、ドライブの装着不良か、欠陥ドライブが原因で
す。不特定の複数ドライブで発生する場合は、I/O モジュールまたはケーブルの障害の可能
性があります。

Dynamic Growth Add Capacity Failed.

動的成長で容量の追加に失敗。

Dynamic Growth Check Consistency Failed.

動的成長で整合性のチェックに失敗。

Dynamic Growth Close Transport Failed.

動的成長で伝送のクローズに失敗。

Dynamic Growth Disable Controller failed.

動的成長でコントローラの無効化に失敗。

Dynamic Growth has completed on logical drive LogicalDrive.

動的成長が論理ドライブ LogicalDrive で完了しました。

Dynamic Growth has started on logical drive LogicalDrive.

動的成長が論理ドライブ LogicalDrive で開始しました。

Dynamic Growth Kill Partner Failed.

動的成長でパートナーの Kill に失敗。

Dynamic Growth Partner Status Failed.

動的成長でパートナー故障状態。

Dynamic Growth Rebuild Failed.

動的成長で再構築に失敗。

Email address format is wrong.

電子メール アドレスの形式が不正です。

Enclosure #Enclosure state change: Name
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格納装置 #Enclosure。状態に変更がありました。Name

Enclosure #Enclosure, Cache backup battery has changed from State state to State state.

格納装置 #Enclosure。キャッシュ バックアップ バッテリが State 状態から State 状態に変わ
りました。

Enclosure #Enclosure, Fan #Fan has changed from a State state to a State state.

格納装置 #Enclosure。ファン #Fan が State 状態から State 状態に変わりました。

Enclosure #Enclosure, Power supply #Power has changed from a State state to a State state.

格納装置 #Enclosure。電源 #Power が State 状態から State 状態に変わりました。

Enclosure #Enclosure, temperature threshold has changed from a State state to a State state.

格納装置 #Enclosure。温度しきい値が State 状態から State 状態に変わりました。

Engaging firmware; a controller reset is not necessary.

ファームウェアの起動中。コントローラのリセットは不要です。

Enter a Contact Name.

連絡先名を入力してください。

Enter a Customer Name.

顧客名を入力してください。

Enter a Location.

場所を入力してください。

Enter a mail address.

メール アドレスを入力してください。

Enter a System ID.

システム ID を入力してください。

Enter a valid gateway address.

有効なゲートウェイ アドレスを入力してください。

Enter a valid IP address.

有効な IP アドレスを入力してください。

Enter a valid network mask.

有効なネットワーク マスクを入力してください。

Enter SMTP server information

SMTP サーバ情報を入力してください。

Enter the login password.
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ログイン パスワードを入力してください。

Enter the ssconfig user password to login

ssconfig ユーザのログイン パスワードを入力してください。

Error in writing file, please try later!

ファイルへの書き込み中にエラー。後で再試行してください!

Error occurred. Reset the config file.

エラー発生。構成ファイルをリセットしてください。

Error on RAIDFlex port inquiry.

RAIDFlex ポートの問い合わせでエラー。

Expand Logical Drive information.

拡張論理ドライブ情報。

Failed primary controller has been removed.

故障プライマリ コントローラが取り外されました。

Failed secondary controller has been removed.

故障セカンダリ コントローラが取り外されました。

Fan #Fan has an unknown status.

ファン #Fan が不明な状態にあります。

Fan #Fan is malfunctioning.

ファン #Fan が誤動作しています。

Fan #Fan is not present in the system.

ファン #Fan がシステムに存在していません。

Fan #Fan is operational.

ファン #Fan が動作可能です。

File I/O error. Configuration could not be saved!

ファイル I/O エラー。構成を保存できません!

Firmware downloaded to Safte device (Ch:%d,Id:%d) failed.

ファームウェアの SAFTE デバイス（Ch:%d,Id:%d）へのダウンロードに成功。

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) failed.

ファームウェアの SCSI ドライブ（Ch:%d,Id:%d）へのダウンロードに失敗。

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) successfully.
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ファームウェアの SCSI ドライブ（Ch:%d,Id:%d）へのダウンロードに成功。

First select one Logical Drive!

初に 1 つの論理ドライブを選択してください!

First select one physical device.

初に 1 つの物理ドライブを選択してください!

First select one RAID controller.

初に 1 つの RAID コントローラを選択してください!

For NRAID Logical Drive 'Expand'/'Add Drive'/'Copy and Replace' function is disabled.

NRAID 論理ドライブで、'拡張'／'ドライブの追加'／'コピーして交換' 機能が無効化されてい
ます。

For RAID1 Logical Drive 'Add Drive'/'Copy and Replace' function is disabled.

RAID1 論理ドライブで、'ドライブの追加'／'コピーして交換' 機能が無効化されています。

Forward mail canceled bu user

メール転送がユーザによってキャンセルされました。

Getting Agent Options failed!

エージェント オプションの取得に失敗!

Getting Controller Parameters failed!

コントローラ パラメータの取得に失敗!

Getting Host LUN Assignments failed! Please try again

ホスト LUN 割り当ての取得に失敗!再試行してください。

Getting the configuration failed!

構成の取得に失敗!

Gross Error on SCSI Bus Detected (Log drive LogicalDrive, Ch:Channel,Id:Target,Lun:Lun).

SCSI バス上で大誤差を検出（Log drive LogicalDrive, Ch:Channel,Id:Target,Lun:Lun）。

Gross Phase/Signal Error Detected. Check drive seating, cables, and I/O module. Replace 
as required. Redundant controllers failed to bind.

位相／信号の大誤差を検出。ドライブの装着、ケーブル、および I/O モジュールをチェック
してください。必要に応じて交換します。冗長コントローラがバインドに失敗しました。

Group Name cannot be empty

グループ名は空であってはなりません。

Host LUN filter Entry created successfully!
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ホスト LUN フィルタ エントリが正常に作成されました!

Host LUN filter Entry deleted successfully!

ホスト LUN フィルタ エントリが正常に削除されました!

Host LUN filter map (StorEdge SN#%d LD %d Partition %d) is created.

ホスト LUN フィルタ マップ（StorEdge SN#%d LD %d Partition %d）を作成します。

Host LUN filter map (StorEdge SN#%d LD %d Partition %d) is deleted.

ホスト LUN フィルタ マップ（StorEdge SN#%d LD %d Partition %d）を削除します。

If file access is not properly coordinated when assigned to multiple hosts, data corruption 
and access contentions may occur.

複数のホストに割り当てる際にファイル アクセスを正しく調整しないと、データの破損やア
クセスの競合が起こることがあります。

If Minimum interval is ¥"0¥" or ¥"*¥", then Content must be ¥"Event¥"

小間隔が ¥"0¥" または ¥"*¥" の場合、内容は ¥"Event¥" でなければなりません。

If the firnware download progress is interrupted the controllers/devices may become 
unusable.

ファームウェアのダウンロードの進行が中断された場合、コントローラ／デバイスが使用不
能になることがあります。

Initialization operations have completed.

初期化操作が完了しました。 

Initializaton, rebuild, expand, or add SCSI drive activities are in progress. Try again later.

SCSI ドライブの初期化、再構築、拡張、または追加の活動が進行中です。後で再試行して
ください。

Inserted failed primary controller.

故障プライマリ コントローラが挿入されました。

Inserted failed secondary controller.

故障セカンダリ コントローラが挿入されました。

Install JRE 1.2.2, 1.3, 04 1.4 before installing the console.

コンソールのインストール前に、JRE 1.2.2、1.3、04 1.4 をインストールしてください。

Invalid server IP address!

無効なサーバ IP アドレス!

IP Address format error (must be xxx.xxx.xxx.xxx and 0 &amp;lt; xxx &amp;lt;255) !

IP アドレス形式エラー（有効な形式: xxx.xxx.xxx.xxx および 0 &amp;lt; xxx &amp;lt;255） !
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IP Address is duplicated!

IP アドレスが重複しています!

IP Address is empty.

IP アドレスが空です!

Issue Reset to the controller.

コントローラにリセットを発行します。

Location is empty.

場所が空です。

Log in as ¥"ssconfig¥" user and try the operation again.

¥"ssconfig¥" ユーザとしてログインし、操作を再試行してください。

Logical array LogicalArray Dynamic Growth has completed.

論理アレイ LogicalArray の動的成長が完了しました。

Logical array LogicalArray Dynamic Growth has started.

論理アレイ LogicalArray の動的成長が開始しました。

Logical array LogicalArray has changed from a State state to a State state.

論理アレイ LogicalArray が State 状態から State 状態に変わりました。

Logical array LogicalArray initialization has completed.

論理アレイ LogicalArray の初期化が完了しました。

Logical array LogicalArray initialization has started.

論理アレイ LogicalArray の初期化が開始しました。

Logical array LogicalArray parity check has completed.

論理アレイ LogicalArray のパリティ チェックが完了しました。

Logical array LogicalArray parity check has started.

論理アレイ LogicalArray のパリティ チェックが開始しました。

Logical array LogicalArray scheduled parity check has completed.

論理アレイ LogicalArray のスケジュールされたパリティ チェックが完了しました。

Logical array LogicalArray scheduled parity check has started.

論理アレイ LogicalArray のスケジュールされたパリティ チェックが開始しました。

Logical Drive %d, a SCSI Drive Failed. Replace defective drive

論理ドライブ %d。SCSI ドライブ故障。欠陥ドライブを交換してください。
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Logical Drive LogicalDrive, Parity Check Failed. Non-recoverable error. Likely drive failure 
or a non-recoverable error on stripe. Run parity check on the logical drive. Contact technical 
support.
Note: If you manually aborted Parity Check, there is no risk of data corruption. There is no 
need to contact technical support.

論理ドライブ LogicalDrive。パリティ チェックに失敗。回復不能エラー。おそらく、ドライ
ブの故障か、ストライプの回復不能エラーが原因です。論理ドライブにパリティ チェックを
実行してください。テクニカル サポートに連絡してください。 
注:パリティ チェックを手動で中止した場合、データが破損することはありません。テクニ
カル サポートに連絡する必要はありません。

Logical Drive ID %d, Rebuild Completed. Informational message. Replace defective drive 
with new drive.

論理ドライブ ID %d。再構築完了。情報メッセージ。欠陥ドライブを新しいドライブと交換
してください。

Logical Drive ID LogicalDrive, Add drive paused. Informational message.

論理ドライブ ID LogicalDrive。ドライブの追加が一時停止。

Logical Drive ID LogicalDrive, Add SCSI Drv Completed. Informational message.

論理ドライブ ID LogicalDrive。SCSI ドライブの追加が完了。情報メッセージ。

論理ドライブ ID LogicalDrive。パリティ チェックを開始。情報メッセージ。

Logical Drive ID LogicalDrive, Starting Rebuild. Informational message.

論理ドライブ ID LogicalDrive。再構築を開始。情報メッセージ。

Logical Drive ID LogicalDrive, Add SCSI Drv Failed. Non-recoverable error. Likely drive 
failure or a non-recoverable error on stripe. Run parity check on the logical drive. Contact 
technical support.

論理ドライブ ID LogicalDrive。SCSI ドライブの追加に失敗。回復不能エラー。おそらく、
ドライブの故障か、ストライプの回復不能エラーが原因です。論理ドライブにパリティ 
チェックを実行してください。テクニカル サポートに連絡してください。

Logical Drive ID LogicalDrive, Clone Completed. Informational message.

論理ドライブ ID LogicalDrive。クローンが完了。情報メッセージ。

Logical Drive ID LogicalDrive, Clone Failed. Non-recoverable error Likely drive failure or a 
non-recoverable error on stripe. Run parity check on the logical drive. Contact technical 
support.

論理ドライブ ID LogicalDrive。クローンに失敗。回復不能エラー。おそらく、ドライブの故
障か、ストライプの回復不能エラーが原因です。論理ドライブにパリティ チェックを実行し
てください。テクニカル サポートに連絡してください。

Logical Drive ID LogicalDrive, Expand Completed. Informational message.

論理ドライブ ID LogicalDrive。拡張が完了。情報メッセージ。
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Logical Drive ID LogicalDrive, Expand Failed. Non-recoverable error. Likely drive failure or 
a non-recoverable error on stripe. Run parity check on the logical drive. Contact technical 
support.

論理ドライブ ID LogicalDrive。拡張に失敗。回復不能エラー。おそらく、ドライブの故障
か、ストライプの回復不能エラーが原因です。論理ドライブにパリティ チェックを実行して
ください。テクニカル サポートに連絡してください。

Logical Drive ID LogicalDrive, Initialization Completed. Informational message.

論理ドライブ ID LogicalDrive。初期化が完了。情報メッセージ。

Logical Drive ID LogicalDrive, Initialization Failed. Informational message. Possible 
defective drive or slot. User might have aborted operation.

論理ドライブ ID LogicalDrive。初期化に失敗。情報メッセージ。ドライブまたはスロットの
欠陥の可能性があります。ユーザーが操作を中止した場合もあります。

Logical Drive ID LogicalDrive, Parity Check Completed. Informational message.

論理ドライブ ID LogicalDrive。パリティ チェックが完了。情報メッセージ。

Logical Drive ID LogicalDrive, Rebuild Failed. Informational message. Possible defective 
drive or slot. User might have aborted operation.

論理ドライブ ID LogicalDrive。再構築に失敗。情報メッセージ。ドライブまたはスロットの
欠陥の可能性があります。ユーザーが操作を中止した場合もあります。

Logical Drive ID LogicalDrive, Starting Add SCSI Drive Operation. Informational message.

論理ドライブ ID LogicalDrive。SCSI ドライブの追加操作を開始。情報メッセージ。

Logical Drive ID LogicalDrive, Starting Clone. Informational message.

論理ドライブ ID LogicalDrive。クローンを開始。情報メッセージ。

Logical Drive ID LogicalDrive, Starting Expansion. Informational message.

論理ドライブ ID LogicalDrive。拡張を開始。情報メッセージ。

Logical Drive ID LogicalDrive, Starting Initialization. Informational message.

論理ドライブ ID LogicalDrive。初期化を開始。情報メッセージ。

論理ドライブ ID LogicalDrive。パリティ チェックを開始。情報メッセージ。

Logical Drive LogicalDrive has changed from a State state to a State state.

論理ドライブ LogicalDrive が State 状態から State 状態に変わりました。

Logical Volume Components List. Total disks in this Logical Volume=

論理ボリューム コンポーネント リスト。この論理ボリューム内の合計ディスク数=

Login successful

ログイン成功
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Login unsuccessful

ログイン失敗

Logout command error.

ログアウト コマンド エラー。

Mail information is empty

エージェント情報が空です。

Memory Allocation Error.

メモリ割り振りエラー。

Minimum interval between emails must be one of the following formats: ¥"*¥"   ¥"0¥"  
¥"nn¥"   ¥"nn:mm¥"

電子メール間の 小間隔は、次のいずれかの形式でなくてはなりません: ¥"*¥"   ¥"0¥"  ¥"nn¥"   
¥"nn:mm¥"

Minimum interval can’t meet Content value.

小間隔が Content 値に合いません。

Minimum interval format error.

小間隔の形式エラー。

Minimum interval format is HH[:MM].

小間隔の形式は、HH[:MM]。

Minimum interval is empty.

小間隔が空です。

Multiple IP assignment mechanisms are not supported. Select only one mechanism.

複数の IP 割り当て方式はサポートされていません。方式を 1 つだけ選択してください。

Mute controller beeper failure.

コントローラ ビープ音の消音に失敗。

Mute controller beeper.

コントローラ ビープ音を消音。

Negotiating with the secondary controller.

セカンダリ コントローラとネゴシエーション中。

Negotiation completed successfully, waiting for next ping.

ネゴシエーションが正常に完了。次のピング送信を待っています。
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Negotiation Error(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace as 
required.

ネゴシエーション エラー（Ch:%d,Id:%d）。ドライブの装着、ケーブル、および I/O モ
ジュールをチェックしてください。必要に応じて交換します。

New parity check schedule has been created.

新しいパリティ チェック スケジュールが作成されました。

No admin progress exists.

管理進行状況が存在しません。

No Admin progress was found. All activity should be complete!

管理進行状況が見つかりません。活動はすべて完了しています!

No array administration activity in progress!

進行中のアレイ管理活動はありません!

No more events to report.

これ以上報告するイベントはありません。

Not Ready Error Reported by Target(Ch:%d,Id:%d). Likely poorly seated or defective drive. 
Possible defective drive slot.

ターゲット（Ch:%d,Id:%d）からの準備未完了エラー。おそらく、ドライブの装着不良か、
欠陥ドライブが原因です。ドライブ スロットの欠陥の可能性があります。

Only the last partition of a logical drive can be deleted.

論理ドライブの 後のパーティションのみ削除できます。

Operation completed successfully.

操作が正常に完了しました。

Operation failed.

操作に失敗しました。

Operation in progress.

操作が進行中です。

Operation on one of the servers failed

サーバの 1 つで操作に失敗しました。

Out of the scope!

範囲外です!

Parity check could not be started on logical drive LogicalDrive.

パリティ チェックを論理ドライブ LogicalDrive で開始できません。
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Parity check has completed on logical drive LogicalDrive.

パリティ チェックが論理ドライブ LogicalDrive で完了しました。

Parity check has started on logical drive LogicalDrive.

パリティ チェックが論理ドライブ LogicalDriveで開始しました。

Parity check or Rebuild has completed on logical drive LogicalDrive.

パリティ チェックまたは再構築が論理ドライブ LogicalDrive で完了しました。

Parity check schedule has been removed.

パリティ チェック スケジュールが削除されました。

Parity check schedule has been updated.

パリティ チェック スケジュールが更新されました。

Parity Error(Ch:%d,Id:%d ). Likely poorly seated or defective drive. If random drives, 
possible I/O module or cable failure.

パリティ エラー（Ch:%d,Id:%d）。おそらく、ドライブの装着不良か、欠陥ドライブが原因
です。不特定の複数ドライブで発生する場合は、I/O モジュールまたはケーブルの障害の可
能性があります。

Parity Error(SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of I/O module, 
cable, controller, or HBA

パリティ エラー（SCSI Channel %d, SCSI ID %d, Target Lun %d）。I/O モジュール、ケー
ブル、コントローラ、または HBA の故障の可能性があります。

Partition 0 cannot be deleted.

パーティション 0 は削除できません。

Partition table is full, 'Expand Logical Drive'/'Add Drive' function is disabled.

パーティション テーブルが一杯です。'論理ドライブの拡張'／'ドライブの追加' 機能が無効
化されています無効化されています。

Password error!

パスワード エラー!

Password is empty

パスワードが空です。

Physical drive Channel:Target rebuild has completed.

物理ドライブ Channel:Target の再構築が完了しました。

Physical drive Channel:Target rebuild has started.

物理ドライブ Channel:Target の再構築が開始しました。
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Poll interval limited to 600 seconds (10 minutes). Specify a lower value.

ポーリング間隔は 大 600 秒（10 分）です。より小さい値を指定してください。

Port is invalid (port must be between 0 and 65535)

ポートが無効（有効なポート値: 0 ～ 65535）

Port is invalid (port must be between 1270 and 1273)

ポートが無効（有効なポート値: 1270 ～ 1273）

Power supply #Power has an unknown status.

電源 #Powerが不明な状態にあります。

Power supply #Power is malfunctioning and has been switched off.

電源 #Power が誤動作し、オフになりました。

Power supply #Power is malfunctioning or disabled.

電源 #Powerが誤動作しているか、使用不能です。

Power supply #Power is not present in the system.

電源 #Power がシステムに存在していません。

Power supply #Power is operational but disabled.

電源 #Powerが動作可能ですが、無効化されています。

Power supply #Power is operational.

電源 #Powerが動作可能です。

Power supply #Power is present in the system.

電源 #Powerがシステムに存在しています。

Primary controller failed. Secondary controller is servicing I/O.

プライマリ コントローラが故障。セカンダリ コントローラが I/O を処理しています。

Primary controller has stopped negotiation because of insufficient memory.

プライマリ コントローラが、メモリ不足のためネゴシエーションを停止しました。

Probe Agent command error!

エージェントの Probe コマンド エラー!

Progress not available

進行状況が使用不能。

Raid Controller is back online.

RAID コントローラがオンラインに回復しました。
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Read config file error

構成ファイル読み取りエラー。

Rebuild or check operations have completed with error - Drive Failure.

再構築またはチェック操作がエラーで終了しました - ドライブの故障。

Rebuild or check operations have completed with error - Job Terminated.

再構築またはチェック操作がエラーで終了しました - ジョブ停止。

Rebuild or check operations have completed with error - System Drive Failure.

再構築またはチェック操作がエラーで終了しました - システム ドライブの故障。

Rebuild or check operations have completed with error - Unknown causes.

再構築またはチェック操作がエラーで終了しました - 原因不明。

Rebuild or check operations have completed.

再構築またはチェック操作が完了。

Received command to establish redundancy with secondary controller.

セカンダリ コントローラで冗長性を確立するようにコマンドを受信。

Received command to return control to primary controller.

コントロールをプライマリ コントローラに戻すようにコマンドを受信。

Received first ping after successful negotiation.

ネゴシエーション成功後、 初のピングを受信。

Received the first ping from secondary controller.

セカンダリ コントローラから 初のピングを受信。

Redundant Array State Change: Controllers back in redundancy mode!

冗長アレイの状態変化:コントローラが冗長モードに戻りました!

Redundant Array State Change: Primary controller failed! Replace the Primary Controller.

冗長アレイの状態変化:プライマリ コントローラが故障!プライマリ コントローラを交換して
ください。

Redundant Array State Change: Secondary controller failed! Replace the Secondary 
Controller.

冗長アレイの状態変化:セカンダリ コントローラが故障!セカンダリ コントローラを交換して
ください。

Remove the package @PKG_NAME@ and then try to install this package

パッケージ @PKG_NAME@ を削除してから、このパッケージのインストールを試みてくだ
さい。
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Removed a failed primary controller.

故障プライマリ コントローラが削除されました。

Removed a failed secondary controller.

故障セカンダリ コントローラが削除されました。

Reselect Timeout(SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of I/O 
module, cable, controller, or HBA.

タイムアウトの再選択（SCSI Channel %d, SCSI ID %d, Target Lun %d）。I/O モジュー
ル、ケーブル、コントローラ、または HBA の故障の可能性があります。

Restoring control to primary controller.

プライマリ コントローラにコントロールを回復中。

Retry the configuration operation after the update is complete.

更新の完了後、構成操作を再試行してください。

SAF-TE card Channel:Target firmware has been updated.

SAF-TE カード Channel:Target のファームウェアが更新されました。

SAF-TE card Channel:Target global status has been updated.

SAF-TE カード Channel:Target のグローバル ステータスが更新されました。

SAF-TE card Channel:Target slot perform status has been updated.

SAF-TE カード Channel:Target の実行ステータスが更新されました。

SAF-TE card Channel:Target slot status has been updated.

SAF-TE カード Channel:Target のスロット ステータスが更新されました。

Save a Copy in server.

コピーをサーバに保存してください。

Saving configuration information; please wait...

構成情報の保存中。お待ちください...

Scan SCSI Drive information.

SCSI ドライブのスキャン情報。

Scan SCSI Drive Successful. Informational message.

SCSI ドライブのスキャンに成功。情報メッセージ。

Scheduled parity check could not be started on logical drive LogicalDrive.

スケジュールされたパリティ チェックを論理ドライブ LogicalDrive で開始できません。

Scheduled parity check has completed on logical drive LogicalDrive.
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スケジュールされたパリティ チェックが論理ドライブ LogicalDrive で完了しました。

Scheduled parity check has started on logical drive LogicalDrive.

スケジュールされたパリティ チェックが論理ドライブ LogicalDrive で開始しました。

Scheduled parity check on logical drive LogicalDrive completed with error - Drive Failure.

論理ドライブ LogicalDrive 上でのスケジュールされたパリティ チェックがエラーで終了し
ました ‐ ドライブの故障。

Scheduled parity check on logical drive LogicalDrive completed with error - Job 
Terminated.

論理ドライブ LogicalDrive 上でのスケジュールされたパリティ チェックがエラーで終了し
ました ‐ ジョブ停止。

Scheduled parity check on logical drive LogicalDrive completed with error - System Drive 
Failure.

論理ドライブ LogicalDrive 上でのスケジュールされたパリティ チェックがエラーで終了し
ました ‐ システム ドライブの故障。

Scheduled parity check on logical drive LogicalDrive completed with error - Unknown 
causes.

論理ドライブ LogicalDrive 上でのスケジュールされたパリティ チェックがエラーで終了し
ました ‐ 原因不明。

Scheduled parity check skipped to next schedule due to incompletion of previous check.

スケジュールされたパリティ チェックが、前のチェックが未完了のため次のスケジュールに
スキップされました。

SCSI Aborted Command(Ch:%d,Id:%d). Informational message. Drive might be failing or 
defective slot.

SCSI でコマンド中止（Ch:%d,Id:%d）。情報メッセージ。不良ドライブまたは欠陥スロット
の可能性があります。

SCSI Bus Device Reset(SCSI Channel %d, SCSI ID %d, Target Lun %d). Possible failure of 
I/O module, cable, or HBA.

SCSI バス デバイス リセット（SCSI Channel %d, SCSI ID %d, Target Lun %d）。I/O モ
ジュール、ケーブル、または HBA の故障の可能性があります。

SCSI Bus Reset Issued(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace 
as required.

SCSI バスがリセットを発行（Ch:%d,Id:%d）。ドライブの装着、ケーブル、および I/O モ
ジュールをチェックしてください。必要に応じて交換します。

SCSI Bus Reset(SCSI Channel %d, SCSI ID %d, Target LUN %d). Possible failure of I/O 
module, cable, or HBA.
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SCSI バス リセット（SCSI Channel %d, SCSI ID %d, Target LUN %d）。I/O モジュール、
ケーブル、または HBA の故障の可能性があります。

SCSI Channel Failure - (Ch:%d,Id:%d) Replace defective I/O or drive module.

SCSI チャネル障害 ‐ （Ch:%d,Id:%d）。欠陥の I/O またはドライブ モジュールを交換し
てください。

SCSI Channel Failure - Fibre Loop Connection Failure Check drive path. Possible cable or 
module failure.

SCSI チャネル障害 ‐ ファイバ ループ接続の障害。ドライブ パスをチェックしてくださ
い。ケーブルまたはモジュールの故障の可能性があります。

SCSI Channel Failure - General. Check drive path.

SCSI チャネル障害 ‐ 一般。ドライブ パスをチェックしてください。

SCSI Channel Failure - Redundant Loop/Path Failure. Check drive path. Possible cable or 
module failure.

SCSI チャネル障害 ‐ 冗長ループ／パスの障害。ドライブ パスをチェックしてください。
ケーブルまたはモジュールの故障の可能性があります。

SCSI Channel Failure(Log drive LogicalDrive, Ch:Channel,Id:Target,Lun:Lun).

SCSI チャネル障害(Log drive LogicalDrive, Ch:Channel,Id:Target,Lun:Lun)。

SCSI Channel Restored - Fibre Loop Connection Restored. Informational message.

SCSI チャネル回復 ‐ ファイバ ループ接続が回復。情報メッセージ。

SCSI Channel Restored - Redundant Path Restored. Informational message.

SCSI チャネル回復 ‐ 冗長パスが回復。情報メッセージ。

SCSI Drive Failed. Replace defective drive.

SCSI ドライブ故障。欠陥ドライブを交換してください。

Secondary controller has failed.

セカンダリ コントローラが故障しました。

Select a Product ID before downloading firmware.

ファームウェアをダウンロードする前に、製品 ID を選択してください。

Select either AM or PM.

AM または PM を選択してください。

Select only ONE logical drive!

論理ドライブを 1 つだけ選択してください!

Select only one row to edit it.
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編集するには 1 行だけ選択してください。

Select only one row to remove it.

削除するには 1 行だけ選択してください。

Select the agent before clicking Remove.

Remove をクリックする前に、エージェントを選択してください。

Select the agent item before clicking Edit.

Edit をクリックする前に、エージェント項目を選択してください。

Select the Channel/ID of the drive you want to scan

スキャンするドライブのチャネル／ID を選択してください。

Select the firmware file before downloading it

ファームウェア ファイルをダウンロードする前に、それを選択してください。

Select the Logical Drive(s)

論理ドライブを選択してください。

Select the server item before clicking Edit.

Edit をクリックする前に、サーバ項目を選択してください。

Select the server item before clicking Remove.

Remove をクリックする前に、サーバ項目を選択してください。

Select the Starting Day.

開始日を選択してください。

Select Timeout(Ch:%d,Id:%d). Likely poorly seated or defective drive. If random drives, 
possible I/O module or cable failure.

タイムアウトの選択（Ch:%d,Id:%d）。おそらく、ドライブの装着不良か、欠陥ドライブが
原因です。不特定の複数ドライブで発生する場合は、I/O モジュールまたはケーブルの障害
の可能性があります。

Server failed the operation due to insufficient memory.

サーバが、メモリ不足のため操作を実行しませんでした。

Server Name is empty

サーバ名が空です。

Server Not managed!

サーバが管理されていません!

Set configuration failed!
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構成の設定に失敗!

Slot #Slot has had a device Name.

スロット #Slot には、デバイス Name がありました。

SMART Predictable Failure Detected Ch:%d,Id:%d). Informational message. Drive might be 
failing.

SMART が予想故障を検出（Ch:%d,Id:%d）。情報メッセージ。不良ドライブの可能性があ
ります。

SMTP From address format is wrong or empty.

SMTP の From アドレスの形式が不正または空です。

SMTP From address format is wrong.

SMTP の From アドレスの形式が不正です。

SMTP Server address is empty.

SMTP サーバのアドレスが空です。

Specify how often you want the parity checked.

パリティ チェックの実行頻度を指定してください。

Standard Configuration options provide a group of basic default RAID sets whereby the 
drive size, quantity, and assignments are preconfigured.

Standard Configuration オプションは、ドライブ サイズ、容量、割り当てが事前設定された
デフォルトの RAID セット グループを提供します。

Standard Configuration will replace the existing configuration.

Standard Configuration は既存の構成に置き換わります。

Standard Host LUN mapping created successfully!

標準ホスト LUN マッピングが正常に作成されました!

Standard Host LUN mapping deleted successfully!

標準ホスト LUN マッピングが正常に削除されました!

Standard maps are available to all connected hosts in certain configurations.

標準マップは、特定の構成内で接続されたすべてのホストに使用可能です。

Standby rebuild operation completed with an unknown error.

スタンバイの再構築操作が、不明なエラーで終了しました。

Standby rebuild operation in progress.

スタンバイの再構築操作が進行中です。

Starting Dynamic Growth.
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動的成長を開始しました。

Startup state of the secondary controller.

セカンダリ コントローラの起動状態。

Successful negotiation between both controllers.

両コントローラ間でのネゴシエーションに成功。

Successful startup. Both controllers have entered redundancy modes.

起動に成功。両コントローラが冗長モードになりました。

SUNWsscsConsole needs JRE 1.2.2, 1.3, or 1.4 to run.The Console will try to find it in 
/usr/java, /usr/jre,/usr/local/java, or /usr/local/jre. If you installed the JRE in a 
directory other than one mentioned above, make a link.

SUNWsscsConsole の実行には JRE 1.2.2、1.3、または 1.4 が必要です。コンソールは、これ
を /usr/java, /usr/jre, /usr/local/java または /usr/local/jreで探します。この JRE を上記
以外のディレクトリにインストールしてある場合は、リンクを作成してください。

System ID is empty.

システム ID が空です。

Tape operation has stopped because an error occurred while reading or writing data, which 
the drive cannot correct.  

テープ操作が、データの読み取り／書き込み中にエラー発生のため停止しました。ドライブ
はこれを修正できません。  

TapeAlert notification. Device [Channel:Target].  

TapeAlert 通知。デバイス [Channel:Target]。  

Target HW Error Reported((Ch:%d,Id:%d). Likely poorly seated or defective drive. Possible 
defective drive slot.

ターゲット HW エラーの報告（Ch:%d,Id:%d）。おそらく、ドライブの装着不良か、欠陥ド
ライブが原因です。ドライブ スロットの欠陥の可能性があります。

Target Media Error Reported(Ch:%d,Id:%d). Likely poorly seated or defective drive. 
Possible defective drive slot.

ターゲット メディア エラーの報告（Ch:%d,Id:%d）。おそらく、ドライブの装着不良か、
欠陥ドライブが原因です。ドライブ スロットの欠陥の可能性があります。

Target Timed-out(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. Replace as 
required.

ターゲット タイムアウト（Ch:%d,Id:%d）。ドライブの装着、ケーブル、および I/O モ
ジュールをチェックしてください。必要に応じて交換します。

Temperature Alert. Check room temperature, clogged or restricted airflow. Correct as 
necessary.
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温度アラート。室温をチェックし、通気に問題がないか調べてください。必要に応じて修正
します。

Temperature Back to Normal. Informational message.

温度が正常に戻りました。情報メッセージ。

Temperature change from TemperatureC to TemperatureC.

温度が TemperatureC から TemperatureC に変わりました。

The changer mechanism is having difficulty communicating with the tape drive. Turn the 
autoloader off then on and restart the operation. If problem persists, call the tape drive 
supplier helpline.

交換機構で、テープ ドライブとの通信に障害があります。自動ローダーをオフにしてからオ
ンにし、操作を再試行してください。問題が解決しない場合は、テープ ドライブの供給元に
連絡してください。

The client receives events only when it is running. Are you sure you want to exit?

クライアントは実行している間だけイベントを受信します。終了してよろしいですか?

The configuration has been updated.

構成が更新されました。

The configuration was successfully updated. If new logical drives were created, the server 
may need to be rebooted.

構成が正常に更新されました。新しい論理ドライブを追加した場合は、サーバのリブートが
必要な場合もあります。

The Content of Periodic Trap cannot be \"Event\". Please select another one.

定期トラップの内容が \"Event\" であってはなりません。別のオプションを選択してくださ
い。

The Controller devices list changed.

コントローラ デバイス リストが変更されました。

The controller needs to be reset for the new firmware to take effect. Do you want to reset 
the controller?

新しいファームウェアを有効にするには、コントローラをリセットする必要があります。コ
ントローラをリセットしますか?

The controller parameters have been updated.

コントローラのパラメータが更新されました。

The current user is ssconfig; you cannot log in again.

現在のユーザ ssconfig です。再ログインはできません。

The device does not belong to the same HBA card. The operations cannot continue.
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デバイスが同じ HBA カードに属していません。操作を続けられません。

The device resource cannot be locked for exclusive use. Check to see if some applications 
are currently accessing the resource. If so, close those applications and try the operation 
again.

デバイス リソースを専用使用のためロックすることはできません。ほかのアプリケーション
が現在リソースにアクセス中でないかチェックしてください。その場合は、それらのアプリ
ケーションを終了し、操作を再試行してください。

The drive can no longer write data to the tape.

ドライブがテープにデータを書き込みできなくなりました。

The drive letter (mounted point) cannot be assigned.

ドライブ文字（マウント ポイント）を割り当てできません。

The encrypt key is empty.

暗号キーが空です。

The encrypt key you entered includes extra space in the beginning or at the end, which can 
cause encryption errors. Do you want to continue

入力された暗号キーの先頭または末尾に、暗号化エラーの原因となる余分なスペースが含ま
れています。続行しますか?

The firmware does not support multiple IP assignment mechanisms.

ファームウェアは、複数の IP 割り当て方式をサポートしていません。

The firmware download failed because you have tried to use the incorrect firmware for this 
tape drive. Obtain the correct firmware and try again.

ファームウェアのダウンロードに失敗。このテープ ドライブに対応しないファームウェアの
使用を試みたためです。正しいファームウェアを取得して、再試行してください。

The IP Address cannot be empty.

IP アドレスは空であってはなりません。

The last cleaning cartridge used in the tape drive has worn out. Discard the worn out 
cleaning cartridge, wait for the current operation to finish, and then use a new cleaning 
cartridge.

テープ ドライブで使用された 後のクリーニング カートリッジが消耗しています。消耗し
たクリーニング カートリッジを廃棄し、現在の操作が完了するまで待ってから、新しいク
リーニング カートリッジを挿入してください。

The LD# is moved up after you delete the LD, so it may not be consistent with the LD# 
shown in the RS-232 terminal window.

論理ドライブを削除した後でその LD# が移動されたため、この番号が RS-232 端末ウィンド
ウに表示される LD# と一致しない可能性があります。
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The length of the encrypt key must be greater than 8 characters.

暗号化キーの長さは 8 文字よりも長くなければなりません。

The Mail Server field cannot be empty.

Mail Server フィールドは空であってはなりません。

The media has exceeded its specified life. The tape cartridge has reached the end of its 
useful life. Copy any data you need to another tape. Discard the old tape.

メディアがその仕様寿命を超えています。テープ カートリッジがその有効寿命の終わりに達
しました。必要なデータをすべて別のテープにコピーしてください。古いテープを廃棄して
ください。

The memory allocation Failed.

メモリの割り振りに失敗。

The mount point (drive letter) cannot be written into file (registry).

マウント ポイント（ドライブ文字）をファイル（レジストリ）に書き込めません。

The operation failed because the autoloader door is open. Clear any obstructions from the 
autoloader door, eject the magazine, and then insert it again. If the fault does not clear, turn 
the autoloader off and then on again.

自動ローダーのドアが開いているため、操作に失敗。自動ローダーのドアから障害物を取り
除き、マガジンをイジェクトしてから再挿入してください。フォールトがクリアされない場
合は、自動ローダーをオフにしてからオンにします。

The operation failed because the tape in the drive has snapped. Discard the old tape. 
Restart the operation with a different tape.

ドライブ内のテープが切れたため操作に失敗。古いテープを廃棄してください。別のテープ
を使って操作を再試行してください。

The Selected Device list is empty!

選択されたデバイスのリストが空です!

The server already exists!

サーバが既に存在します!

The Server Name cannot be empty or only contain any extra spaces

サーバ名は空であってはなりません。スペースだけを含むこともできません。

The set configuration Failed.

構成の設定に失敗。

The tape cartridge is not data grade. Any data you backup to the tape is at risk. The drive 
has not been able to read the MRS stripes. Replace the cartridge with a data-grade tape.
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テープ カートリッジがデータ品質ではありません。このテープにバックアップしたデータは
喪失する危険があります。ドライブは、MRS ストライプを読み取ることができません。
カートリッジをデータ品質のテープと交換してください。

The tape drive has a hardware fault, which is not read/write related. Turn the tape drive off 
and then on again and restart the operation. If the problem persists, call the tape drive 
supplier helpline.

テープ ドライブに、読み書きに関連しないハードウェア フォールトがあります。テープ ド
ライブをオフにしてからオンにし、操作を再試行してください。問題が解決しない場合は、
テープ ドライブの供給元に連絡してください。

The tape drive has a hardware fault. Eject the tape or magazine, reset the drive (hold the 
unload button down for 5 seconds), and restart the operation.

テープ ドライブにハードウェア フォールトがあります。テープまたはマガジンをイジェク
トし、ドライブをリセットして（アンロード ボタンを 5 秒間押し続ける）、操作を再試行し
てください。

The tape drive has a problem with the SCSI interface. Check the cables and cable 
connections and restart the operation.

テープ ドライブに SCSI インターフェイスの問題があります。ケーブルとケーブル接続を
チェックし、操作を再試行してください。

The tape drive is due for routine cleaning. Wait for the current operation to finish and then 
use a cleaning cartridge.

テープ ドライブの定期クリーニング期限です。現在の操作が完了するまで待ってから、ク
リーニング カートリッジを使用してください。

The tape drive is having problems reading data.No data has been lost, but there has been a 
reduction in the capacity of the tape.

テープ ドライブでデータの読み込み時に問題が発生しました。データは喪失していません
が、テープの容量が低減しています。

The tape drive needs cleaning. If the operation has stopped, eject the tape and clean the 
drive. If the operation has not stopped, wait for it to finish and then clean the drive.

テープ ドライブのクリーニングが必要です。操作が停止している場合は、テープをイジェク
トし、ドライブをクリーニングしてください。操作が停止していない場合は、完了するまで
待ってから、ドライブをクリーニングしてください。

The tape in the drive is a cleaning cartridge. If you want to backup or restore, insert a 
data-grade tape.

ドライブに入っているテープはクリーニング カートリッジです。バックアップまたは復元操
作を実行するには、データ品質のテープを挿入してください。

The tape is damaged or the drive is faulty. The drive can no longer read data from the tape. 
Call the tape supplier helpline.  
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テープが損傷しているか、ドライブに欠陥があります。ドライブがテープからデータを読み
取りできなくなりました。

テープの供給元に連絡してください。  

The tape is from a faulty batch or the tape drive is faulty. Use a good tape to test the drive. 
If the problem persists, call the tape drive supplier helpline.

テープが欠陥グループからのものか、またはテープ ドライブに欠陥があります。良好なテー
プを使ってドライブをテストしてください。問題が解決しない場合は、テープ ドライブの供
給元に連絡してください。

The tape operation failed. Eject and then reinsert the tape or magazine.

テープ操作に失敗。テープまたはマガジンをイジェクトしてから再挿入してください。

The WWN must be a Hex string that is less than 17 characters.

WWN は 17 文字より短い 16 進文字列でなければなりません。

There are no available disks to configure.

構成するために使用可能なディスクがありません。

There are no logical drives to manage.

管理するための論理ドライブがありません。

There are not enough available disks to add a new LD.

新しい論理ドライブに追加するための使用可能ディスクが不足しています。

There is a problem with the autoloader mechanism. Loader mechanism has detected a 
hardware fault.

自動ローダー機構に問題があります。ローダ機構がハードウェア フォールトを検出しまし
た。

There is no spare or replacement drive. Rebuild cannot continue.

スペアまたは交換用ドライブがありません。再構築を続行できません。

This Configuration Will Overwrite the Existing Configuration. All Previous Configuration 
Information and Data Will Be Lost.

この構成は既存の構成を上書きします。以前の構成情報とデータがすべて失われます。

This operation will add to the existing configuration.

この操作は既存の構成に追加します。

This operation will delete the fibre map.

この操作はファイバ マップを削除します。

This operation will erase any existing configuration and data.

この操作は既存の構成とデータをすべて消去します。
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This operation will result in the loss of current controller settings and data on ALL of the 
logical drives. Are you sure you want to restore factory defaults?

この操作の結果、現在のコントローラ設定と、すべての論理ドライブ上のデータが喪失しま
す。工場出荷時デフォルトを復元してよろしいですか?

This operation will result in the loss of data on ALL of the modified partitions. Do you 
want to continue?

この操作の結果、修正されたすべてのパーティション上のデータが喪失します。続行します
か?

To find out the java version currently installed, type "Java-version"

現在インストールされている Java のバージョンを見るには、"Java-version" と入力します。

Trap information has been modified. Do you want to save it?

トラップ情報が修正されました。これを保存しますか?

Unable to allocate memory for array inquiry. Unable to monitor this array.

アレイの問い合わせ用にメモリを割り振りできません。このアレイは監視できません。

Unable to determine local host, terminating!

ローカル ホストを特定できません。終了します!

Unable to eject cartridge because the tape drive is in use. Wait until the operation is 
complete before ejecting the cartridge.

テープ ドライブが使用中のため、カートリッジをイジェクトできません。操作が完了するま
で待ってから、カートリッジをイジェクトしてください。

Unable to inquire card. Array error.

カードを問い合わせできません。アレイ エラー。

Unable to inquire SAF-TE device. SAF-TE monitoring for this enclosure disabled.

SAF-TE デバイスを問い合わせできません。この格納装置の SAF-TE 監視が無効化されてい
ます。

Unable to inquire tape device. This device willbe removed.

テープ デバイスを問い合わせできません。このデバイスは削除されます。

Unable to inquire target devices. Device and SAF-TE monitoring disabled.

ターゲット デバイスを問い合わせできません。デバイスおよび SAF-TE 監視が無効化されて
います。

Unable to issue Self-Reliability Query on device at [Channel:Target].

自己信頼性の照会を [Channel:Target] のデバイスで発行できません。

Unable to open bindings file -or- no bindings present. Check Bindings file.
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バインド ファイルを開けません。または、バインドが存在しません。バインド ファイルを
チェックしてください。

Unable to open I/O transport layer

I/O トランスポート層を開けません。

Unable to query TapeAlert log data. TapeAlert monitoring disabled for this device.

TapeAlert ログ データを照会できません。このデバイスの TapeAlert 監視が無効化されてい
ます。

Unable to read enclosure environmental status.

格納装置の環境ステータスを読み取れません。

Unable to send login info to the server.

サーバにログイン情報を送信できません。

Undefined Error(Ch:%d,Id:%d). Contact technical support.

未定義エラー（Ch:%d,Id:%d）。テクニカル サポートに連絡してください。

Unexpected Disconnect(Ch:%d,Id:%d). Check drive seating, cables, and I/O module. 
Replace as required.

予期しない切断（Ch:%d,Id:%d）。ドライブの装着、ケーブル、および I/O モジュールを
チェックしてください。必要に応じて交換します。

Unexpected Sense Data Received from Target(Ch:%d,Id:%d). Likely poorly seated or 
defective drive. Possible defective drive slot.

予期しないセンス データをターゲット（Ch:%d,Id:%d）から受信。おそらく、ドライブの装
着不良か、欠陥ドライブが原因です。ドライブ スロットの欠陥の可能性があります。

Unexpected Unit Attention Received from Target(Ch:%d,Id:%d). Likely poorly seated or 
defective drive. Possible defective drive slot.

予期しないユニット呼び出しをターゲット（Ch:%d,Id:%d）から受信。おそらく、ドライブ
の装着不良か、欠陥ドライブが原因です。ドライブ スロットの欠陥の可能性があります。

Unknown redundancy state.

不明な冗長状態。

UNMAPPED LUN, NOT AVAILABLE TO HOST

マップされていない LUN。ホストでは使用できません。

Username is empty.

ユーザー名が空です。

Waiting for debounce ping.

ピングの戻りを待っています。
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Write config file error.

構成ファイル書き込みエラー。

Wrong Fax number format.

不正なファックス番号形式。

Wrong Phone number format.

不正な電話番号形式。

You must first delete the host mapping for the partitions whose index number is greater 
before you can change this partition.

このパーティションを変更するには、先に、インデックス番号がより大きいパーティション
のホスト マッピングを削除する必要があります。

You must first delete the host mapping for the partitions whose index number is greater or 
equal before you can delete this partition.

このパーティションを削除するには、先に、インデックス番号が同一以上のパーティション
のホスト マッピングを削除する必要があります。

You must first delete the host mapping for this logical drive before you can delete it.

この論理ドライブを削除するには、先に、ホスト マッピングを削除する必要があります。

You must first delete the host mapping of the last partition before you can add a new 
partition.

新しいパーティションを追加するには、先に、 後のパーティションのホスト マッピングを
削除する必要があります。

You selected "Event" as the Trap Type, therefore, you must select at lease one Active trap 
event.

トラップ タイプとして "Event" が選択されたので、 低 1 つのアクティブ トラップ イベン
トを選択する必要があります。 

You selected "My SMTP server needs authorization," therefore, you must enter a Password.

"My SMTP server needs authorization" が選択されたので、パスワードを入力する必要があ
ります。

You selected "My SMTP server needs authorization," therefore, you must enter a Username.

"My SMTP server needs authorization" が選択されたので、ユーザ名を入力する必要があり
ます。

You selected "use encrypt," therefore, you must enter an encrypt key.

"use encrypt" が選択されたので、暗号化キーを入力する必要があります。
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用語集

この付録は、本書で使用されている略語と RAID 用語の定義の一覧です。ディスク 
ドライブ、論理ドライブ、冗長コントローラの動作ステータスの定義も含まれていま
す。 

略語
ANSI 米国規格協会（American National Standards Institute）。

CH チャネル

CISPR 国際無線障害特別委員会（International Special Committee on Radio 
Interference）。

EMU イベント監視ユニット（Event Monitoring Unit）。

FC-AL ファイバ チャネル調停ループ（Fibre Channel-Arbitrated Loop）。FC-AL は
ループまたはファブリックとして実装されます。ループは 大 126 ノードまで
含むことができ、1 台または 2 台のサーバからのみアクセス可能です。 

FRU 現場交換可能ユニット（Field-Replaceable Unit）。

GB ギガバイト（Gigabyte）。1,000,000,000 （10億）バイト。 

GBIC ギガビット インターフェイス コンバータ（Gigabit Interface Converter）。
ギガビット イーサネット ポートまたはファイバ チャネルにプラグ接続する
ホットスワップ可能な入出力デバイス。

HBA ホスト バス アダプタ（Host Bus Adapter）。

ID 識別子番号（Identifier number）。

IEC 国際電気標準会議（International Electrotechnical Commission）。

JBOD 単なるディスクの束(Just a Bunch of Disks)。(コントローラがないディスクだけ
のアレイ ユニット)

LAN ローカル エリア ネットワーク（Local Area Network）。
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LD 論理ドライブ（Logical drive）。

LUN 論理ユニット番号（Logical unit number）。メジャーとマイナーのデバイス番
号により、コンピュータに接続されている特定のデバイスの論理ユニット番号
シーケンスが構成されます。

LVD 低雑音、低電力、低振幅の伝送システムで、サポートされているサーバとスト
レージ デバイス間のデータ通信を可能にします。LVD 伝送では、2 本のワイヤ
を使用して銅線上に信号を送信し、25 メートル（82 フィート）以下のケーブル
が必要です。 

MB メガバイト（Megabyte）。1,000,000 バイト（キャラクタ）のデータ。 

NVRAM 不揮発性ランダム アクセス メモリ（Non-Volatile Random Access 
Memory）。主電源が切断された後でもデータがそのまま保持されるように、
バッテリが装備された記憶装置。

PID セカンダリ コントローラ識別子番号（Secondry controller identifier 
number）。

RAID 独立ディスクの冗長アレイ（Redundant Array of Independent Disks）。複数
のドライブを組み合わせて単一の仮想ドライブにし、パフォーマンスと信頼性
を向上させる構成。

SAN ストレージ エリア ネットワーク（Storage Area Network）。ストレージ デバ
イスとサーバによる高速でオープン規格かつスケーラブルなネットワークで、
加速データアクセスを提供します。

SCSI SCSI （Small Computer Systems Interface）。ディスクやテープ デバイスを
ワークステーションに接続するための業界規格。

SES SCSI 格納装置サービス ドライバ（SCSI Enclosure Services driver）。SCSI 格
納装置サービス デバイスへのインターフェイス。これらのデバイスは、格納装
置内の物理状態を検知、監視します。また、格納装置のステータス報告および
構成機能（格納装置のインジケータ LED など）へのアクセスを可能にします。

SID セカンダリ コントローラ識別子番号（Secondary controller identifier 
number）。

S.M.A.R.T. 自己監視分析およびレポート テクノロジ（Self Monitoring Analysis and 
Reporting Technology）。IDE/ATA および SCSI ハード ディスク ドライブ用
の業界標準の信頼性予告インジケータ。SMART 搭載のハード ディスク ドライ
ブは、クリティカルなデータを保護するためハード ディスク障害の早期警告を
発します。 

SMTP 簡易メール転送プロトコル（Simple Mail Transfer Protocol）。サーバ間で、ま
たはメール クライアントからメール サーバへ電子メール メッセージを送信す
るためのプロトコル。メッセージは、POP または IMAP を使用して電子メール 
クライアント側で受信されます。 

SNMP 簡易ネットワーク管理プロトコル（Simple Network Management Protocol）。
複雑なネットワークを管理するための規約セット。SNMP は、プロトコル デー
タ ユニット（PDU）と呼ばれるメッセージを、ネットワーク上の異なる部分に
320  Sun StorEdgeTM  3000 Family  Configuration Service 1.2 ユーザ ガイド • 2003 年 3 月



送信します。エージェントと呼ばれる SNMP 準拠デバイスは、自身に関する
データを管理情報ベース（MIB）に格納し、SNMP 要求に対してこのデータを
返します。 

WWN ワールド ワイド ネーム（world wide name）。アレイ システムと Solaris 動作
環境のシステムの両方において、アレイ ボリュームを識別するため使用される
番号。

用語
アクティブ アクティブ

コントローラ 一対のコンポーネント。たとえば、両方のコントローラが正常動作していると
きにタスクまたはタスク セットを共有する、フォールト トレラント ストレー
ジ システム内のストレージ コントローラなど。一対のコンポーネントの片方が
故障した場合、他方がすべての負荷を処理します。デュアルアクティブ コント
ローラとも呼ばれるこのコントローラは、同じデバイス セットに接続され、単
一のコントローラよりも高い I/O パフォーマンスとフォールト トレランスを提
供します。 

自動再構築 ドライブが故障した後、データが自動的に再構築され、スタンバイ（スペア）
ドライブに書き込まれるプロセス。故障ドライブの代わりに新しいドライブを
手動でインストールするときにも自動再構築が実行されます。再構築プロセス
がリセットにより中断された場合、Array Administration → Rebuild を使って
再構築プロセスを再開できます。

バックグラウンド レート バックグラウンド レートとは、アレイ管理活動（故障ドライブの再構築、パリ
ティ チェック、初期化など）に割り当てられた、使用可能なアレイ コントロー
ラ CPU 時間のパーセンテージ。バックグラウンド レートが 100% に設定され
ている場合、アレイ管理活動がほかのシステム活動よりも優先されます。0% の
場合は、アレイ コントローラにほかの活動がないときにのみアレイ管理活動が
実行されます。

キャッシング データを、ディスク上の指定済み領域、または RAM （ランダムアクセスメモ
リー）に格納すること。キャッシングにより、RAID システム、ディスク ドラ
イブ、コンピュータやサーバ、その他の周辺デバイスの動作が速くなります。 

チャネル ストレージ デバイスとストレージ コントローラまたは I/O アダプタの間で、
データおよび制御情報の転送に使用されるパス。また、ディスク アレイ コント
ローラ上の 1 つの SCSI バスも指します。各ディスク アレイ コントローラは、
少なくとも 1 つのチャネルを提供します。 

ファブリック 1 つまたは複数のスイッチ周辺に構築されたファイバ チャネル ネットワーク。 

フェイルオーバー フォールト トレラント システムの動作モード。1 つのコンポーネントに障害が
発生した場合、その機能が冗長コンポーネントによって継続されます。 

フォールト トレランス 障害が検出された場合に、バックアップ システムをオンラインにして使用する
などの方法で、データの可用性を中断せずに内部ハードウェアの問題に対処す
る能力。多くのストレージ システムは、1 台のディスク ドライブが故障した場
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合に RAID アーキテクチャを使用することにより、データの喪失を防ぐフォー
ルト トレランスを提供します。RAID 1 （ミラーリング）、RAID 3 または 5 
（パリティでストライピング）、RAID 6 または 1+0 （ミラーリングとストラ
イピング）技術を使用し、アレイ コントローラは、故障ドライブからデータを
再構築し、それをスタンバイまたは交換用ドライブに書き込むことができま
す。

フォールト トレラント

論理ドライブ 1 台のドライブが故障した際、RAID 1、3、5、または 6 (RAID 1+0 とも呼ばれ
る)を用い、データの保護を提供する論理ドライブ。

ファイバ チャネル 広範囲のハードウェアに導入される、コスト効率のよいギガビット通信リン
ク。

グループ グループとは、複数のサーバを 1 つのカテゴリにまとめるための新しいデータ 
オブジェクト。概念的にはドメインに似ており、Configuration Service 内で
サーバを整理できます。管理する全サーバをリニア ツリーで表すのではなく、
Configuration Service のオペレータは、サーバを類似セットまたはグループと
して整理できます。

グループは必須ではありません。たとえば、グループなしで 15 台のサーバを持
つように、または 10 台のサーバから成る 1 つのグループとトップ レベルにさ
らに 5 台のサーバを持つように Configuration Service を設定できます。
Configuration Service では任意の組み合わせが可能です。

グループの数と 1 つのグループ内に許可されるサーバの数は、使用可能なシス
テム メモリーによってのみ制限されます。サーバがあるグループのメンバーで
あり、ユーザーがそのグループをグループ リストボックスから削除した場合、
そのグループ内の全サーバは、Configuration Service により「グループなし」
カテゴリに再割り当てされます。Configuration Service は、メイン ウィンドウ
に表示されるツリーを自動的に再マップします。

ホット スペア RAID 1 または RAID 5 構成内のドライブで、データを含まず、ほかのドライブ
が故障した場合のスタンバイとして機能するもの。 

ホットスワップ可能 システムに電源が入り、動作状態のまま、現場交換可能ユニット（FRU）を取
り外して交換できる能力。

論理ドライブ 複数の独立の物理ドライブによるアレイで、ホストには 1 つの大容量ドライブ
のように見えます。

LUN マッピング ストレージからサーバに提示される仮想 LUN を変更する能力。この機能によ
り、ローカル ディスク ドライブを必要とせずに、サーバが SAN からブートで
きるなどの利点が得られます。各サーバは、ブートするために LUN 0 を必要と
します。

LUN マスキング 管理者が HBA を特定の LUN に動的にマップできるようにする機能。これによ
り、個々のサーバまたは複数のサーバが、個々のドライブまたは複数のドライ
ブにアクセスでき、同じドライブへの不要なサーバ アクセスを抑止できます。
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ミラーリング（RAID 1） 1 つのディスク ドライブに書き込まれたデータが、同時に別のディスク ドライ
ブにも書き込まれます。一方のディスクが故障した場合、他方のディスクを使
用してシステムを稼動し、故障したディスクを再構築できます。ディスク ミ
ラーリングによる主な利点は 100% のデータ冗長性です。ディスクはミラーリ
ングされているので、ディスクの 1 つが故障しても問題にはなりません。両方
のディスクに常に同じデータが格納され、どちらか 1 つが動作ディスクとなり
ます。

ディスク ミラーリングは 100% の冗長性を提供しますが、システムの各ドライ
ブを二重化するため高価です。

N ポート ポイントツーポイントまたはファブリック接続内のファイバ チャネル ポート。

アウトオブバンド データ パス上にない接続やデバイスのこと。 

パリティ チェック フォールト トレラント アレイ（RAID 1、3、5、6 または 1+0）の冗長データの
保全性をチェックするプロセス。論理ドライブでのパリティ チェック手順で
は、論理ドライブの RAID ストライプ セットのそれぞれについて、データ ス
トライプのパリティを再計算し、格納されているパリティとこれを比較しま
す。不一致があった場合はエラーが報告され、新しい正しいパリティが、格納
されているパリティと置き換えられます。

パーティション ホストの動作環境に対して単一の物理ドライブとして提示される、ディスク ス
トレージ領域の 1 つのセクション。システム ドライブまたは LUN とも呼ばれ
ます。論理ドライブは 1 つまたは複数の物理ドライブで構成されます。 

パートナー グループ 相互接続している一対のコントローラ ユニット。一対のコントローラ ユニット
に相互接続している拡張ユニットも、パートナー グループの一部になれます。

物理アレイ 物理アレイとは、Configuration Service 内で 1 つまたは複数の論理ドライブの
一部となる、物理ドライブのグループ。物理ドライブのグループが、物理ドラ
イブの全容量を使用せずに 1 つの論理ドライブとして構成されている場合、
Configuration Service では、この同じ物理アレイのドライブを、残り容量で作
成される残りの論理ドライブに一緒に使用する必要があります。

論理ドライブの作成に使用された残りのドライブ容量が複数の物理ドライブ上
にある場合、 New Configuration ウィンドウでの Add Disk ボタンがAdd 
Array に変わります。この物理ドライブはスライスされているため、アレイと
して選択する必要があります。個別に選択することはできません。

RAID 独立ディスクの冗長アレイ（Redundant Array of Independent Disks）。ディ
スク ストレージ領域の増大、パフォーマンス向上、データの冗長バックアップ
などを提供するため、複数のディスク ドライブを一緒に動作するように配置し
た構成。この機能のさまざまな組み合わせが RAID レベルで定義されていま
す。RAID レベルの詳細は、「201 ページの「RAID の基本」」を参照してくだ
さい。
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読み取りポリシー 読み取りポリシーには以下の種類があります。

No Cash 読み取りポリシーを指定した場合、コントローラは読み取りキャッ
シュにデータを格納しません。

Normal を指定した場合、現在のコントローラは、現在のドライブに対して前
方読み取りキャッシングを使用しません。

読み取りポリシーを Read Ahead に設定すると、コントローラは複数の隣接
データ ブロックを自動的に読み取ります。この設定は、シーケンシャル読み取
りのアプリケーションに も効果的です。

再構築 ディスクの再構築とは、ディスクが故障する前のディスク上のデータを再構築
するプロセス。再構築は、データに冗長性があるアレイにおいてのみ実行可能
です。 

再構築の詳細は、321 ページの「自動再構築」を参照してください。再構築
レートについては、「321 ページの「バックグラウンド レート」」を参照して
ください。 

スパンニング ディスクのスパンニングでは、ファームウェアのストライピング機能を利用
し、本来は独立の 2 つの RAID 論理ドライブ全体に渡りデータをストライプし
ます。スパンした 2 つの論理ドライブは、動作環境に対して 1 つの論理ドライ
ブとして提示されます。スパンニングには次の利点があります。

組み合わせたフォールト トレラント論理ドライブ内で、2 つ同時に発生したド
ライブの故障をサポートする（各論理ドライブに故障ドライブが 1 つと仮定し
た場合）。

スピンドル数が増すので、パフォーマンスも向上する。

スパンニングの欠点は、各論理ドライブがフォールト トレランスを個別に処理
するため、冗長 RAID レベルの RAID オーバーヘッドが増大することです。

スタンバイ ドライブ 論理ドライブに関連付けられた物理ドライブが故障した場合に、データの自動
再構築をサポートするスペアとして指定されているドライブ。別のドライブと
交換するスタンバイ ドライブは、少なくとも故障したドライブと同じサイズで
なくてはなりません。また、故障したドライブは RAID 1、3、5、または 1+0 
内のドライブでなくてはなりません。

状態 ディスク ドライブ、論理ドライブ、または冗長コントローラの現在の動作状
態。ストレージ システムは、ドライブ、論理ドライブ、および冗長コントロー
ラの状態をその不揮発性メモリーに格納します。この情報はシステムの電源中
断後も保持されます。
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ストライプ サイズ これは、1 つの論理ドライブの各物理ドライブに渡りストライプされるデータ
の量（キロバイト単位）です。値は 8 キロバイト増分で設定され、値の範囲は 
8～64 キロバイトです。一般に、大きいストライプ サイズを使用すると、主に
シーケンシャル読み取りを行うシステムに効果的です。

既存のドライブのストライプ サイズを変更するには、データのバックアップを
作成し、ストライプ サイズを再定義し、ストレージを再構成した後、全データ
を復元する必要があります。

ストライピング 論理ドライブ内の異なるすべての SCSI ドライブで、入力データのシーケン
シャル ブロックを格納すること。たとえば、論理ドライブ内に SCSI ドライブ
が 3 台ある場合、データは次のように格納されます。

SCSI ドライブ 1 にブロック 1

SCSI ドライブ 2 にブロック 2

SCSI ドライブ 3 にブロック 3

SCSI ドライブ 1 にブロック 4

SCSI ドライブ 2 にブロック 5、以下同様。

このメソッドでデータを書き込むと、複数のドライブが同時に作動し、データ
の読み取りと格納を行うため、ディスク システムのスループットが増大しま
す。RAID 0、3、5、1+0 はすべて、ストライピングを使用します。

ターミネータ SCSI バスを終端処理するための部品。ターミネータは無線周波信号を吸収し
て、エネルギーがケーブル プラントに反射するのを防ぎます。 

ボリューム 論理ユニット番号または LUN とも呼ばれるボリュームは、データ ストレージ
用にユニットとしてグループ化される 1 つまたは複数のドライブ。

ライトバック キャッシュ キャッシュ書き込み手法の 1 つ。アレイ コントローラが、ディスクに書き込む
データを受け取り、これをメモリー バッファに格納し、データが実際にディス
ク ドライブに書き込まれるまで待たず直ちに、書き込み操作が完了したという
信号をホスト動作環境に送信します。コントローラは、ビジーでなければ、こ
のデータを短時間内にディスク ドライブに書き込みます。

ライトバック キャッシングでは、書き込み操作とコントローラ カードのスルー
プットが向上します。ただし、停電時にはデータ喪失の危険性があるので、ラ
イトバック キャッシングを行うストレージ システムでは、UPS またはバッテ
リ バックアップ キャッシュを装備しています。UPS は、キャッシュ メモリ内
のデータがディスク ドライブに書き込まれるまで十分な時間の電力を供給しま
す。バッテリ バックアップ キャッシュでは、バッテリにより、メモリー デー
タを 大 48 時間まで保持できる電力が供給されます。

書き込みポリシー システムの書き込み操作を制御するためのキャッシュ書き込み手法。書き込み
ポリシーのオプションには、write-back および write-through キャッシュがあ
ります。
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ライトスルー キャッシュ キャッシュ書き込み手法の 1 つ。アレイ コントローラが、ホスト動作環境にプ
ロセスが完了したことを送信する前に、データをディスク ドライブに書き込み
ます。ライトスルー キャッシュは、ライトバック キャッシュよりも、書き込み
操作とスループットのパフォーマンスは低くなりますが、電源故障時における
データ喪失の危険性が 小で、より安全な手法です。
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